AutoCAD Tutorials

CADTutor delivers the best free tutorials and articles for AutoCAD and associated applications along with a friendly AutoCAD forum and an AutoCAD FAQ. If you need to learn AutoCAD, you're in the right place.

http://www.cadtutor.net/

Donate to CADTutor

If you find this information useful, you might like to consider making a donation. All content on this site is provided free of charge and we hope to keep it that way. However, running a site like CADTutor does cost money and you can help to improve the service and to guarantee its future by donating a small amount. We guess that you probably wouldn't miss $5.00 but it would make all the difference to us.
About CADTutor

Colophon
The CADTutor website is designed, built and maintained by David Watson from his home, a small cottage in rural Hampshire (UK), which he shares with his wife, two children, two chickens and a cat. The site is primarily about a computer drafting application, known as AutoCAD. The aim of the site is to help beginners learn how to use AutoCAD and also to help experienced users become even more efficient.

In addition to running the CADTutor website, David teaches Digital Design at the University of Greenwich. He is also a qualified Landscape Architect and specializes in Visual Impact Assessment. When he's not doing any of these things, he's most likely to be found out cycling or taking photographs of the beautiful Hampshire countryside. Sometimes he just likes listening to old Echo and the Bunnymen songs on his iPod (his wife thinks that's a bit sad).

Author's Notes
Over the past 5 years, CADTutor has grown amazingly and what started as a small tutorial site with a few visitors per day is now a well-known AutoCAD resource with comfortably over 100,000 unique visitors every month. When CADTutor v3.0 was published five and a half years ago, I wouldn't have believed things could change so positively. CADTutor v4.0 brings the prospect of a whole range of new opportunities for the next 5 years. It's taken 18 months of work (off-and-on) but the site has now been transformed from an "old-school", static html site into a modern, standards compliant, dynamic site using PHP and MySQL.

As you can see from the image of the version 3 website on the right, the site has retained its established identity and its mascot, the enigmatic trout (still without a name!) but I hope the new design improves both usability and accessibility in addition to just making the place a better experience for visitors. If you have any comments about the site, I'd love to hear from you, especially if you have suggestions or feedback (good or bad).

Thanks to all of you who have made the site such a success.

David Watson, February 2007
CADTutor started life in 1995 as a couple of A4 printed handouts designed to help students get to grips with AutoCAD R12 for DOS.

I had recently started teaching computer aided design at the University of Greenwich in the UK and needed to develop some simple teaching materials. I continue to teach at Greenwich but have also been teaching at the University of Kingston, in the UK and have been visiting tutor at the Technische Universitat Berlin at Berlin in Germany, Larenstein University of Professional Education at Velp in the Netherlands and Erasmus Hogeschool Brussels at Vilvoorde in Belgium.

For the last few years, I have also run a number of professional training courses for AutoCAD and Photoshop.

The nature and range of my teaching has meant that I need access to teaching materials wherever I am and the Internet, when it arrived, proved to be the perfect medium for delivery.

As you can see, what started out life as a few brief notes has turned into a mammoth amount of work, all done in my own time. It has, in fact, become a labour of love.

So here it is, never complete, never perfect but substantial and comprehensive. It will continue to grow as my teaching inevitably leads into new areas. Enjoy it, it really is free.

http://www.cadtutor.net/

Donate to CADTutor

If you find this information useful, you might like to consider making a donation. All content on this site is provided free of charge and we hope to keep it that way. However, running a site like CADTutor does cost money and you can help to improve the service and to guarantee its future by donating a small amount. We guess that you probably wouldn't miss $5.00 but it would make all the difference to us.
About CADTutor

About The Author

About CADTutor

CADTutor Website

Donate to CADTutor

The Basics

Drawing Objects
Getting to grips with AutoCAD's basic drawing tools. This is an ideal start for the AutoCAD beginner.

Object Selection
This tutorial shows you the many ways AutoCAD objects can be selected. Covers the building of selection sets with implied windowing, fences etc.

Modifying Objects
This tutorial runs through all of the modify tools, demonstrating practical examples in each case.

Direct Distance Entry
The essential way of working with AutoCAD

Drawing Aids
All about drawing aids.

Units and Scales
If you're asking yourself "what scale do I draw in?" or "what units should I use?", you need this tutorial.

Using Co-ordinates
All about the use of co-ordinates in AutoCAD.

Object Snap
A tutorial giving an overview of all the AutoCAD object snaps (osnaps) with some worked examples. The tutorial also covers the use of temporary tracking points and object snap tracking.
Object Properties
This tutorial describes how to control the display of objects (colour, linetype etc.) using layers. It also explains what layers are and how they should be used.

Masterplan Exercise
This exercise can be used to practice your basic drafting skills.

North Point Exercise
An exercise sheet, covering a range of basic skills including object snaps.

Site Layout Exercise
This exercise is designed to help you test out your basic AutoCAD skills. You'll need an understanding of the Draw and Modify tools and how to use co-ordinates.

Beyond Basics

Advanced Selection
After you've mastered the basics of selection, this tutorial shows you some powerful methods for making complex selection sets.

User Co-ordinate Systems
This tutorial describes what UCSs are, why we need them and how to use them. The correct use of UCSs with AutoCAD is the key to producing good 3D models and they can also help with 2D work.

Dimensioning
This tutorial describes the options and commands available for dimensioning drawings and how to use them. The correct use of AutoCADs dimension tools is the key to producing clear and concise measured drawings.

The UCS Icon
All about the UCS icon.

Scaling Images
How to scale images in AutoCAD.

All About Images
This tutorial tells you all you need to know about working with images in AutoCAD.

Using Images
This exercise is designed to demonstrate the use of many of the image commands described in the All About Images tutorial. If you have little or no experience of working
with images in AutoCAD, it is recommended that you work through the tutorial before attempting the exercise

ISO Paper Sizes
There has always been some confusion over the size of standard ISO drawing sheets with AutoCAD. The stated sizes in the plot dialogue box are not the true ISO sizes. This tutorial explains why and how to plot to scale from Model Space.

Paper Space Exercise
AutoCAD's paper space mode is a bit like having a page in a scrapbook onto which you can paste different views of your AutoCAD drawing. This whole page can then be plotted. This exercise demonstrates how.

Techniques

AutoCAD to Photoshop
This tutorial demonstrates a number of workflows from quick and simple to high quality.

Setting up a PostScript Plotter
How to set up a PostScript Plotter.

Scaling Images
How to scale images in AutoCAD.

Adding Sunlight to your Drawings
This tutorial takes you through the steps required to add realistic sunlight effects to your 3D model.

Creating Custom Bitmap Materials
This tutorial demonstrates how to create your own bitmap based materials using Photoshop and AutoCAD.

Creating Seamless Tiles
This tutorial shows you how to create perfectly seamless image tiles in Photoshop. The image tiles are perfect for creating image based materials in AutoCAD, MAX or Bryce.

AutoCAD to Bryce
This tutorial takes a step-by-step approach to moving your AutoCAD 3D models into Bryce, applying materials and creating a setting.

Importing AutoCAD Meshes to Bryce
This tutorial describes how to create a triangular ground model using Key Terra-Firma and AutoCAD and how to import this ground model into Bryce.
Perspectives, Slides and Scripts
AutoCAD can be used to create a simple "walk through" of any 3D model. This tutorial shows you how.

Entering Survey Data using AutoCAD
These techniques apply to basic CAD programs such as AutoCAD, IntelliCAD, etc. If you have a civil/survey program or add-on, such as Land Desktop, SurvCADD, Eagle Point, etc., then there are built-in tools for entering lines and curves.

Basic 3D and Surface Modeling
Although AutoCAD has a number of commands for creating special 3D objects, a lot can be achieved by changing the properties of basic 2D objects like polylines. This tutorial provides a basic introduction to creating and viewing 3D objects.

3D Tree Exercise
The object behind this exercise is twofold. Firstly it is to give you practice with some of the 3D techniques which you have discovered in the tutorials or to introduce you to them if you haven't seen them before. Secondly it is to demonstrate a reasonably simple method for constructing a convincing 3D tree.

Adding Sunlight to your Drawings
This tutorial takes you through the steps required to add realistic sunlight effects to your 3D model.

All About Shadows
This tutorial considers the various options for creating shadows when rendering 3D models.

Creating Custom Bitmap Materials
This tutorial demonstrates how to create your own bitmap based materials using Photoshop and AutoCAD.

Creating Seamless Tiles
This tutorial shows you how to create perfectly seamless image tiles in Photoshop. The image tiles are perfect for creating image based materials in AutoCAD, MAX or Bryce.

AutoCAD to Bryce
This tutorial takes a step-by-step approach to moving your AutoCAD 3D models into Bryce, applying materials and creating a setting.

Perspectives, Slides and Scripts
AutoCAD can be used to create a simple "walk through" of any 3D model. This tutorial shows you how.
Introduction

This tutorial is designed to show you how all of the AutoCAD Draw commands work. If you just need information quickly, use the QuickFind toolbar below to go straight to the command you want or select a topic from the contents list above. Not all of the Draw commands that appear on the Draw toolbar are covered in this tutorial. Blocks, Hatch and Text for example are all tutorial topics in their own right!

The Draw commands can be used to create new objects such as lines and circles. Most AutoCAD drawings are composed purely and simply from these basic components. A good understanding of the Draw commands is fundamental to the efficient use of AutoCAD.

The sections below cover the most frequently used Draw commands such as Line, Polyline and Circle as well as the more advanced commands like Multiline and Multiline Style. As a newcomer to AutoCAD, you may wish to skip the more advanced commands in order to properly master the basics. You can always return to this tutorial in the future when you are more confident.

In common with most AutoCAD commands, the Draw commands can be started in a number of ways. Command names or short-cuts can be entered at the keyboard, commands can be started from the Draw pull-down menu, shown on the right or from the Draw toolbar. The method you use is dependent upon the type of work you are doing and how experienced a user you are. Don't worry too much about this, just use whatever method feels easiest or most convenient at the time. Your drawing technique will improve over time and with experience so don't expect to be working very quickly at first.

If you are working with the pull-down menus, it is worth considering the visual syntax that is common to all pull-downs used in the Windows operating system. For example, a small arrow like so " ▼ " next to a menu item means that the item leads to a sub-menu that may contain other commands or command options. An ellipsis, " ... " after a menu item means that the item displays a dialogue box. These little visual clues will help you to work more effectively with menus because they tell you what to expect and help to avoid surprises for the newcomer.

Lines

Lines are probably the most simple of AutoCAD objects. Using the Line command, a line can be drawn
between any two points picked within the drawing area. Lines are usually the first objects you will want to draw when starting a new drawing because they can be used as "construction lines" upon which the rest of your drawing will be based. Never forget that creating drawings with AutoCAD is not so dissimilar from creating drawings on a drawing board. Many of the basic drawing methods are the same.

Anyone familiar with mathematics will know that lines drawn between points are often called vectors. This terminology is used to describe the type of drawings that AutoCAD creates. AutoCAD drawings are generically referred to as "vector drawings". Vector drawings are extremely useful where precision is the most important criterion because they retain their accuracy irrespective of scale.

The Line Command

With the Line command you can draw a simple line from one point to another. When you pick the first point and move the cross-hairs to the location of the second point you will see a rubber band line which shows you where the line will be drawn when the second point is picked. Line objects have two ends (the first point and the last point). You can continue picking points and AutoCAD will draw a straight line between each picked point and the previous point. Each line segment drawn is a separate object and can be moved or erased as required. To end this command, just hit the \( \text{Esc} \) key on the keyboard.

Command Sequence

Command: \text{LINE}
Specify first point: (pick P1)
Specify next point or [Undo]: (pick P2)
Specify next point or [Undo]: \( \text{Esc} \) (to end)

You can also draw lines by entering the co-ordinates of their end points at the command prompt rather than picking their position from the screen. This enables you to draw lines that are off screen, should you want to. (See Using Co-ordinates for more details). You can also draw lines using something called direct distance entry. See the Direct Distance Entry tutorial for details.

The Construction Line Command

With the Construction Line command you can draw construction lines which are used to create "construction lines" upon which the rest of your drawing will be based. You can exit this command at any time by hitting the \( \text{Esc} \) key. The Construction Line command is also used for drawing "construction lines" for geometry on which the rest of your drawing will be based. You can exit this command at any time by hitting the \( \text{Esc} \) key.

Command Sequence

Command: \text{XLINE}
Specify first point: (pick P1)
Specify next point or [Undo]: (pick P2)
Specify next point or [Undo]: \( \text{Esc} \) (to end)
The Construction Line command creates a line of infinite length which passes through two picked points. Construction lines are very useful for creating construction frameworks or grids within which to design.

Construction lines are not normally used as objects in finished drawings, it is usual, therefore, to draw all your construction lines on a separate layer which will be turned off or frozen prior to printing. See the Object Properties tutorial to find out how to create new layers. Because of their nature, the Zoom Extents command option ignores construction lines.

Command Sequence

Command: **XLINE**
Specify a point or [Hor/Ver/Ang/Bisect/Offset]: (pick a point)
Specify through point: (pick a second point)
Specify through point: ← (to end or pick another point)

You may notice that there are a number of options with this command. For example, the "Hor" and "Ver" options can be used to draw construction lines that are truly horizontal or vertical. In both these cases, only a single pick point is required because the direction of the line is predetermined. To use a command option, simply enter the capitalised part of the option name at the command prompt. Follow the command sequence below to see how you would draw a construction line using the Horizontal option.

Command Sequence

Command: **XLINE**
Hor/Ver/Ang/Bisect/Offset/<From point>: **H** ←
Through point: (pick a point to position the line)
Through point: ← (to end or pick a point for another horizontal line)

The Ray Command

Toolbar custom  
Pull-down Draw ▶Ray 
Keyboard **RAY**

The Ray command creates a line similar to a construction line except that it extends infinitely in only one direction from the first pick point. The direction of the Ray is determined by the position of the second pick point.

Command Sequence

Command: **RAY**
Specify start point: (pick the start point)
Specify through point: (pick a second point to determine direction)
Specify through point: ← (to end or pick another point)

The Polyline Family

Polylines differ from lines in that they are more complex objects. A single polyline can be composed of a
number of straight-line or arc segments. Polylines can also be given line widths to make them appear solid. The illustration below shows a number of polylines to give you an idea of the flexibility of this type of line.

You may be wondering, if Polylines are so useful, why bother using ordinary lines at all? There are a number of answers to this question. The most frequently given answer is that because of their complexity, polylines use up more disk space than the equivalent line. As it is desirable to keep file sizes as small as possible, it is a good idea to use lines rather than polylines unless you have a particular requirement. You will also find, as you work with AutoCAD that lines and polylines are operationally different. Sometimes it is easier to work with polylines for certain tasks and at other times lines are best. You will quickly learn the pros and cons of these two sorts of line when you begin drawing with AutoCAD.

The Polyline Command

Toolbar      Draw
Pull-down    Draw ➤ Polyline
Keyboard     PLINE  short-cut  PL

The Polyline or Pline command is similar to the line command except that the resulting object may be composed of a number of segments which form a single object. In addition to the two ends a polyline is said to have vertices (singular vertex) where intermediate line segments join. In practice the Polyline command works in the same way as the Line command allowing you to pick as many points as you like. Again, just hit Enter to end. As with the Line command, you also have the option to automatically close a polyline end to end. To do this, type C to use the close option instead of hitting Enter. Follow the command sequence below to see how this works.

Command Sequence

Command: PLINE
Specify start point: (pick P1)
Current line-width is 0.0000
Specify next point or [Arc/Halfwidth/Length/Undo/Width]: (pick P2)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P3)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P4)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: (pick P5)
Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: ↵ (or C to close)

In the illustration on the right, the figure on the left was created by hitting the ↵ key.
after the fifth point was picked. The figure on the right demonstrates the effect of using the Close option.

It is worth while taking some time to familiarise yourself with the Polyline command as it is an extremely useful command to know. Try experimenting with options such as Arc and Width and see if you can create polylines like the ones in the illustration above. The Undo option is particularly useful. This allows you to unpick polyline vertices, one at a time so that you can easily correct mistakes.

Polylines can be edited after they are created to, for example, change their width. You can do this using the PEDIT command, Modify Object Polyline from the pull-down menu.

The Rectangle Command

The Rectangle command is used to draw a rectangle whose sides are vertical and horizontal. The position and size of the rectangle are defined by picking two diagonal corners. The rectangle isn't really an AutoCAD object at all. It is, in fact, just a closed polyline which is automatically drawn for you.

Command Sequence

Command: RECTANG
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (pick P1)
Specify other corner point or [Dimensions]: (pick P2)

The Rectangle command also has a number of options. Width works in the same way as for the Polyline command. The Chamfer and Fillet options have the same effect as the Chamfer and Fillet commands, see the Modifying Objects tutorial for details. Elevation and Thickness are 3D options.

Notice that, instead of picking a second point to draw the rectangle, you have the option of entering dimensions. Say you wanted to draw a rectangle 20 drawing units long and 10 drawing units wide. The command sequence would look like this:

Command Sequence

Command: RECTANG
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (pick a point)
Specify other corner point or [Dimensions]: D
Specify length for rectangles <0.0000>: 20
Specify width for rectangles <0.0000>: 10
Specify other corner point or [Dimensions]: (pick a point to fix the orientation)

This method provides a good alternative to using relative cartesian co-ordinates for determining length and width. See the Using Co-ordinates tutorial for more details.

The Polygon Command

The Polygon command can be used to draw any regular polygon from 3 sides up to 1024 sides. This command requires four inputs from the user, the number of sides, a pick point for the centre of the polygon, whether you want the polygon inscribed or circumscribed and then a pick point which determines both the radius of this imaginary circle and the orientation of the polygon. The polygon command creates a closed polyline in the shape of the required polygon.

This command also allows you to define the polygon by entering the length of a side using the Edge option. You can also control the size of the polygon by entering an exact radius for the circle. Follow the command sequence below to see how this command works.

Command Sequence

Command: POLYGON
Enter number of sides <4>: 5
Specify center of polygon or [Edge]: (pick P1 or type E to define by edge length)
Enter an option [Inscribed in circle/Circumscribed about circle] <I>: (to accept the inscribed default or type C for circumscribed)
Specify radius of circle: (pick P2 or enter exact radius)

In the illustration above, the polygon on the left is inscribed (inside the circle with the polygon vertexes touching it), the one in the middle is circumscribed (outside the circle with the polyline edges tangential to it) and the one on the right is defined by the length of an edge.

The Donut Command
This command draws a solid donut shape, actually it's just a closed polyline consisting of two arc segments which have been given a width. AutoCAD asks you to define the inside diameter i.e. the diameter of the hole and then the outside diameter of the donut. The donut is then drawn in outline and you are asked to pick the centre point in order to position the donut. You can continue picking centre points to draw more donuts or you can hit ↵ to end the command. Surprisingly, donuts are constructed from single closed polylines composed of two arc segments which have been given a width. Fortunately AutoCAD works all this out for you, so all you see is a donut.

Command Sequence

Command: DONUT
Specify inside diameter of donut <0.5000>: (pick any two points to define a diameter or enter the exact length)
Specify outside diameter of donut <1.0000>: (pick any two points to define a diameter or enter the exact length)
Specify center of donut or <exit>: (pick P1)
Specify center of donut or <exit>: ↵ (to end or continue to pick for more doughnuts)

As an alternative to picking two points or entering a value for the diameters, you could just hit ↵ to accept the default value. Most AutoCAD commands that require user input have default values. They always appear in triangular brackets like this <default value>.

Curiously enough AutoCAD doesn't seem to mind if you make the inside diameter of a donut larger than the outside diameter, try it and see.

The Revcloud Command

Command Sequence

Command: REVCLOUD
Minimum arc length: 66.6377 Maximum arc length: 116.6159
Specify start point or [Arc length/Object] <Object>: (Pick P1)
Guide crosshairs along cloud path...
Move the mouse to form a closed shape; the command automatically ends when a closed shape is formed.
Revision cloud finished.

You can use the "Arc length" option to control the scale of the revision cloud. This is achieved by specifying the minimum and maximum arc length. The "Object" option is used to transform any closed shape, such as a polyline, spline or circle into a revision cloud.

The 3D Polyline Command

The 3D Polyline command works in exactly the same way as the Polyline command. The main difference between a normal polyline and a 3D polyline is that each vertex (pick point) of a 3D polyline can have a different value for Z (height). In normal (2D) polylines, all vertexes must have the same Z value.

3D polyline objects are not as complex as their 2D cousins. For example, they cannot contain arc segments and they cannot be given widths. However, they can be very useful for 3D modeling.

Command Sequence

Command: **3DPOLY**
Specify start point of polyline: (pick a point)
Specify endpoint of line or [Undo]: (pick another point)
Specify endpoint of line or [Undo]: (pick a third point)
Specify endpoint of line or [Close/Undo]: ←(to end, C to close or continue picking points)

Notice that you are not prompted for a Z value each time you pick a point. You must either use one of the Object Snaps to pick a point with the required Z value or use the ".XY" filter to force AutoCAD to prompt for a Z value.

Circles, Arcs etc.

Along with Line and Polyline, the Circle command is probably one of the most frequently used. Fortunately it is also one of the simplest. However, in common with the other commands in this section there are a number of options that can help you construct just the circle you need. Most of these options are self explanatory but in some cases it can be quite confusing. The Circle command, for example, offers 6 ways to create a circle, while the Arc command offers 10 different methods for drawing an arc. The sections below concentrate mainly on the default options but feel free to experiment.

The Circle Command
The Circle command is used to draw circles. There are a number of ways you can define the circle. The default method is to pick the centre point and then to either pick a second point on the circumference of the circle or enter the circle radius at the keyboard.

**Command Sequence**

**Command:** CIRCLE

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

Specify radius of circle or [Diameter] <50.0195>:

As you can see from the command prompt above the default options are always indicated in triangular brackets like so <Default> and command options appear within square brackets like so [Option]. Each option is separated by a forward slash like this / . You can choose to use the alternative options by typing them at the prompt. For example, the circle command gives you three extra options to define a circle. 3P which uses any three points on the circumference, 2P which uses two points on the circumference to form a diameter and Ttr which stands for Tangent Tangent Radius. Obviously to use this last option you need to have drawn two lines which you can use as tangents to the circle. Try these options out to see how they work. Note that to invoke a command option, you need only type the upper-case part of the option name. For example, if you want to use the Ttr option, you need only enter "T". There are two more circle options on the pull-down menu that enable you to draw a circle by defining the center and diameter or by using 3 tangents.

**The Arc Command**

**Command:** ARC

The Arc command allows you to draw an arc of a circle. There are numerous ways to define an arc, the default method uses three pick points, a start point, a second point and an end point. Using this method, the drawn arc will start at the first pick point, pass through the second point and end at the third point. Once you have mastered the default method try some of the others. You may, for example need to draw an arc with a specific radius. All of the Arc command options are available from the pull-down menu.

**Command Sequence**
Command: **ARC**
Specify start point of arc or [Center]: (pick P1)
Specify second point of arc or [Center/End]: (pick P2)
Specify end point of arc: (pick P3)

It is also possible to create an arc by trimming a circle object. In practice, many arcs are actually created this way. See the Trim command on the Modifying Objects tutorial for details.

### The Spline Command

**Toolbar**  
Draw

**Pull-down**  
Draw ➤ Spline

**Keyboard**  
**SPLINE** short-cut **SPL**

The Spline command creates a type of spline known as a nonuniform rational B-spline, NURBS for short. A spline is a smooth curve that is fitted along a number of control points. The Fit Tolerance option can be used to control how closely the spline conforms to the control points. A low tolerance value causes the spline to form close to the control points. A tolerance of 0 (zero) forces the spline to pass through the control points. The illustration on the right shows the effect of different tolerance values on a spline that is defined using the same four control points, P1, P2, P3 and P4.

Splines can be edited after they have been created using the SPLINEDIT command, **Modify ➤ Object ➤ Spline** from the pull-down menu. Using this command, you can change the tolerance, add more control points move control points and close splines, amongst other things. However, if you just want to move spline control points, it is best to use grips. See the Stretching with Grips section of the Modifying Objects tutorial for details.

**Command Sequence**

Command: **SPLINE**
Specify first point or [Object]: (Pick P1)
Specify next point: (Pick P2)
Specify next point or [Close/Fit tolerance] <start tangent>: (Pick P3)
Specify next point or [Close/Fit tolerance] <start tangent>: (Pick P4)
Specify next point or [Close/Fit tolerance] <start tangent>: ←
Specify start tangent: (pick a point)
Specify end tangent: (pick a point)

You can create linear approximations to splines by smoothing polylines with the PEDIT command, Modify Polyline from the pull-down menu. However, you can also turn polylines into true splines using the Object option of the Spline command.

The Ellipse Command

Toolbar Draw
Pull-down Draw ▶ Ellipse ▶ Axis, End
Keyboard ELLIPSE short-cut EL

The Ellipse command gives you a number of different creation options. The default option is to pick the two end points of an axis and then a third point to define the eccentricity of the ellipse. After you have mastered the default option, try out the others.

Command Sequence
Command: ELLIPSE
Specify axis endpoint of ellipse or [Arc/Center]:
(pick P1)
Specify other endpoint of axis: (pick P2)
Specify distance to other axis or [Rotation]: (pick P3)

The ellipse command can also be used to draw isometric circles. See the worked example in the Drawing Aids tutorial to find out how to do this and how to draw in isometric projection with AutoCAD.

The Ellipse Arc Command

Toolbar Draw
Pull-down Draw ▶ Ellipse ▶ Arc
Keyboard ELLIPSE ← A short-cut EL ← A

The Ellipse Arc command is very similar to the Ellipse command, described above. The only difference is that, in addition to specifying the two axis end points and the "distance to other axis" point, you are prompted for a start and end angle for the arc. You may specify angles by picking points or by entering values at the command prompt. Remember that angles are measured in an anti-clockwise direction, starting at the 3 o'clock position.

In truth, the Ellipse Arc command is not a new or separate
command; it is just an option of the Ellipse command and it therefore has no unique command line name. It is curious why Autodesk considered this option important enough to give it its own button on the Draw toolbar. Still, there it is.

**Command Sequence**

**Command:** **ELLIPSE**

Specify axis endpoint of ellipse or [Arc/Center]: A
Specify axis endpoint of elliptical arc or [Center]: (pick P1)
Specify other endpoint of axis: (pick P2)
Specify distance to other axis or [Rotation]: (pick P3)
Specify start angle or [Parameter]: 270
Specify end angle or [Parameter/Included angle]: 90

**The Region Command**

**Toolbar**     Draw
**Pull-down**  Draw ▶ Region
**Keyboard**   REGION short-cut REG

A region is a surface created from objects that form a closed shape, known as a loop. The Region command is used to transform objects into regions rather than actually drawing them (i.e. you will need to draw the closed shape or loop first). Once a region is created, there may be little visual difference to the drawing. However, if you set the shade mode to "Flat Shaded", View ▶ Shade ▶ Flat Shaded, you will see that the region is, in fact a surface and not simply an outline. Regions are particularly useful in 3D modeling because they can be extruded.

Before starting the Region command, draw a closed shape such as a rectangle, circle or any closed polyline or spline.

**Command Sequence**

**Command:** **REGION**

Select objects: (Pick P1)
Select objects: ←
1 loop extracted.
1 Region created.

You can use the boolean commands, Union, Subtract and Intersect to create complex regions.

**The Wipeout Command**

**Toolbar**     custom
**Pull-down**  Draw ▶ Wipeout
**Keyboard**   WIPEOUT
A Wipeout is an image type object. Most commonly it is used to "mask" part of a drawing for clarity. For example, you may want to add text to a complicated part of a drawing. A Wipeout could be used to mask an area behind some text so that the text can easily be read, as in the example shown on the right.

The Wipeout command can be used for 3 different operations. It can be used to draw a wipeout object, as you might expect, but it can also be used to convert an existing closed polyline into a wipeout and it can be used to control the visibility of wipeout frames.

Command Sequence

Command: WIPEOUT
Specify first point or [Frames/Polyline] <Polyline>: (Pick P1)
Specify next point: (Pick P2)
Specify next point or [Undo]: (Pick P3)
Specify next point or [Close/Undo]: (Pick P4)
Specify next point or [Close/Undo]:

You can use as many points as you wish in order to create the shape you need. When you have picked the last point, use right-click and Enter (or hit the Enter key on the keyboard) to complete the command and create the wipeout.

You may find that it is easier to draw a polyline first and then convert that polyline into a wipeout. To do this, start the Wipeout command and then Enter to select the default "Polyline" option. Select the polyline when prompted to do so. Remember, polylines must be closed before they can be converted to wipeouts.

In most cases, you will probably want to turn off the wipeout frame.

Command Sequence

Specify first point or [Frames/Polyline] <Polyline>: F (the Frames option)
Enter mode [ON/OFF] <ON>: OFF
Regenerating model.

The Frames option is used to turn frames off (or on) for all wipeouts in the current drawing. You cannot control the visibility of wipeout frames individually. You should also be aware that when frames are turned off, wipeouts cannot be selected. If you need to move or modify a wipeout, you need to have frames turned on.

It is often more convenient to draw the wipeout after the text so that you can see how much space you need. In such a case, you may need to use the DRAWORDER command (Tools ▶ Display Order ▶ Option) to force the text to appear above the wipeout.

Tip: If you have the Express Tools loaded, you can use the very useful TEXTMASK command, which automatically creates a wipeout below any selected text. Find it on your pull-down at Express ▶ Text ▶ Text Mask
Points and Point Styles

Points are very simple objects and the process of creating them is also very simple. Points are rarely used as drawing components although there is no reason why they could not be. They are normally used just as drawing aids in a similar way that Construction Lines and Rays are used. For example, points are automatically created when you use the Measure and Divide commands to set out distances along a line.

When adding points to a drawing it is usually desirable to set the point style first because the default style can be difficult to see.

The Point Command

The point command will insert a point marker in your drawing at a position which you pick in the drawing window or at any co-ordinate location which you enter at the keyboard. The default point style is a simple dot, which is often difficult to see but you can change the point style to something more easily visible or elaborate using the point style dialogue box. Points can be used for "setting out" a drawing in addition to construction lines. You can Snap to points using the Node object snap. See the Object Snap tutorial for details.

Command Sequence

Command: POINT
Current point modes: PDMODE=0 PDSIZE=0.0000
Specify a point: (pick any point)

Strangely, in Multiple Point mode (the default for the Point button on the Draw toolbar) you will need to use the escape key (Esc) on your keyboard to end the command. The usual right-click or enter doesn't work.

The Point Style Command

You can start the point style command from the keyboard by typing DDPTYPE or you can start it from the pull-down menu at Format Point... The command starts by displaying a dialogue box offering a number of options.

To change the point style, just pick the picture of the style you want and then click the "OK" button. You will need to use the Regen command, REGEN at the keyboard or View Regen
from the pull-down to force any existing points in your
drawing to display in the new style. Any new points created after the style has been set will automatically
display in the new style.

One interesting aspect of points is that their size can be set to an absolute value or relative to the screen size,
expressed as a percentage. The default is for points to display relative to the screen size, which is very useful
because it means that points will remain the same size, irrespective of zoom factor. This is particularly
convenient when drawings become complex and the drawing process requires a lot of zooming in and out.

**Multilines**

Multilines are complex lines that consist of between 1 and 16 parallel lines, known as *elements*. The default
multiline style has just two elements but you can create additional styles of an almost endless variety. The
Multiline Style command enables you to create new multiline styles by adding line elements, changing the
colour and linetype of elements, adding *end caps* and the option of displaying as a solid colour.

**The Multiline Command**

- **Toolbar**
  - custom

- **Pull-down**
  - Draw ▶ Multiline

- **Keyboard**
  - MLINE 
  - short-cut ML

The Multiline command is used to draw multilines. This process of drawing is pretty much the same as
drawing polylines, additional line segments are added to the multiline as points are picked. As with polylines,
points can be unpicked with the Undo option and multilines can be closed.

When you start the Multiline command you also have the option to specify the Justification, Scale and Style of
the multiline. The Justification option allows you to set the justification to "Top", the default, "Zero" or "Bottom".
When justification is set to top, the top of the multiline is drawn through the pick points, as in the illustration
below. Zero justification draws the centreline of the multiline through the pick points and Bottom draws the
bottom line through the pick points. Justification allows you to control how the multiline is drawn relative to
your setting out information. For example, if you are drawing a new road with reference to its centre line, then
Zero justification would be appropriate.

The Scale option allows you to set a scale factor, which
effectively changes the width of the multiline. The
default scale factor is set to 1.0 so to half the width of
the multiline, a value of 0.5 would be entered. A value
of 2.0 would double the width.

The Style option enables you to set the current
multiline style. The default style is called "Standard".
This is the only style available unless you have
previously created a new style with the Multiline Style
command. Follow the command sequence below to see how the Multiline command works and then try changing the Justification and Scale options.

**Command Sequence**

Command: **MLINE**

Current settings: Justification = Top, Scale = 20.00, Style = STANDARD

Specify start point or [Justification/Scale/Style]: (Pick P1)

Specify next point: (Pick P2)

Specify next point or [Undo]: (Pick P3)

Specify next point or [Close/Undo]: ← (to end or continue picking or C to close)

**The Multiline Style Command**

The Multiline style command is used to create new multiline styles, which can then be used with the Multiline command. When you start the command for the first time, you will see the Multiline Styles dialogue box indicating that the Standard style is "Current". To create a new style, enter a new style name in the "Name" edit box by overwriting "STANDARD" and enter an optional description in the "Description" edit box. The dialogue box should now look something like the one on the right. When you are happy with the new name and description, simply click on the "Add" button. Your new style will now appear in the "Current" box.

The new style you have created is simply a copy of the Standard style, so the next step is to change the style to suit your own purposes. Click on the "Element Properties..." button to proceed.

You will now see the Element Properties dialogue box appear. This dialogue box allows you to add new line elements or delete existing ones and to control the element offset, colour and linetype. Click the "Add" button to add a new element. A new line element now appears with an offset of 0.0, in other words, this is a centre line. Highlight the top element in the "Elements" list and change the offset to 1.0 by entering this value in the "Offset" edit box. Now do the same with the
bottom element remembering to enter a value of -1.0 because this is a negative offset. You now have a multiline that is 2 \textit{drawing units} wide with a centre line.

Let's now change the colour and linetype of the centre line.

Highlight the 0.0 offset element by clicking it in the "Elements" list. To change the colour, simply click on the Colour… button and select an appropriate colour from the palette. When a colour has been selected, click the "OK" button on the palette to return to the Element Properties dialogue box.

Changing the linetype is a little more complicated because we will need to load the required linetype first. However, click on the "Linetype…” button to proceed.

The Select Linetype dialogue box appears with just a few solid linetypes listed, ByLayer, ByBlock and Continuous. Click on the "Load…” button. The Load or Reload Linetypes dialogue box now appears. Scroll down the list of linetypes until you find one called "Hidden". Highlight Hidden and then click the "OK" button. You will now see the Hidden linetype appear in the "Loaded linetypes" list in the Select Linetype dialogue box, which should now look similar to the one shown above. Finally, highlight Hidden and click the "OK" button. Your Element Properties dialogue box should now look similar to the one in the illustration above. To complete our new style, we will add some end caps and a solid fill. Click on the "Multiline Properties…” button to proceed.

In the Multiline Properties dialogue box, click in the "Line" check boxes under "Start" and "End". This will have the effect of \textit{capping} the ends of the multiline with a 90 degree line. As you can see from the dialogue box you can change this angle if you wish to give a chamfered end. Next, click the "On" check box in the "Fill" section and then click on the Colour… button and select the fill colour from the palette. The Multiline Properties dialogue box should now look like the one in
the illustration on the left. Finally, click the "OK" button in the Multiline Properties dialogue box and again in the Multiline Style dialogue box. You are now ready to draw with your new multiline.

Start the Multiline command, pick a number of points and admire your handiwork. If you have followed this tutorial closely, your new multiline should look something like the one in the illustration on the right. Notice the effect of the various changes you have made compared with the Standard multiline style.

One limitation of multiline styles is that you cannot modify a style if there are multilines referencing the style in the current drawing. This is a shame because it means that it is not possible to update multiline styles in the same way as it is possible to update text or dimension styles. You also cannot change the style of an existing multiline. If you really want to modify a multiline style, you will have to erase all multilines that reference the style first.

If you are new to AutoCAD, the whole process of working with multilines and creating multiline styles may appear a little bewildering because it touches upon a number of aspects of the program with which you may not be familiar. If this is the case, it may be a good idea to return to this tutorial in the future. Multilines are useful because they can save lots of time but their use is fairly specific and you should think carefully before using them. It may, for example, be more convenient simply to draw a polyline and to create offsets using the Offset command.

Tips & Tricks

- You will have noticed that many of the draw commands require the ← key on the keyboard to be pressed to end them. In AutoCAD, clicking the right mouse key and selecting "Enter" from the context menu has the same effect as using the ← key on the keyboard. Using the right-click context menu is a much more efficient way of working than using the keyboard.

- You can also use the ← key or right mouse click to repeat the last command used. When a command has ended, you can start it again by right clicking and selecting "Repeat command" from the context menu rather than entering the command at the keyboard or selecting it from the pull-down or toolbar. By this method it is possible, for example, to repeat the line command without specifically invoking it. The command sequence might be something like the one below.

Command Sequence

Command: **LINE**

Specify first point: (pick P1)

Specify next point or [Undo]: (pick P2)

Specify next point or [Undo]: (right-click and select Enter)

Command: (right-click and select Repeat Line)

Specify first point: (pick P1)
Specify next point or [Undo]: (pick P2)
Specify next point or [Undo]: (right-click and select Enter)
Command: (right-click and select Repeat Line)...

You could continue this cycle as long as you needed, using only the mouse for input.

- You can change the Linetype of any of the objects created in the above tutorial. By default all lines are drawn with a linetype called "Continuous". This displays as a solid line. However, lines can be displayed with a dash, dash-dot and a whole range of variations. See the Object Properties tutorial for details.
Object Selection

by David Watsor

Introduction
Before you start to use the AutoCAD Modify commands, you need to know something about selecting objects. All of the Modify commands require that you make one or more object selections. AutoCAD has a whole range of tools which are designed to help you select just the objects you need. This tutorial is designed to demonstrate the use of many of the selection options. As with so many aspects of AutoCAD, developing a good working knowledge of these options can drastically improve your drawing speed and efficiency.

Selecting Objects by Picking
Perhaps the most obvious way to select an object in AutoCAD is simply to pick it. Those of you who have used other graphics based utilities will be familiar with this concept. Generally all you have to do is place your cursor over an object, click the mouse button and the object will be selected. In this respect AutoCAD is no different from any other graphics utility.

When you start a Modify command such as ERASE, two things happen. First, the cursor changes from the usual crosshairs to the pickbox and second, you will the the "Select objects" prompt on the command line. Both of these cues are to let you know that AutoCAD is expecting you to select one or more objects.

To select an object, place the pickbox over a part of the object and left-click the mouse. When the object has been picked it is highlighted in a dashed line to show that it is part of the current selection and the command line reports "1 found". You will now see the "Select objects" prompt on the command line again. At this point you can continue adding more objects to the current selection by picking them or you can press ↓ or the Space Bar to complete the selection.

When you pick one or more objects in response to the "Select objects" prompt, you are effectively creating a selection set. Selection sets are an important concept in AutoCAD because they can be used to great effect, especially when drawings become large or complicated.

An Example
Follow the example below to get an idea how a selection set can be created by picking objects.
Draw Two Circles

Draw two circles using the CIRCLE command. **Draw ▶ Circle ▶ Center, Radius** from the pull-down menu or from the Draw toolbar. The size and position of the circles does not matter.

Command: **CIRCLE**

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (pick a point in the middle of the drawing window)

Specify radius of circle or [Diameter] <8.3453>: (pick another point to define the circle circumference)

Command: **CIRCLE**

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (pick the center point of the second circle)

Specify radius of circle or [Diameter] <37.9174>: (pick another point to define the circle circumference)

Erase the Two Circles

Erase the two circles using the ERASE command, **Modify ▶ Erase** from the pull-down or from the Modify toolbar.

Command: **ERASE**

Select objects: (place the pickbox over a circle circumference and left-click)

1 found

Select objects: (place the pickbox over the second circle circumference and left-click)

1 found

Select objects: (press ← to complete the selection and erase the objects)

Creating selection sets by picking objects can become quite tedious if you want to select a large number of objects. Just imagine having to pick a hundred or more objects in a large drawing! Fortunately AutoCAD provides a number of selection options which can help you select objects more efficiently.

Window Selection

The Window option is invoked by typing **W** in response to the "Select objects" prompt. Window allows you to define a rectangle using two points in exactly the same way as the RECTANGLE command. Once the window is defined, all objects which lie entirely within the window will be selected.
Command Sequence

Command: (start one of the Modify commands such as ERASE)
Select objects: W
First corner: (pick first corner)
Specify opposite corner: (pick second corner)
Select objects: (at this point you can either select more objects or ← to complete the selection set and continue with the current command.)

Crossing Window Selection

The Crossing Window option is invoked by typing C at the “Select objects” prompt and is a variation of the Window command. The command sequence is exactly the same but objects are selected which lie entirely within the window and those which cross the window border.

Implied Windowing

Although you can explicitly invoke the Window and Crossing Window selection boxes by entering W or C at the keyboard when prompted to “Select objects”, in practice this is rarely done. Both of these selection options are so commonly used that AutoCAD provides a method of implied windowing so that you don’t have to use the keyboard at all. You can test this out without using any command. If you pick a point in space on the graphic window, you will notice that AutoCAD automatically assumes that you want to define a selection window and uses the pick point as the first point of that window. If you move the cursor to the right of the pick point you will get a Window selection box (solid line). If you move the cursor th the left you will get a Crossing Window selection box (broken line). With a little bit of practice the use of implied windowing can make the whole drawing process very efficient and you will rarely find yourself having to explicitly invoke the window selection options from the keyboard.

The Undo option

It often happens that you inadvertently add objects which you don't want to a selection set during its compilation. When this occurs in the middle of a complicated selection it can be pretty annoying. Fortunately
AutoCAD allows you to undo the last selection made during the compilation of a selection set. All you need do is enter \textit{U} at the next "Select objects" prompt to remove the objects previously added.

**Selecting All Objects**

The All option is invoked by typing \textit{ALL} at the "Select objects" prompt. You can use this option to select all the objects in the current drawing, no picking is required. Objects on Locked or Frozen layers are not selected but objects on layers which are simply turned off are selected.

**Fence Selection**

The Fence option allows you to draw a multi-segment line, like a Polyline. All objects which cross the fence will be selected. The Fence option is invoked by typing \textit{F} at the "Select objects" prompt.

**Command:**

(start one of the Modify commands such as ERASE)

**Command Sequence**

Select objects: \textit{F}

First fence point: (pick first point)

Specify endpoint of line or [Undo]: (pick second point)

Specify endpoint of line or [Undo]: (pick another point or \textrightarrow to end fence selection)

Select objects: (\textrightarrow to complete the selection set or add more objects)

**Window Polygon Selection**

The Window Polygon option, invoked by typing \textit{WP} is similar to the Window option except that you can define an irregular polygon shape within which objects will be selected. As with the Window option, only objects which fall entirely within the polygon will be selected.

**Command Sequence**

Command: (start one of the Modify commands)

Select objects: \textit{WP}

First polygon point: (pick first point)

Specify endpoint of line or [Undo]: (pick second point)

Specify endpoint of line or [Undo]: (pick third point)

Specify endpoint of line or [Undo]: (pick another point or \textrightarrow to end polygon selection)

Select objects: (\textrightarrow to complete the selection set or add more objects)

A polygon is formed by picking at least three points.

**Crossing Polygon Selection**

The Crossing Polygon option can be used in exactly the same way as the Window Polygon option but it has the same selection criteria as the Crossing Window option, i.e. objects will be selected if they fall entirely
within or touch the polygon boundary. This option is invoked by typing CP at the "Select objects" prompt.

**Note:** Lines, polygons and windows drawn using the selection options do not exist as drawing objects. Once the selection has been made they disappear.

### Using a Previous Selection

AutoCAD always remembers the last selection set you defined. This is very useful because you may need to make a number of changes using different commands to the same group of objects. In order to re-select the last selection set you can use the Previous option. The previous option is invoked by typing P at the "Select objects" prompt.

### Selecting the Last Object

You can select the last object created by entering L at the "Select objects" prompt.

### Object Cycling

When drawings become complicated it is sometimes difficult to select the particular object you want because it is either very close to or overlies another object. In such a case it may happen that the other object is selected and not the one you want. Object cycling is designed to overcome this problem. If you make a pick whilst holding the Control (Ctrl) key down, AutoCAD will respond with "<Cycle on>". If you continue to pick, each object near the pick point is highlighted in rotation. Just keep picking until the object you want is highlighted, then right-click or , AutoCAD responds "<Cycle off>", the required object is added to the selection set and you can continue to select more objects as normal.

### Adding and Removing Objects

AutoCAD provides two methods for adding and removing objects to and from a selection set. As you know, objects can be added to a selection set simply by picking them or by using one of the methods outlined above. You can remove selected objects from a selection set just as easily by *shift picking*. If you hold the Shift key down on the keyboard while picking a selected object, that object will be deselected (removed from the current selection set). You can tell when a selected object has been deselected because it is no longer highlighted. You can remove more than one object at a time by holding down the Shift key while using implied windowing. However, none of the other selection options which require keyboard input will work using the shift pick method.

If you need to remove a more complex selection from the current selection set you should use the Remove option to switch to Remove mode. If you enter R at the "Select objects" prompt, AutoCAD will respond:

```
Remove objects:
```

Objects now picked or selected using any of the above methods will be removed from the current selection set. When you have finished removing objects, you can return to Add mode by entering A at the "Remove objects" prompt.

You can use any combination of picking, selection options and add/remove modes to define your selection set. Once you are happy that you have selected all the objects you need, just hit → to complete the selection.
process and to continue with the current command.

When you feel confident with the basic selection tools, have a look at the Advanced Selection tutorial to find out how to use AutoCAD's advanced selection tools for creating complex selection sets.

**Tips & Tricks**

- When you are picking objects in a complex drawing, use the ZOOM command transparently to make object selection easier. All Zoom options selected from the toolbars are automatically transparent but if you invoke the command from the keyboard you will need to enter `zoom`. 
Modifying Objects

Introduction

AutoCAD drawings are rarely completed simply by drawing lines, circles etc. Most likely you will need to Modify these basic drawing objects in some way in order to create the image you need. AutoCAD provides a whole range of modify tools such as Move, Copy, Rotate and Mirror. As you can see, the command names are easily understandable. However, the way these commands work is not always obvious. This tutorial is designed to show you how all of the Modify commands work. If you just need information quickly, use the QuickFind toolbar below to go straight to the information you need or select a topic from the contents list above.

As is usual with AutoCAD, the Modify tools can be accessed in one of three ways, from the keyboard, from the pull-down menu and from the toolbar. All of the Modify tools are available from the Modify pull-down and the Modify toolbar. In each section below, the toolbar, pull-down and keyboard options are given. The method you choose is entirely up to you. Ultimately you will use the method that you feel most comfortable with or the one you find most efficient. AutoCAD allows great flexibility and there aren't any right or wrong ways of working. That said, it should be pointed out that the use of toolbars in AutoCAD is almost always quicker than any other method.
The Modify toolbar is usually displayed by default but if it is not already displayed, you can display it using the TOOLBAR command, View Toolbars… from the pull-down menu. When the Toolbar dialogue box (shown above) appears, simply check the box next to "Modify" in the toolbars list. Many AutoCAD users work with the Modify toolbar permanently docked on their screen because it gives one-click access to all of the commands, making the drawing process much more efficient.

The Erase Command

 Toolbar   Modify  
 Pull-down  Modify  Erase  
 Keyboard   ERASE   short-cut  E

The Erase command is one of the simplest AutoCAD commands and is one of the most used. The command erases (deletes) any selected object(s) from the drawing. Remember you can always get deleted objects back by typing U to undo, from the Standard toolbar or by using the OOPS command.

Command Sequence

Command: ERASE  
Select objects: (pick an object to erase)  
Select objects: ← (to end the selection and erase the object)

If you simply want to erase the last object you created you can type L at the "Select objects" prompt. The last object will be highlighted and you can then select more objects or ← to end the command. See the "Object Selection" tutorial for more information on selecting objects.
The Copy Command

The Copy command can be used to create one or more duplicates of any drawing object or objects which you have previously created. Copy is a very useful and time-saving command because you can create very complex drawing elements and then simply copy them as many times as you like.

Command Sequence

Command: COPY
Select objects: (pick object to copy, P1)
Select objects: (to end selection)
Specify base point or displacement, or [Multiple]: (pick P2 or M for multiple copies)
Specify second point of displacement or <use first point as displacement>: (pick P3)

The multiple option allows you to create additional copies of the selected object(s) by picking as many new points as you like. To end a multiple copy, just hit the ← key.

Notice that the "Base point", P2 and the "Second point", P3 do not have to be picked on or near the object. The two points are simply used to indicate the distance and direction of the copied object from the original object.

The Mirror Command

The Mirror command allows you to mirror selected objects in your drawing by picking them and then defining the position of an imaginary mirror line using two points.
Command Sequence

Command: **MIRROR**
Select objects: (pick object to mirror, P1)
Select objects: ← (to end selection)
Specify first point of mirror line: (pick P2)
Specify second point of mirror line: (pick P3)
Delete source objects? [Yes/No] <N>: ← (for No to keep the original object)

Notice that in the command sequence above, pressing the ← key when asked whether to "Delete source objects?" resulted in a "No" response. This is because "No" is the default option. AutoCAD always shows the default option within triangular brackets, in this case "<N>". Many AutoCAD commands offer default options. They are usually the most commonly used and you need only right-click and select "Enter" from the menu or press ← on the keyboard to accept them.

In order to create perfectly horizontal or vertical mirror lines use Ortho. For more information on the use of Ortho and other drawing aids, see the "Drawing Aids" tutorial.

**The Offset Command**

Toolbar  Modify  
Pull-down  Modify  Offset  
Keyboard  OFFSET  short-cut  O

Offset is probably one of the most useful commands for constructing drawings. The Offset command creates a new object parallel to or concentric with a selected object. The new object is drawn at a user defined distance (the offset) from the original and in a direction chosen by the user with a pick point. You can offset lines, arcs, circles, ellipses, 2D polylines, xlines, rays and planar splines.

Command Sequence

Command: **OFFSET**
Specify offset distance or [Through] <1.0000>: 10 (specify distance)
Select object to offset or <exit>: (select object, P1)
Specify point on side to offset: (pick direction, P2)
Select object to offset or <exit>: ← (to end or select another object to offset)
In the illustration below, a line (cyan) has been offset to the right through a distance "Offset" by picking a point to the right of the original line. The result is a new line (red) to the right of the original.

Circles can be offset inside or outside of themselves to create a new circle which is concentric (has the same centre point) with the original circle. In the illustration, a new circle (red) has been created outside of the original by picking a point outside of the original circle. The radius of the new circle is the offset distance "Offset" plus the radius of the original circle.

In the illustration above, the new objects and original objects are shown in different colours for clarity. In reality, offset objects inherit their object properties from the original object. See the "Object Properties" tutorial for details.

**The Array Command**

*Toolbar*  Modify  
*Pull-down*  Modify ▶ Array
*Keyboard*  ARRAY  short-cut  AR

The Array command makes multiple copies of selected objects in a rectangular matrix (columns and rows) or a polar (circular) pattern. This command has been completely transformed in AutoCAD 2000i. It is now completely dialogue box driven with the option to see a preview of the array before it is created. You can also now create rectangular arrays at a user specified angle. This constitutes a major improvement in usability.

**The Rectangular Array**

The illustration on the right shows the results of a rectangular array with two columns and three rows. The distance between rows is indicated with the dimension DR and between columns with DC. When creating rectangular arrays it is important to remember that new rows are created above the original object and new columns are created to the right of the original object. The resulting array is, therefore, always created with the original object in the bottom left hand position with respect to the current co-ordinate system. In the
illustration, the original object is shown in cyan and the new objects in red. It is possible to create arrays which do not align with the World Co-ordinate System by setting a User Co-ordinate System first. See the UCS tutorial for details.

Try creating this array yourself. First, draw a rectangle 20 drawing units wide and 10 drawing units tall. To do this, start the rectangle command Draw Rectangle from the pull-down menu. When you are prompted to pick a point, pick somewhere in the lower left quarter of the drawing area. Then, when you are prompted for a second point, enter the relative cartesian co-ordinate @20,10. You have now drawn a rectangle at the right size. See the Using Co-ordinates tutorial for more information on drawing with co-ordinates.

Now start the Array command. First of all, make sure that the Rectangular Array radio button is selected and that you are looking at the Rectangular Array dialogue box and now follow the steps below:

1. Click the Select objects button. The dialogue box will temporarily disappear enabling you to select the rectangle you just drew. Press the Return button on your keyboard to complete the selection. You are now returned to the dialogue box and the message immediately below the Select Objects button should read “1 objects selected”.

2. Enter the number of rows required in the Rows edit box. For this example, enter the value "3". Notice that the schematic preview on the right hand side of the dialogue box updates to reflect the values you are entering.

3. Enter the number of columns required in the Columns edit box. Enter the value "2".

4. Enter the row offset in the Row Offset edit box. This is the distance DR in the illustration above. Note that this is not the distance between rows. In this example, our rectangle is 10 units high and we will enter a row offset of 15. The result will be a 5 unit gap between rectangles.
5. Enter the column offset in the Column Offset edit box. The same parameters apply as for the row offset. Enter a value of 25 to give a 5 unit gap between our rectangles.

6. Click on the Preview button. Once again, the dialogue box disappears and the specified array is temporarily drawn so that we can preview it. We are now offered 3 choices. If the array isn't quite right, click the Modify button to return to the Array dialogue box. If you are happy with the array, click the Accept button, the array will be permanently drawn and the command is ended.

You should now have an array that looks similar to the one in the illustration above consisting of 6 rectangles arranged in 3 rows and 2 columns. As you can see, this command is very powerful and can save lots of time if used carefully.

The Polar Array

The polar array works in a similar way to the rectangular array. The main difference is that rather than specifying the number and offset for rows and columns, you must specify a center point and the total number of objects in the array (including the original object).

You can try this for yourself by drawing another rectangle as described above. This time, though, locate the rectangle in the centre top half of the drawing area. Now, start the Array command, click the Polar Array radio button and follow the steps below:

1. Click the Select objects button. The dialogue box will temporarily disappear enabling you to select the rectangle you just drew. Press the Return button on your keyboard to complete the selection. You are
now returned to the dialogue box and the message immediately below the Select Objects button should read "1 objects selected".

2. Specify the center point for the array. This is the point C in the illustration below. You can do this by entering x and y co-ordinates into the appropriate edit boxes if you know what these values should be. However, this is rarely the case and most often you will want to click the Pick Center Point button to pick a point from the drawing area. Pick a point somewhere below the rectangle you have just drawn.

3. Enter a value for the total number of items. For this example, enter the value "6". Notice that once again, the schematic preview updates to reflect the values you have entered.

4. Make sure that the Rotate items as copied checkbox is checked.

5. Click on the Preview button. Once again, the dialogue box disappears and the specified array is temporarily drawn so that we can preview it. We are now offered 3 choices. If the array isn't quite right, click the Modify button to return to the Array dialogue box. If you are happy with the array, click the Accept button, the array will be permanently drawn and the command is ended.

The array you have just drawn should look something like the one illustrated below, left. Take some time to play around with the other options in the Array dialogue box to see what they can do.

![Polar Array](image)

The illustration above shows the results of a polar array using an original rectangle (cyan) copied six times about a centre point C, through an angle of 360 degrees (full circle). The only difference between the array on the left and the one on the right is that the Rotate items as copied checkbox was not checked in the right hand example.

All new objects created with the Array command will inherit the object properties of the original object. See the "Object Properties" tutorial for information on object properties.

**The Move Command**
The Move command works in a similar way to the Copy command except that no copy is made, the selected object(s) is simply moved from one location to another.

**Command Sequence**

**Command:** MOVE

Select objects: (pick object to move, P1)

Select objects: ← (to end selection)

Specify base point or displacement: (pick P2)

Specify second point of displacement or <use first point as displacement>: (pick P3)

Note that as with the Copy command, the two pick points, P2 and P3 are used only to indicate the distance and direction of movement.

**The Rotate Command**

**Command:** MOVE

Select objects: (pick object to move, P1)

Select objects: ← (to end selection)

Specify base point or displacement: (pick P2)

Specify second point of displacement or <use first point as displacement>: (pick P3)

Note that as with the Copy command, the two pick points, P2 and P3 are used only to indicate the distance and direction of movement.

**The Rotate Command**

**Toolbar** Modify ◆

**Pull-down** Modify ◦ Rotate

**Keyboard** ROTATE short-cut RO

The Rotate command allows an object or objects to be rotated about a point selected by the user. AutoCAD prompts for a second rotation point or an angle which can be typed at the keyboard.
Command Sequence

Command: ROTATE

Current positive angle in UCS: ANGDIR=counterclockwise ANGBASE=0

Select objects: (pick object to rotate, P1)
Select objects: ← (to end selection)
Specify base point: (pick base point, P2)
Specify rotation angle or [Reference]: (pick second point, P3 or enter angle)

Remember, by default, AutoCAD angles start at 3 o'clock and increase in an anti-clockwise direction. The "ANGDIR" and "ANGBASE" variables remind you of this. If you want to rotate in a clockwise direction you can enter a negative angle by using a minus sign.

Note: You can change the angle direction and the base angle using the Units command, Format ▶ Units... from the pull-down menu. Click the "Clockwise" check box to change the direction and click the "Direction..." button to set the base angle.

The Scale Command

Toolbar  Modify  
Pull-down  Modify ▶ Scale  

Keyboard  SCALE  short-cut  SC

The Scale command can be used to change the size of an object or group of objects. You are prompted for a pick point about which the selection set will be scaled. Scaling can then be completed by picking a second point (not always easy because it can sometimes be difficult to precisely control the scaling) or by entering a scale factor at the keyboard. For example a scale factor of 2 will double the size of the objects in the selection set and a factor of 0.5 will half them.
Command Sequence

Command: **SCALE**
Select objects: (pick objects to be scaled, P1)
Select objects: ← (to end selection)
Specify base point: (pick base point, P2)
Specify scale factor or [Reference]: (pick second point, P3 or enter scale factor)

In the example shown above, the original tree symbol has been enlarged by dynamically scaling it using pick points to determine the change in scale. If you want to scale an object precisely, it is much easier to enter a scale factor using the keyboard.

Note that the position of the new sized tree symbol is determined by the location of the base point. The base point, P2 has been picked to the upper right of the centre of the tree which resulted in the centre of the tree shifting to a lower left position. If the base point had been picked in the centre of the tree symbol, the tree would have remained in the same position. In theory the base point can be any point in the drawing area but for ease of control it is best to choose a known point so that the results are obvious.

The Stretch Command

 Toolbar Modify
 Pull-down Modify Stretch
 Keyboard STRETCH short-cut S

The Stretch command can be used to move one or more vertices of an object whilst leaving the rest of the object unchanged. In the example below, a rectangle has been stretched by moving one vertex to create an irregular shape.
Command Sequence

Command: **STRETCH**
Select objects to stretch by crossing-window or crossing-polygon...
Select objects:  (pick first point of crossing window)
Specify opposite corner:  (pick second point of window)
Select objects:  ↓ (to end selection)
Specify base point or displacement:  (pick base point)
Specify second point of displacement:  (pick second point)

To select vertices to stretch, you must use a crossing window or polygon. See the "Object Selection" tutorial for details of these selection methods.

**Stretching with Grips**

Although the Stretch command can be very useful, it has largely been superseded by the use of "Grips" which allow this sort of modification to be made much more intuitively.

To stretch an object using grips, simply select the object by clicking on it (you can do this without starting a command). The object becomes highlighted and small square grips appear at each vertex and various snap points, depending upon the object type. Click a grip to activate it and click again to reposition it. When you have completed your modifications, use the Escape key (Esc) at the top left of your keyboard to deselect the object and release grips.

**The Lengthen Command**

Toolbar  **Modify**
Pull-down  **Modify ➤ Lengthen**
Keyboard  **LENGTHEN** short-cut **LEN**

The Lengthen command can often be used instead of either the Trim or Extend commands. Indeed the end result is exactly the same. The Lengthen command can be used to either lengthen or shorten Lines, Arcs, open Polylines, elliptical Arcs and open Splines without the use of cutting or boundary edges.

Command Sequence

Command: **LENGTHEN**
Select an object or [Delta/Percent/Total/Dynamic]: **DY**
Select an object to change or [Undo]: (select a line or arc)
Specify new end point: (pick new end point)
Select an object to change or [Undo]: ← (to end)

The command sequence above demonstrates the use of the Dynamic Lengthen option which is probably the most useful for general purpose drafting. However, the other options are worth getting to know because they can save lots of time and effort.

The Total option allows you to change the total length of a line to any value that you specify. The Percent option allows you to change a line length using a percentage. For example, a value of 50 will result in a line one half the length of the original and a value of 200 will result in a line twice the length of the original. The Delta option can be used to extend or reduce the endpoint of a line by a given distance. The endpoint affected by the change is the one closest to the pick point when the object selection is made.

The Trim Command

The Trim command can be used to trim a part of an object. In order to trim an object you must draw a second object which forms the "cutting edge". Cutting edges can be lines, xlines, rays, polylines, circles, arcs or ellipses. Blocks and text cannot be trimmed or used as cutting edges. The illustration on the right shows the Trim command in action. The red square and circle have been drawn using the Polygon and Circle commands respectively. In order to trim these objects, a line has been drawn (cyan in the illustration), this forms the cutting edge. The Trim command, unlike most other modify commands requires that two separate object selections are made. The cutting edges are selected first (there can be one or more) and then the objects to be trimmed are selected. In the example above, the line is selected first because it forms the cutting edge and then the square and circle are selected.

The Trim command is slightly more complicated than many other modify commands. To get a better understanding of how it works, draw a square, circle and line as illustrated above and then follow the command sequence below. Don't forget to watch the AutoCAD command line at each stage of the process.

Command Sequence

Command: TRIM
Current settings: Projection=UCS Edge=None
Select cutting edges ...
Select objects: (select the cutting edge, P1)
Select objects: ← (to end cutting edge selection)
Select object to trim or shift-select to extend or [Project/Edge/Undo]: (pick the part of the square which you want to trim, P2)
Select object to trim or shift-select to extend or [Project/Edge/Undo]: (pick the circle, P3)
Select object to trim or shift-select to extend or [Project/Edge/Undo]: ← (to end)

Notice that at each trimming step you are given the option to undo the previous trim. This can be very useful if you inadvertently pick the wrong object.

In the above example, when the objects were trimmed, both pick points were made to the right of the cutting edge, resulting in the removal of that part of the objects to the right of the cutting edge. Obviously, the portion of square and circle to the left of the cutting edge could have been removed by picking to the left of the cutting edge. Also, you may not have noticed it, but by trimming a circle you have created an Arc object. This makes no visible difference but the object type has changed.

The Extend Command

Toolbar Modify
Pull-down Modify ▶ Extend
Keyboard EXTEND short-cut EX

This command extends a line, polyline or arc to meet another drawing object (known as the boundary edge). In the illustration on the right, two lines (red) are extended to meet another line (cyan) which forms the boundary edge. This command works in a similar way to the Trim command, described above. Two selections are made, one for the boundary edge(s) and one for the object(s) to extend.

Lines and other objects can be extended in one of two directions. In the illustration on the right, the red line could be extended either to the right or to the left. You can tell AutoCAD in which direction to extend by picking a point to the right or left of the midpoint respectively. AutoCAD does not intuitively know where the boundary edge lies so you must explicitly indicate the direction of extension by picking either one side or other of the midpoint.

Draw the lines as shown in the illustration and follow the command sequence below.

Command Sequence

Command: EXTEND
Current settings: Projection=UCS Edge=None
Select boundary edges ...

Select objects: (select the boundary edge, P1)
Select objects: ← (to end boundary edge selection)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: (pick the object which you want to be extended, P2)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: (pick another object which you want to be extended, P3)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: ← (to end)

Sometimes you may get the message "Object does not intersect an edge" or "No edge in that direction". If this happens it means that you are either picking the wrong end of the object or the object you are trying to extend will not meet the boundary edge. The solution is either to pick near the end you want to extend or to move the boundary edge so that the extended line will intersect with it.

Using Edgemode

If the line you are trying to extend does not intersect with the boundary line, you can use the "Edge" option to toggle Edgemode to "Extend" (the default is "No Extend"). When the Extend command is set to Extend Mode, the objects being extended will extend to an imaginary line through the boundary edge, irrespective of whether the extended object actually intersects with the boundary edge. This is particularly useful and can save lots of time.

The illustration on the left shows the result of extending a line (red) to a boundary edge (cyan) with Edgemode set to "Extend". The same process would have resulted in an error message if Edgemode had been set to "No Extend". To get a better understanding of how this works, draw the two lines as shown in the illustration and try to extend them using the default settings. When you have done that, follow the command sequence below.

Command Sequence (Edgemode)

Command: EXTEND
Select boundary edges: (Projmode = UCS, Edgemode = No extend)
Select objects: (select the boundary edge, P1)
Select objects: ← (to end boundary edge selection)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: E (to use the Edge option)
Enter an implied edge extension mode [Extend/No extend] <No extend>: E (to set Edgemode to Extend)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: (pick the
object to be extended, P2)
Select object to extend or shift-select to trim or [Project/Edge/Undo]: ← (to end)

Notice that the current value of Edgemode is always displayed on the command line when you start the Extend command. The Edge option can also be used with the Trim command to enable trimming to cutting edges which do not actually intersect the object to trim. Edgemode is a system variable, so any change to its value will affect both the Trim and Extend commands.

See the Lengthen command for more ways to extend and trim objects.

**Shift Selection with Trim & Extend**

You may have noticed during the command sequences for the Trim and Extend commands that you have the option to "shift-select". This feature is new to AutoCAD 2000i and it enables you to extend while using the Trim command and to trim while using the Extend command. These two commands are very closely related and you often need to trim and extend objects at the same time. If you are a beginner with AutoCAD it may be a good idea to avoid this feature initially, the Trim and Extend commands can be tricky to get to grips with in any case. However, do remember this feature because it is a great time saver.

**The Break Command**

**Toolbar**
Modify

**Pull-down**
Modify ▶ Break

**Keyboard**
BREAK short-cut BR

The Break command enables you to break (remove part of) an object by defining two break points. In the illustration below, a corner of a rectangle has been removed. The Break command can be used with lines, polylines, circles, arcs ellipses, splines, xlines and rays. When you break an object, you can either select the object using the first break point and then pick the second break point, or you can select the object and then pick the two break points.

![Break Command Illustration](image)

**Command Sequence**

Command: **BREAK**
Select objects: (select the object using the first break point, P1)
Specify second break point or [First point]: (pick the second break point, P2)
The section of the object is removed and the command ends.

Sometimes you may want to select the object first and then specify the two break points. If this is the case,
use the "First point" option to specify the first break point. By default, AutoCAD assumes that the point used to select the object is the first break point. This is often confusing for new users.

It may sometimes be necessary to break a line into two without removing any part of it. In this case, simply pick the first and second break points in the same position.

The Chamfer Command

Toolbar  Modify  
Pull-down  Modify ➤ Chamfer
Keyboard  CHAMFER  short-cut  CHA

The Chamfer command enables you to create a chamfer between any two non-parallel lines as in the illustration below or any two adjacent polyline segments. Usually, the Chamfer command is used to set the chamfer distances before drawing the chamfer. Follow the command sequence below where the chamfer distances are changed to 20 before the chamfer is made.

Command Sequence

Command: CHAMFER
(TRIM mode) Current chamfer Dist1 = 10.0000, Dist2 = 10.0000
Select first line or [Polyline/Distance/Angle/Trim/Method]: D (to set distances)
Specify first chamfer distance <10.0000>: 20 (enter required distance)
Specify second chamfer distance <20.0000>: ← (first distance value or enter a different value)
Select first line or [Polyline/Distance/Angle/Trim/Method]: (pick P1)
Select second line: (pick P2)
The chamfer is made and the command ends.

Notice from the command sequence that there are a number of options which can be used to control the way the Chamfer command behaves. The Polyline option can be used to chamfer all vertexes of a polyline simultaneously. The Distance option allows you to specify the two chamfer distances. Angle allows the angle between the first line and the chamfer to be specified. Trim is used to control whether the original lines are trimmed to the chamfer or remain as they are. Finally, Method is used to toggle the command between Distance and Angle mode. When Angle mode is used, the chamfer is defined using one distance and an angle rather than two distances.

The Fillet Command

Toolbar  Modify
The Fillet command is a very useful tool which allows you to draw an arc between two intersecting lines or adjacent polyline segments. You first need to use the command to set the required radius and then a second time to select the two lines.

Command Sequence

Command: **FILLET**
Current settings: Mode = TRIM, Radius = 10.0000
Select first object or [Polyline/Radius/Trim]: **R**
Specify fillet radius <10.000>: 25
Select first object or [Polyline/Radius/Trim]: (pick P1)
Select second object : (pick P2)

The Fillet command can also be used to fillet arcs and circles. The "Polyline" option also allows you to fillet all vertices of a polyline with a single command. It's worth experimenting with this command, it can save you lots of time and enables you to construct shapes which otherwise would be quite difficult.

![Diagram](before_after_fillet.png)

For example, you can easily create the lozenge shape shown on the right from a simple rectangle. Since AutoCAD rectangles are just closed polylines, you can use the Polyline option of the Fillet command to fillet all polyline vertexes simultaneously. Try this for yourself; draw a rectangle and then follow the command sequence below.

Command Sequence

Command: **FILLET**
Current settings: Mode = TRIM, Radius = 10.0000
Select first object or [Polyline/Radius/Trim]: **P**
Select 2D polyline: (pick P1)
4 lines were filleted

**Tip:** Make sure that the radius you specify will fit the objects you select, otherwise the fillet command will not work.
The Explode Command

**Toolbar**  Modify  

**Pull-down**  Modify  ▶ Explode  

**Keyboard**  EXPLODE

The Explode command is used to "explode" single objects back to their constituent parts. In other words, the command is used to return blocks, polylines etc. (which may be composed of a number of component objects) back to their individual component parts. The change has no visible effect.

**Tips & Tricks**

- Always look at the command line for guidance when you are learning new AutoCAD commands. The command line will prompt you for information and this is the easiest way to find out how a new command works. This is especially true for the more complicated commands like Trim and Extend.

- The command line window displays 3 lines of text by default. You can change this by clicking and dragging the top of the window frame. When you are starting with AutoCAD you may like to see more than 3 lines. The illustration below shows the command line window increased in size to 6 lines.

```
Command: _trim
Current settings: Projection=WCS Edge=None
Select cutting edges . . .
Select objects: 1 found
Select objects:
Select object to trim or [Project/Edge/Undo]:
```

- The command line can also be displayed as a floating text window. The AutoCAD text window is displayed by pressing the F2 key on the keyboard. See Function Keys on the Drawing Aids tutorial for more details.

- You can control the way text is mirrored using the MIRRTEXT variable.

- You can use the Fillet command with a radius of zero to trim intersecting lines back to their intersection. Of course, you could also achieve this effect with the Trim command but if you have a number of operations to complete, the Fillet method is much quicker.

- When using the Trim and Extend commands, hitting when prompted to "Select cutting edges" and "Select boundary edges" respectively will automatically select all valid cutting or boundary edges on the screen. This can be a real time saver if you have a complicated set of edges to select.
Direct Distance Entry

by David Watson

Introduction

Direct distance entry is one of those AutoCAD features that is often overlooked. This is rather unfortunate because it can be extremely useful and an amazing time-saver. Basically, direct distance entry enables you to draw an object, such as a line, by pointing in a particular direction with the cursor and entering a distance at the command line.

How does it work?

Say, for example, you wanted to draw a horizontal line with a length of 30 drawing units. Start the Line command, Draw ▶ Line from the pull-down menu or from the Draw toolbar. When prompted, to specify the first point for the line, pick a point somewhere on the left side of the drawing area.

You now need to constrain the line to the horizontal. You can do this using Polar Tracking. Use the POLAR button on the status bar to turn on Polar Tracking. Usually, Polar Tracking is on by default, so you may not need to do this.

Now, move your cursor to the right of the first pick point. If you are within a few degrees of the horizontal, you should see something similar to the illustration on the right. Hold your cursor in this position and simply enter 30 at the keyboard. When you hit the Return key, a line segment is drawn, 30 units long and in the direction you were pointing.

Obviously, you could vary this sequence to get different effects. If you only want to draw horizontal or vertical lines, you could use Ortho rather than Polar Tracking. Or, you could configure polar tracking to snap to other angles like 45° or 30°. You might even want to turn both Ortho and Polar Tracking off and use free angles. See the Drawing Aids tutorial to learn more about Polar Tracking.

It's also worth pointing out that when Polar Tracking has snapped to an angle, as in the illustration above, a Tool Tip is displayed. This Tool Tip displays a relative polar co-ordinate from the first pick point to the current cursor position. The first number is the distance between the two points and it can be quite useful as a drawing guide since the value updates dynamically. See the Using Co-ordinates tutorial for more information on polar co-ordinates.

To get a clearer idea how direct distance entry works, follow the worked example below.
A Worked Example

In this exercise, we will use direct distance entry to draw the closed shape shown below using the associated dimensions.

1. Check that you have either Polar Tracking or Ortho mode turned on.

2. Start the Polyline command, Draw → Polyline from the pull-down menu or from the Draw toolbar.

3. When prompted to specify the first point, pick a point somewhere in the lower left quadrant of the drawing area. This will be the point marked "start" in the illustration.

4. Now, follow the command sequence below. In each case, point the cursor in the direction you want the line drawn and enter the distance for that particular line segment at the keyboard.

   Point up
   Specify next point or [Arc/Halfwidth/Length/Undo/Width]: 40

   Point right
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 15

   Point down
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 25

   Point right
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 20

   Point up
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 25

   Point right
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 15

   Point down
   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: 40

   You should now be at the point marked "end" on the illustration. All you need to do now is enter "C" to close the polyline and end the command.

   Specify next point or [Arc/Close/Halfwidth/Length/Undo/Width]: C

The closed polyline shape you have drawn is located arbitrarily because you just picked a start point somewhere in the drawing area. If you had wanted to start at a particular location, you could have entered a co-ordinate value for the start point instead of just picking. See the Using Co-ordinates tutorial for more
Obviously, the exercise above is a very simple example but there are many circumstances where direct distance entry can be used. It's a very useful tool to add to your AutoCAD skills toolbox and can help you towards greater drawing efficiency. If you would like more practice using direct distance entry, have a go at the site layout exercise.
Introduction

Drawing with AutoCAD is really just like drawing on a drawing board. Most newcomers to Computer Aided Design assume that they will need to learn how to draw all over again. In fact, many of the drawing aids that AutoCAD provides are analogous to traditional drafting tools. Just as you have a parallel motion and set squares to help you draw horizontal and vertical lines on a drawing board, AutoCAD has similar drawing aids which can help you to draw horizontal and vertical lines on a computer. This means that in many respects, the drawing techniques are very similar. If you ever get stuck, think how you would complete a task on a drawing board and then look for a similar way to do it with AutoCAD.

Ortho Mode

Ortho is short for orthogonal, which means either vertical or horizontal. Like the other options on the status bar, Ortho is not really a command, it is a drawing mode which can either be turned on or off. Ortho mode can be toggled on or off in one of three ways. The quickest way is just to click on the ORTHO button on the status bar. The appearance of the button tells you whether Ortho is currently turned on or turned off. When Ortho is turned on, the ORTHO button appears pressed in. You can see how this appears by looking at the status bar illustration below. In the illustration, Ortho is turned on but Grid and Snap are turned off.

Ortho can also be toggled on and off using the F8 Function key (see Function Keys below for more details). Finally, you can also type ORTHO at the command prompt as in the command sequence below. Using Ortho is the equivalent of using your parallel motion and set square on a drawing board. With Ortho mode turned on you can only draw lines which are either vertical or horizontal. Turn Ortho mode on now and draw some lines to get a feeling for how it works.

Command Sequence

Command: ORTHO
Enter mode [ON/OFF] <OFF>: (type ON or OFF)

Ortho mode is probably the simplest of all the drawing aids, and historically one of the oldest. It is either on or it is off and there are no special settings to make. Also, it does a very simple job; it constrains drawn lines to
the horizontal or the vertical. You may not be surprised to learn, therefore, that its use has largely been
superceded by more recent features, particularly Polar Tracking, described below.

The Drawing Grid

Status Bar  GRID (right-click for settings)
Pull-down  None
Keyboard  GRID or F7

The drawing grid is a regular pattern of dots displayed on the screen which acts as a visual aid, it is the
equivalent of having a sheet of graph paper behind your drawing on a drawing board. You can control the grid
spacing, so it can give you a general idea about the size of drawn objects. It can also be used to define the
extent of your drawing. See, Setting Grid Limits, for more details.

Command Sequence

Command: GRID

Specify grid spacing(X) or [ON/OFF/Snap/Aspect] <10.000>: (enter grid spacing)

Although you can use the command line to control the visibility of the grid by using the "ON" and "OFF"
options this is more easily achieved using the F7 key or, better still, by clicking the GRID button on the status
bar. However, the command line does offer some additional options. The Snap option allows you to
automatically set the grid spacing to the current snap spacing (see Snap Mode below). You can also change
the aspect ration of the grid. By default, the X and Y spacing of the Grid are the same, resulting in a regular
square matrix of grid points. But you can display a grid with different X and Y spacing by using the "Aspect"
option.

Grid mode and X/Y spacing can also be set using the Drafting Settings dialogue box. You
can access grid settings by right-clicking the Grid button on the status bar and selecting
Settings… from the menu. You can also do this from the pull-down menu, Tools
Drafting Settings… and click on the "Snap and Grid" tab.

You may have noticed that the grid does not extend infinitely in all directions. In fact, it is only displayed within
a finite rectangle. You can control the extent of the visible grid using Drawing Limits.
Setting Grid Limits

Drawing Limits is used to define the extent of the grid display and to toggle Limits mode which can be used to define the extent of your drawing. The grid is displayed within a rectangle defined by two pick points or co-ordinates.

Command Sequence

Command: **LIMITS**

Reset Model space limits:

Specify lower left corner or [ON/OFF] <0.0000,0.0000>:

(pick point, enter co-ordinates or ← to accept the default value)

Specify upper right corner <420.0000,297.0000>:

(pick point, enter co-ordinates or ← to accept the default value)

Drawing Limits can also be used to turn Limits mode on or off. Limits mode can be used to control where objects can and cannot be drawn. Limits is turned off by default which means that there is no restriction as to where points can be picked and objects drawn. When Limits is on, AutoCAD will not allow points to be picked or co-ordinates entered at the command line which fall outside of the specified drawing limits. If you try to pick a point outside the drawing limits when Limits mode is turned on, AutoCAD reports to the command line:

**Outside limits**

Limits mode is useful if you know the extent of your plotted drawing sheet and you want to prevent objects being drawn outside of this area. However, Drawing Limits is most commonly used simply to control the extent of the Grid.

Snap Mode

Status Bar **SNAP** (right-click for settings)

Pull-down None

Keyboard **SNAP** or F9

Snap mode takes AutoCAD one step further than the drawing board. With Snap mode turned on AutoCAD only allows you to pick points which lie on a regular grid. The Snap grid is completely independent of the display grid. However, the Grid spacing and Snap spacing are usually set to the same value to avoid confusion. You can force the display grid to conform with the snap grid by setting the display grid spacing to zero. The display grid will then automatically change each time the snap grid is changed. When Snap mode is turned on and the Grid is displayed, the Snap and Grid spacings are the same and the crosshairs will jump from one grid point to another as you move across the screen. This makes it very easy to draw objects which have a regular shape. The Snap command is used to set the snap spacing and to toggle Snap mode.
Command Sequence

Command: **SNAP**

Specify snap spacing or [ON/OFF/Aspect/Rotate/Style/Type] <10.0000>: (enter the required snap spacing in drawing units)

Although you can use the Snap command to turn Snap mode on and off, it is much more efficient to use the F9 function key on the keyboard or to click the SNAP button on the status bar.

The "Aspect" option can be used to vary the horizontal and vertical snap spacings independently.

"Rotate" is used to set the snap grid to any angle.

You can also set the snap style to either Isometric or Standard (the default) using the "Style" option. The Standard style is used for almost all drawing situations including detail drawings in Orthographic Projection. The Isometric style is specifically to aid the creation of drawings in Isometric Projection (see the illustrations on the right).

The "Type" option allows you to set the snap type to either Grid (the default) or to Polar. The Polar option can be used in conjunction with Polar Tracking so that Snap mode snaps along polar tracking angles rather than to the grid.

The grid snap is particularly useful if you need lots of modular objects such as bricks or paviors. In the illustration on the left, the Aspect option is used to set the X and Y snap spacings to the brick dimensions and the Rotate option is used to set the orientation of the bond. Once these settings are made, the bricks can be accurately drawn without any other drawing aids.

All of the Snap variables can also be set using the Drafting Settings dialogue box. Right-click on the SNAP button and choose Settings… from the menu.

**Drafting Settings**

Toolbar: None
The Snap and Grid mode settings, can also be made from the Drafting Settings dialogue box, illustrated below. This dialogue can be invoked from the command line or from the pull-down menu but probably the simplest way is to right-click on either the GRID or SNAP buttons on the status bar and choose "Properties..." from the context menu. The advantage of the Drafting Settings dialogue box is that it gives you one-stop access to all the Grid and Snap settings.

These options act in the same way as those in the respective commands described above, see The Snap Command and The Grid Command for details. If you are creating drawings in isometric projection, use the "Isometric snap" option to change the grids from the standard orthogonal square grid to a 30 degree isometric grid.
Polar Tracking

Status Bar  **POLAR** (right-click for settings)
Pull-down  None
Keyboard  F10

Polar Tracking is a bit like Ortho mode on steroids. Whereas Ortho constrains your lines to either the horizontal or the vertical, Polar Tracking allows you to snap into whatever angles you choose to configure.
In this default setting, Polar Tracking works like a more flexible version of Ortho but if you look at the Polar Tracking tab on the Drafting Settings dialogue box, you will see just how versatile it can be. Right-click on the POLAR button on the status bar and choose Settings… from the menu.

You can use the Increment angle drop-down list to select one of the preset angle increments. For example, if the increment angle is set to 22.5 degrees, Polar Tracking will snap at 22.5 degree increments starting with zero degrees.

Incidentally, you will notice that the reported angle on the tool tip shown in the illustration on the right is “23”, whereas the actual snap angle is 22.5 degrees. This is because angular units are set to display only whole degrees and so, 22.5 is rounded up to 23. See the Units and Scale tutorial for more information on changing the precision with which angular measurements are reported.

You may sometimes need to snap to specific angles. Say you are working on a drawing of a site and the buildings are orientated in a particular way. If you know the angle, you can use the Additional angles option to add this specific angle so that Polar Tracking will snap to it.

To set additional angles, all you need to do is click on the New button and enter the value in the list. The Delete button can be
used to remove unwanted angles. It is also possible to temporarily suspend Additional angles. You can do this by deselecting the Additional angles check box. When you do this the angles list is greyed out and those angles won’t be used for Polar Tracking until you check the box again.

One of the great benefits of Polar Tracking is that, when used in combination with direct distance entry, you can draw lines of a given length and at a preset angle without using any construction lines and without the need for entering relative co-ordinates. Drawing using this technique can be extremely efficient. See the Direct Distance Entry tutorial for more details.

The Function Keys

Many of the modes described above can be controlled quickly using the keyboard function keys. In most cases this is quicker than using a pull-down or the command line. The function keys are arranged along the top of your keyboard. AutoCAD uses function keys F1 to F11. Their use is described below.

The F1 key on your keyboard brings up the "AutoCAD Help: User Documentation" dialogue box. You can use this dialogue box to search for help on any AutoCAD command or topic. To find help on a command or topic, click on the Index tab and enter a keyword. You will usually be given a list of options in the topics list; select the most appropriate and click the "Display" button to see the item.
The F2 key is used to toggle (turn on and off) the AutoCAD text window. This is a floating version of the command window which can be resized to suit your requirements. The text window contains the whole command history from the beginning of the drawing session. If you wish, you can scroll back to see which commands you have used. The text window is also useful for viewing the results of commands like LIST which report to the command line on a number of lines which may scroll off the command window and make them difficult to view.

The F3 key is used to toggle running Object Snaps on and off. See the Object Snap tutorial for details on the use of running Object Snaps.

The F4 key on your keyboard toggles tablet mode on and off. This only has an effect if a digitising tablet has been calibrated.
The **F5** key cycles through the *Isoplanes*, this only has an effect if "Isometric Snap/Grid" mode is on. The options are Left, Top and Right. The different options describe the plane in which Ortho mode works. It also affects the orientation of *Isocircles* drawn with the Ellipse command. The illustration on the right shows a cube with isocircles drawn on the top, left and right faces. Each isocircle was drawn using the corresponding isoplane. See Tips & Tricks for a worked example using isoplanes.

The **F6** key is a three way toggle which changes the co-ordinate reading in the status bar. By default the status bar shows co-ordinates using the Cartesian system. You can use the F6 key to turn the co-ordinate readout off and to change to the polar system when you are in pick mode. For a more detailed description of AutoCAD’s co-ordinate systems see the “Using Co-ordinates” tutorial.

The **F7** key is used to toggle grid mode on and off. When grid mode is on a grid of dots is shown on the screen as a drawing aid. You can set the grid spacing by using "Drafting Settings" from the “Tools” pull-down. The grid points do not necessarily reflect the snap setting, they can be set independently, however, you can force the grid to reflect the snap setting by giving the grid setting a value of zero.

The **F8** key on your keyboard can be used to toggle Ortho (orthogonal) mode on and off. When Ortho mode is on AutoCAD will only allow you to draw either vertical or horizontal lines. You can think of it as being a computer version of the parallel motion on your drawing board. You can see if Ortho mode is on by looking at the status bar. The "ORTHO" button is shown "pushed in" when Ortho is turned on.

The **F9** key can be used to toggle Snap mode on and off. Snap makes the *crosshairs* jump to points on a defined grid. The snap spacing can be set using the "Drafting Settings" dialogue box from the “Tools” pull-down menu. You can also see if Snap mode is on by looking at the status bar.

The **F10** key is used to switch polar tracking off and on. Polar Tracking allows you to snap to specific angles and these are user definable. See Polar Tracking for more details.

The **F11** key toggles object snap tracking on and off. See the Object Snap tutorial for more information on object snap tracking.

**Tips & Tricks** 

One of the most difficult aspects of drawing in isometric projection is the correct representation of circles. Obviously a circle in isometric projection looks like an ellipse (see illustration) but knowing exactly what aspect ratio to draw the ellipse at is difficult. Fortunately AutoCAD makes the whole process very simple. When "Isometric Snap/Grid" mode is turned on, the ellipse command gains an extra option, the "Isocircle" option. Follow the exercise below to draw a cylinder in isometric projection.

**Note:** During this exercise, you will be using the Quadrant Object Snap. See the Object Snap tutorial for more information on the use of Object Snaps.
Step 1 - Start a new drawing
Start AutoCAD and use the "Start from Scratch" option from the "Start Up" dialogue box. If you are already using AutoCAD, create a new drawing by clicking on the button and use "Start from Scratch" from the "Create New Drawing" dialogue box.

Step 2 - Make the Drafting Settings
Display the Drafting Settings dialogue box by selecting Drafting "Settings..." from the "Tools" pull-down menu. Click on the "Snap and Grid" tab. In the Snap type & style section of the dialogue, set the type to "Grid snap" and the style to "Isometric snap", as shown in the illustration. Now, check the two boxes at the top of the dialogue, once for "Snap On" and once for "Grid On". Click on the "OK" button to confirm these mode changes. The graphic window now displays a grid of dots arranged at an angle of 30 degrees and the crosshairs will jump from one dot to another. Notice also, that the crosshairs are oriented in the left hand isoplane.

Step 3 - Setting the correct isoplane
In this exercise, we will draw a cylinder which stands vertically. The circles which we draw must, therefore be drawn in the "Top" isoplane. Use the F5 key on the keyboard to change the isoplane to "Top". AutoCAD reports to the command line:

Command: <Isoplane Top>

Step 4 - Drawing the base circle
Circles in isometric projection are drawn using the Ellipse command. Start the Ellipse command by clicking on the button or by selecting Draw Ellipse Axis, End from the pull-down menu. Now look at the command line:

Command: _ellipse
Specify axis endpoint of ellipse or [Arc/Center/Isocircle]: I (Isocircle)
Specify center of isocircle: (pick a point in the lower half of the graphics window)
Specify radius of isocircle or [Diameter]: 30 (enter a radius of 30)

Your drawing should look like the one in the illustration above.

Step 5 - Copying the base circle
Start the Copy command by clicking on the button or selecting Modify Copy from the pull-down menu. Now look at the command line:

Command: _copy
Select objects: (pick the circle)
Tip: If you find picking the circle difficult, use the F9 key to turn off Snap.
Select objects: 
Specify base point or displacement, or [Multiple]: (pick the grid point in the centre of the circle)

**Note:** Use F9 to turn Snap back on if you turned it off.
Specify second point of displacement or <use first point as displacement>: (move the crosshairs vertically by 6 grid points and pick)

You should now have two isometric circles, one above the other.

**Step 6 - Drawing the sides**

Start the Line command by clicking the button or selecting **Draw ▶ Line** from the pull-down menu. Now look at the command line.

Command: \_line

Specify first point: (use the Quadrant Osnap to pick the left-hand quadrant of the lower isocircle)

**Tip:** There are a number of ways to invoke osnaps, they are available from the Osnap toolbar and from the keyboard. However, in this case it may be simplest to select Quadrant from the cursor menu. To do this, hold down the Shift key on the keyboard and click on the right hand mouse button. A menu will appear at the crosshair position. Simply select Quadrant from the menu.

Now, move the crosshairs near to the left hand quadrant point on the lower isocircle. You will see a yellow diamond appear at the quadrant point (see illustration). Pick the point.

Specify next point or [Undo]: (use the Quadrant Osnap again to pick the left-hand quadrant point on the upper isocircle)

Specify next point or [Undo]: (to end the Line command)

Now repeat this process to draw the right hand line or use the Copy command to copy the left hand line to the right. Remember to use the Quadrant Osnap to pick points whichever method you use. This will ensure that the line is drawn or copied in exactly the right place.

When you have completed this step, your drawing should look similar to the illustration on the right.

**Step 7 - Trimming the circle**

To complete the drawing we will remove the upper half of the lower isocircle to give the impression of a solid cylinder. To do this we will use the Trim command. Start the Trim command by clicking the button or selecting "Trim" from the "Modify" pull-down. Now look at the command line:

Command: \_trim

Current settings: Projection=UCS Edge=None
Select cutting edges ...
Select objects: (pick the two vertical lines)
**Tip:** You may need to turn Snap off (F9).

Select objects: ←
Select object to trim or [Project/Edge/Undo]: (pick the upper arc of the lower isocircle)
Select object to trim or [Project/Edge/Undo]: ← (to end the Trim command)

The isometric cylinder is now complete. Use F7 to turn the grid off and your drawing should look similar to the one in the illustration at the beginning of this exercise.
Units and Scales

by David Watson

Introduction

Among the most important concepts that newcomers to AutoCAD need to get to grips with are those of drawing scale and drawing units. You cannot start creating sensible drawings with AutoCAD until you are familiar with scale, units and the commands you use to control them. This tutorial discusses these concepts, starting with the two most commonly asked questions in this subject area.

At what scale should I draw?

As a general rule, everything you draw with AutoCAD will be drawn full size. This often comes as quite a surprise to those who are new to CAD and have spent a number of years working on a drawing board. When you start drawing with AutoCAD you do not have to decide upon a drawing scale as you do when using a drawing board. When drawing on paper you must decide do draw at say, 1:20 or 1:200 depending upon the size of the object that you are drawing so that your scaled drawing will fit on the drawing sheet, be that A3 or A1. In AutoCAD you do not need to decide upon a drawing scale until you come to print the drawing and because the scaling of your drawing takes place at the printing stage, you can create drawings at a scale of 1:1. This has particular advantages because you can, for example, measure lengths, areas and volumes within an AutoCAD drawing and not need to compensate for any scale factor.

Am I drawing in metres or millimetres?

Most people who use AutoCAD, draw using decimal drawing units. What these drawing units represent is entirely up to the individual. However, you must decide what units you will use before you start drawing. One drawing unit could represent one millimetre, one centimetre, one metre, kilometre, mile, furlong or fathom. It is entirely up to you. However, in most parts of the world it is common practice to work in either millimetres or metres. Which of these two units you use will largely depend upon the type of drawing you are creating. For example, if you were creating a detail drawing of a flight of steps, you would most likely use millimetres (Architects will almost always use millimetres). If, on the other hand you are drawing a landscape masterplan, you would probably want to work in metres (Landscape Architects and Civil Engineers usually use metres).

By way of example, consider a drawing where you need to draw a footpath in plan. The footpath is two metres wide. If you are working in millimetres, the footpath would be drawn 2,000 drawing units wide but if you are working in metres, the footpath would be drawn just 2 drawing units wide. To translate this into practical terms if you had drawn one edge of the path and you intended to draw the other edge using the Offset command, you would enter either “2,000” or “2” for the offset value depending upon whether you were using millimetres or metres respectively.

Although decimal drawing units are the most commonly used, you can configure AutoCAD to work with other types of drawing units. To change the unit type, you must use the Drawing Units dialogue box.
Units Control

When you start the Units command, the first thing you see is the Drawing Units dialogue box, shown on the right. The dialogue box is divided into four main sections. The upper two are "Length", which refers to linear units and "Angles", referring to angular units. Settings for linear units and angular units can be made independently and in each case, you can control both the type and precision. In addition, the Angles section also allows you to specify the direction in which angles are measured. See below for more details.

A third section, entitled Drawing units for Design Center blocks allows you to assign a specific unit to the drawing so that when blocks are inserted via the AutoCAD Design Centre, they will automatically be scaled. The final section, Sample Output, gives you a preview of the drawing units as they will be displayed using the current settings.

Linear Units

You can see from the dialogue box that there are five different linear unit types for you to choose from, one of which is "Decimal", the default. The table below shows the effect of the different unit settings on two drawing unit values to give you an idea how the various settings might be used along with a brief description.

<table>
<thead>
<tr>
<th>Unit Type</th>
<th>1.5 Drawing Units</th>
<th>1500 Drawing Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal</td>
<td>1.5000</td>
<td>1500.0000</td>
<td>Metric or SI units</td>
</tr>
<tr>
<td>Scientific</td>
<td>1.5000E+00</td>
<td>1.5000E+03</td>
<td>Decimal value raised to a power</td>
</tr>
<tr>
<td>Engineering</td>
<td>0'-1.5000&quot;</td>
<td>125'-0.0000&quot;</td>
<td>Feet and decimal inches</td>
</tr>
<tr>
<td>Architectural</td>
<td>0'-1 1/2&quot;</td>
<td>125'-0&quot;</td>
<td>Feet and fractional inches</td>
</tr>
<tr>
<td>Fractional</td>
<td>1 1/2</td>
<td>1500</td>
<td>Whole numbers and fractions</td>
</tr>
</tbody>
</table>

Notice that when you change the unit type, the co-ordinate display on the status bar changes to show coordinates using the current unit type. Changing the unit type also affects the way distances, areas and volumes are reported when using the appropriate inquiry command.
For the most part you should not need to change the unit type. Units such as "Architectural" and "Engineering" are there mainly for AutoCAD users in the USA where Feet and Inches are still in common use.

Angular Units

Looking at the Drawing Units dialogue box again, you will notice that there are also five angular unit types. The default is decimal degrees, but there are other options. The table below shows the effect of the different unit types on two angular unit values. As with the linear units, there are not many circumstances under which you would want to use anything other than the default.

<table>
<thead>
<tr>
<th>Unit Type</th>
<th>12.5 Angular Units</th>
<th>180 Angular Units</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Decimal Degrees</td>
<td>12.500</td>
<td>180.000</td>
<td>Metric units</td>
</tr>
<tr>
<td>Deg/Min/Sec</td>
<td>12d30'0&quot;</td>
<td>180d0'0&quot;</td>
<td>Degrees, Minutes and Seconds</td>
</tr>
<tr>
<td>Grads</td>
<td>13.889g</td>
<td>200.000g</td>
<td>400 grads = 360 degrees</td>
</tr>
<tr>
<td>Radians</td>
<td>0.218r</td>
<td>3.142r</td>
<td>2 Pi radians = 360 degrees</td>
</tr>
<tr>
<td>Surveyor</td>
<td>N 77d30'0&quot; E</td>
<td>W</td>
<td>Compass bearings</td>
</tr>
</tbody>
</table>

AutoCAD also allows you to control the direction in which angular units are measured and the position of the start angle. By default, AutoCAD starts with the zero angle at the 3 o'clock position (East) with angles increasing in an anti-clockwise direction. For the most part this does not present any problems once you get used to the idea. However, there are specific situations where it may be desirable to have the zero angle at the 12 o'clock position (North) and angles increasing in a clockwise direction. For example, if you are working on a surveyors drawing or a map base, this latter situation enables you to specify angles with respect to North. To change the direction of angular measurement, use the Clockwise check box in the Angle section of the Drawing Units dialogue box. When this box is checked, positive angles are measured in a clockwise direction, when it is not checked (the default), positive angles are measured in an anti-clockwise direction.

To change the start angle, click on the "Direction..." button in the Drawing Units dialogue box. The Direction Control dialogue box appears. You can set the Base Angle to any of the circle quadrants by clicking on the appropriate radio button or you can set it to a specific angle with the "Other" option. You can enter a specific angle into the edit box or you can pick an angle using the Pick an angle button. The ability to specify an "Other" or user angle can be useful if, for example, your drawing is not oriented to North but where you still want angular measurements to be made with respect to North. To change the direction of angular measurement, simply click on the appropriate radio button.

Unit Precision
The Drawing Units dialogue box can also be used to set the precision of linear and angular units. By default, AutoCAD sets the linear unit precision to four places of decimal, so distances appear in the form 0.0000. Angular unit precision is set to whole degrees only.

To change the precision with which linear and angular values are displayed, simply click the down arrow against the appropriate drop-down list (see illustration on the left) and select the number of decimal places required. The default setting of four decimal places is usually adequate for linear units. It is, however, often necessary to change the precision for angular units. Working in whole degrees does not usually give an adequate level of detail for many drawing functions. However, you do not need to change the precision of either linear or angular units unless you have a specific reason for doing so.

Changing the unit precision does not make your drawing more accurate, it just means that the co-ordinate display on the status bar and the results from the various inquiry commands will be displayed with a higher degree of precision. The accuracy of your drawing will be determined by the values you enter for the size of objects when you draw and edit them and by the correct use of the various object snaps and drawing aids. See the appropriate tutorials for more details.
Using Co-ordinates

by David Watso

Introduction

A good understanding of how co-ordinates work in AutoCAD is absolutely crucial if you are to make the best use of the program. If you are not familiar with co-ordinates and co-ordinate systems, take some time to familiarise yourself with the basic concepts.

Co-ordinates fall into two types, namely Cartesian and Polar. A basic understanding of these co-ordinate types will help you to use AutoCAD to construct drawings more easily. In addition, these two co-ordinate types come in two distinct flavours. They can be either Absolute or Relative. Knowing just when and where to use the various types and flavours of co-ordinate is the key to efficient drawing with AutoCAD.

Cartesian Co-ordinates

Despite the fancy title (named after the French philosopher and mathematician René Descartes 1596-1650), the Cartesian co-ordinate system is the standard co-ordinate system. The position of a point can be described by its distance from two axes, X and Y. This results in a simple point description using two numbers separated by a comma e.g. 34.897,45.473.

In the example on the right the point described lies 34.897 drawing units to the right of the Y axis and 45.473 drawing units above the X axis. The first value (34.897) is known as the X co-ordinate because it’s value is measured along the X axis. The second value is known as the Y co-ordinate because it’s value is measured along the Y axis. The X and Y axes are two lines of infinite length which intersect at the origin point. The co-ordinate value of the origin point is always 0,0. When viewed in plan the X and Y axes are always perpendicular to one another with the X axis in a horizontal position and the Y axis in a vertical position (See illustration). X co-ordinate values become negative to the left of the Y axis and Y co-ordinate values become negative below the X axis. All co-ordinate values (both X and Y) are negative in the lower left hand quadrant and positive in the upper right hand quadrant. Normally we try to work in the positive quadrant. Although this is not essential for AutoCAD to operate, it does tend to make life easier because we don't need to worry about negative numbers.
AutoCAD allows you to use co-ordinates to draw objects rather than using pick points. For example you could draw a line like this:

**Command Sequence**

Command: **LINE**

From point: \(34.897,45.473\)

To point: \(54.896,65.395\)

To point: \(\rightarrow\) (to end)

This sequence draws a line between the two co-ordinate points specified. Note that if you enter a co-ordinate that is off the screen the line will still be drawn to the required point. You will then need to zoom out in order to see the whole line. You can also start the Line command by clicking \(\rightarrow\) on the Draw toolbar or from the pull-down menu (Draw ➤ Line).

**Polar Co-ordinates**

Polar co-ordinates achieve the same result i.e. the description of the position of a point. The main difference is that polar co-ordinates use one distance and one angle to describe the position of a point rather than the two distances in the Cartesian system. The distance and angle measurements are made relative to an origin. This results in a point description which looks like this \(34.897<30\) where the first figure is the distance (in drawing units) and the second is the angle. Notice that the separator in the case of polar co-ordinates is the "less than" mathematical symbol. If you look at your keyboard you will see that this symbol is typed by using Shift and comma.

AutoCAD angles start at 3 o’clock (i.e. along the positive portion of the X axis) and increase in an anti-clockwise direction. You can specify negative angles if you need to define an angle in a clockwise direction although this is not really necessary because angles are circular, hence an angular value of -30 degrees will give the same result as an angular value of 330 degrees (there are 360 degrees in a full circle).

**The UCS Icon**

In the bottom left hand corner of the AutoCAD drawing window you will see a symbol like the one shown on the right. This is called the UCS (User Co-ordinate System) icon and it is there to remind you which is the X axis and which is the Y axis. The empty box at the intersection of the X and Y axes is there to remind you that you are using "World" co-ordinates and that the UCS icon is not positioned over the true origin of the current co-ordinate system, probably because it is off screen. See the UCS Icon tutorial for more details on this feature.
Absolute & Relative Co-ordinates

Both Cartesian and polar co-ordinates come in two flavours, absolute and relative. The distinction is quite simple, absolute co-ordinates relate to the X and Y axes and the origin of the current co-ordinate system, whilst relative co-ordinates relate to the current pick point. When you are specifying co-ordinates you need to tell AutoCAD which type you want. Absolute co-ordinates are typed exactly as in the examples above. To specify a relative co-ordinate you need to use the "at" symbol as a prefix. In the case of the two examples above a relative Cartesian co-ordinate looks like this @34.897,45.473 and a relative polar co-ordinate looks like this @34.897<30. Relative co-ordinates are very useful for drawing objects which you know the size of.

For example, you could draw a square of 12 units with its lower left hand point at 30,40 as follows:

Command Sequence

Command: **LINE**
From point: **30,40** (an absolute Cartesian co-ordinate)
To point: **@0,12** (a relative Cartesian co-ordinate)
To point: **@12<0** (a relative polar co-ordinate)
To point: **@0,-12** (another relative Cartesian co-ordinate)
To point: **C** (to close)

Try this sequence out and watch the square drawn as you enter each co-ordinate value. You can also use this method to quickly draw a rectangle of known size. Say you needed to draw a rectangle 20 drawing units wide and 10 drawing units high and you didn't mind where exactly the rectangle is drawn, you could do this:

Command Sequence

Command: **RECTANGLE**
Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (pick a point near the middle of the drawing area)
Specify other corner point or [Dimensions]: **@20,10**

Note that the relative X co-ordinate determines the rectangle width and the relative Y co-ordinate determines the rectangle height.

See the Direct Distance Entry tutorial for more ways to draw lines of known length.

The Status Bar

The status bar at the bottom of the AutoCAD window always shows the current co-ordinate value at the cursor point. Watch the co-ordinate values change as the cursor moves across the drawing area. You can turn the dynamic co-ordinate display off and on using the **F6** key on the keyboard. See Function Keys on the Drawing Aids tutorial for more details.
Object Snap

Introduction

The Object Snaps (Osnaps for short) are drawing aids which are used in conjunction with other commands to help you draw accurately. Osnaps allow you to snap onto a specific object location when you are picking a point. For example, using Osnaps you can accurately pick the end point of a line or the center of a circle. Osnaps in AutoCAD are so important that you cannot draw accurately without them. For this reason, you must develop a good understanding of what the Osnaps are and how they work.

This tutorial describes the use of all the osnaps. There are a number of worked examples which demonstrate Osnaps in use. Following these examples is probably the best way to understand the logic of Osnaps and to get an idea how they might be used in drawing practice. The tutorial also includes sections on tracking and the use of point filters. If you just need information quickly, use the QuickFind toolbar below to go straight to the information you need or select a topic from the contents list above.

An Example

This simple example is to give you an idea how Osnaps work. Follow the command sequence below to draw a circle and then to draw a line from the center point of the circle to a point on the circle's circumference at the 12 o'clock position.

To Draw the Circle

Command: CIRCLE
Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (pick a point in the middle of the drawing window)
Specify radius of circle or [Diameter]: (pick another point to draw the circle, the size is not important)

To Draw the Line using Osnaps

Command: LINE
From point: CEN (this is the short-cut for the Center Osnap) of (pick point P1 on the circumference of the circle)
To point: QUA (this is the short-cut for the Quadrant Osnap) of (pick point P2 on the circumference of the circle)
To point: (to end)

You have now drawn a line from the exact centre of the circle to a point on the
circle circumference vertically above the centre. The line is drawn with perfect geometric accuracy.

When you use Osnaps you need only pick a point which is near to the point required because AutoCAD automatically snaps to the object location implied by the particular Osnap you use. Notice that when you move the cursor close enough to an Osnap location, it is highlighted with an Osnap marker. Each Osnap has a different marker. As you have already seen, the Center Osnap marker is a circle and the Quadrant Osnap marker is a diamond. Notice also that when you move the cursor over a snap point the cursor jumps to the snap location. This feature is known as Magnet.

One thing that often catches new users out is that when you want to snap to the centre of a circle, the cursor must pass over the circle’s circumference. This is because the circle has no solidity, it is only an outline.

Although you can get quite close to the result above by picking freehand you will never be able to pick as accurately as you can using Osnaps. Many AutoCAD commands rely upon the fact that objects have been drawn accurately and so you should always use Osnaps when you need to pick a point at a particular location.

Object Snaps

There are four basic methods of accessing the Osnaps:

- The Osnaps are available from a flyout button on the Standard toolbar, see illustration on the right.
- The Osnaps are also available on their own Object Snap toolbar. If this toolbar is not already displayed, you can display it using the TOOLBAR command, View Toolbars… from the pull-down menu. When the Toolbar dialogue box appears, simply check the box next to "Object Snap" in the toolbars list. Many AutoCAD users work with the Object Snap toolbar permanently docked on their screen because it gives one-click access to all of the Osnaps, making drawing much more efficient.
- You can also access the Osnaps from the cursor menu. Hold the Shift key down on the keyboard and right-click the mouse to bring up the cursor menu. The menu appears at the current cursor position.
- Finally, you can also access the Osnaps from the keyboard by typing their abbreviated name. See the exercise above and the sections below for details.

The main reason for this flexibility in using the Object Snaps is that they are used very frequently. Experienced AutoCAD users will use Object Snaps all of the time because they are the only way to make sure that the objects you are drawing are drawn accurately. You must practice using Object Snaps until they become second nature.

There are thirteen Osnaps in all and although they are all useful in certain situations you will probably find yourself using about half of them on a regular basis and the other half in special circumstances. However, it's a good idea to get to know all of the Osnaps so that you can plan your drawing, knowing all of the tools at your disposal. A sensible use of Osnaps is the best way to improve your drawing efficiency.
Each of the sections below is accompanied by a small screen-shot illustrating the Osnap in use. In each case, drawing objects are shown in pale blue (cyan), the Osnap marker is shown in red and the cursor cross-hairs in white. The corresponding Snap Tip is also shown. Snap Tips appear if you let the cursor hover over an Osnap location for a second or so and have a similar function to the toolbar Tool Tips.

**Endpoint**

**Toolbar** Object Snap

**Pull-down** Shift + Right Click **Endpoint**

**Keyboard** END (when picking)

The Endpoint Osnap snaps to the end points of lines and arcs and to polyline vertices. This is one of the most useful and commonly used Osnaps.

**Midpoint**

**Toolbar** Object Snap

**Pull-down** Shift + Right Click **Midpoint**

**Keyboard** MID (when picking)

The Midpoint Osnap snaps to the mid points of lines and arcs and to the mid point of polyline segments.

**Intersection**

**Toolbar** Object Snap

**Pull-down** Shift + Right Click **Intersection**

**Keyboard** INT (when picking)

The Intersection Osnap snaps to the physical intersection of any two drawing objects (i.e. where lines, arcs or circles etc. cross each other) and to Polyline vertices. However, this osnap can also be used to snap to intersection points which do not physically exist. This feature is called the Extended Intersection (see the illustration on the right). To use the apparent intersection feature, you must pick two points to indicate which two objects should be used.

**Apparent Intersect**

**Toolbar** Object Snap

**Pull-down** Shift + Right Click **Apparent Intersect**

**Keyboard** APP or APPINT (when picking)
Apparent Intersection snaps to the point where objects appear to intersect in the current view. For example, you may be looking at a drawing in plan view where two lines cross, as in the illustration. However, since AutoCAD is a 3 dimensional drawing environment, the two lines may not physically intersect. One line may be at ground level and the other may be 10 meters or more above or below ground level. As with the Intersection Osnap, Apparent Intersection also has an "Extended" mode.

**Extension**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="image.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>Shift + Right Click <strong>Extension</strong></td>
<td><img src="image.png" alt="Image" /></td>
</tr>
<tr>
<td>Keyboard</td>
<td>EXT or EXTEN (when picking)</td>
<td><img src="image.png" alt="Image" /></td>
</tr>
</tbody>
</table>

The Extension Osnap enables you to snap to some point along the imaginary extension of a line, arc or polyline segment. To use this osnap, you must hover the cursor over the end of the line you want to extend. When the line end is found, a small cross appears at the endpoint and a dashed extension line is displayed from the endpoint to the cursor, providing the cursor remains close to the extension. The Snap Tip for Extension also includes the relative polar co-ordinate of the current cursor position. This can be a useful guide for positioning your next pick point. The co-ordinate includes a distance from the endpoint and the angle of the extension. In the case of the arc extension, the Snap Tip displays the distance along the arc. See the Using Co-ordinates tutorial for more information on polar co-ordinates.

**Center**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="image.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>Shift + Right Click <strong>Center</strong></td>
<td><img src="image.png" alt="Image" /></td>
</tr>
<tr>
<td>Keyboard</td>
<td>CEN (when picking)</td>
<td><img src="image.png" alt="Image" /></td>
</tr>
</tbody>
</table>

The Center Osnap snaps to the centre of a circle, arc or polyline arc segment. The cursor must pass over the circumference of the circle or the arc so that the centre can be found. This often causes some confusion for new users.

**Quadrant**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="image.png" alt="Image" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>Shift + Right Click <strong>Quadrant</strong></td>
<td><img src="image.png" alt="Image" /></td>
</tr>
<tr>
<td>Keyboard</td>
<td>QUA or QUAD (when picking)</td>
<td><img src="image.png" alt="Image" /></td>
</tr>
</tbody>
</table>

The Quadrant Osnap snaps to one of the four circle quadrant points located at
north, south, east and west or 90, 270, 0 and 180 degrees respectively.

**Tangent**

Toolbar  Object Snap
Pull-down  Shift + Right Click **Tangent**
Keyboard  TAN (when picking)

The Tangent Osnap snaps to a tangent point on a circle. This osnap works in two ways. You can either draw a line from a point to the tangent point (see illustration) or you can draw a line from a tangent point, the latter is referred to as the "Deferred Tangent" snap mode.

**Perpendicular**

Toolbar  Object Snap
Pull-down  Shift + Right Click **Perpendicular**
Keyboard  PER or PERP (when picking)

The Perpendicular Osnap snaps to a point which forms a perpendicular with the selected object. As with the Tangent Osnap, Perpendicular can be used to draw a line to a perpendicular point, as in the illustration or from a perpendicular point, known as the "Deferred Perpendicular" snap mode.

**Parallel**

Toolbar  Object Snap
Pull-down  Shift + Right Click **Parallel**
Keyboard  PAR or PARA (when picking)

The Parallel Osnap is used to draw a line parallel to any other line in your drawing. In operation, this osnap is slightly less intuitive than some of the others. To draw a parallel line, first start the Line command, specify the first point when prompted and then start the Parallel Osnap. Hover the cursor over an existing line until you see the Parallel snap marker. Now, move the cursor close to a parallel position and a dotted line will appear, indicating the parallel. You can now pick the second point of your line. The Snap Tip also includes a relative polar co-ordinate.

**Insert**

Toolbar  Object Snap
Pull-down  Shift + Right Click **Insert**
Keyboard  INS (when picking)
The Insert Osnap snaps to the insertion point of a block, text or an image.

**Node**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="https://example.com/node.png" alt="Node" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>Shift + Right Click <strong>Node</strong></td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td><strong>NODE</strong> (when picking)</td>
<td></td>
</tr>
</tbody>
</table>

The Node Osnap snaps to the center of a Point object. This osnap can be useful if you have created a number of Points with the Measure or Divide commands. You could, for example insert a number of regularly spaced tree symbols (blocks) along a line by using the Node Osnap for the insertion point of each block.

The image above shows a Spline (cyan). The Measure command has been used to set Points (red) at regular intervals and a tree symbol has been inserted with the Insert command at each Point location using the Node Osnap.

**Nearest**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="https://example.com/nearest.png" alt="Nearest" /></th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>Shift + Right Click <strong>Nearest</strong></td>
<td></td>
</tr>
<tr>
<td>Keyboard</td>
<td><strong>NEA</strong> or <strong>NEAR</strong> (when picking)</td>
<td></td>
</tr>
</tbody>
</table>

The Nearest Osnap snaps to the nearest point on a drawing object. This Osnap is useful if you want to make sure that a pick point lies on a drawing object but you don't necessarily mind exactly where it is located.

**Using the From Object Snap**

The From Object Snap is a little more complicated than the other object snaps but it is well worth getting to know because it can be very useful.

**From**

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Object Snap</th>
<th><img src="https://example.com/from.png" alt="From" /></th>
</tr>
</thead>
</table>
The From Osnap can be used in conjunction with other osnaps or ordinary pick points and relative co-ordinates to pick offset points. If you are unsure about using relative co-ordinates, see the "Using Co-ordinates" tutorial before working with the From Osnap. The From Osnap does not snap to object snap locations, rather it can be used to snap to points at some distance or offset from an object snap location. Consider the following example. Look at the illustration on the right. It shows a circle drawn on top of a line. It is quite difficult to see how this circle could have been drawn accurately without the use of construction lines. However, the From Osnap can be used to draw the circle without any construction lines. Follow the command sequence below to discover how this is done.

**To draw the Line**

Command: **LINE**

Specify first point: (pick a point in the lower half of the drawing area)

Specify next point or [Undo]: @0,30 (a relative co-ordinate, 30 units above the first point)

Specify next point or [Undo]: ← (to end)

**To draw the Circle**

Command: **CIRCLE**

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: FROM

Base point: END of <Offset>: @0,10 (this co-ordinate is a point 10 units above the endpoint)

Specify radius of circle or [Diameter] <10.0000>: 10 (a radius value of 10 ensures that the southern point on the circle will touch the top of the line)

Your drawing should now look like the illustration above. Practice using the From Osnap until you are quite sure how it works. Don't forget to prefix all co-ordinates with the @ symbol to let AutoCAD know that you are entering a relative co-ordinate. The North Point Exercise demonstrates more uses of the From Osnap.

**Running Object Snaps**

Pull-down **Tools » Drafting Settings…**
Using the Object Snaps as described above can sometimes be a consuming process. Every time you want to snap to an endpoint, you need to click on the Snap to Endpoint button. If you have a lot of endpoints to snap to, this can become a little tedious. For example, when we used the Node Osnap to insert lots of tree symbols above, the Snap to Node button had to be clicked each time an insert point was picked. Wouldn't it be great if there was a way to have osnaps running in the background so that you could snap without having to invoke the snap tools explicitly? Well, the good news is that AutoCAD provides just such a facility and it is called Running Object Snaps.

You may already have been using running object snaps without noticing it. When you first start AutoCAD, a number of running object snaps are set by default. If you hover the cursor over an endpoint while being prompted to specify a point, you may see the square osnap marker spontaneously appear. If so, you have running object snaps set on.

Running object snaps can be configured using the Object Snap tab of the Drafting Settings dialogue box, illustrated below. This tabbed dialogue box and also includes settings for Snap and Grid and for Polar Tracking.

The Drafting Settings dialogue box can be used to set one or more osnaps so that you don’t need to keep invoking them as you draw. For example, if your drawing requires the use of a number of Center and Endpoint...
snaps, use the Drafting Settings dialogue box to set these two osnaps on by checking the box next to their respective names. Try setting some running osnaps now. From the pull-down menu select **Tools > Drafting Settings**... and when the dialogue box appears, click on the Object Snap tab to display the Object Snap settings. Check the boxes against the Center and Endpoint osnaps if they are not already selected. Now, make sure that the "Object Snap On (F3)" box is checked as in the illustration on the right. Click the "OK" button to confirm your settings.

The selected osnaps will remain running until you turn them off by deselecting them in the Osnap Settings dialogue box. However, sometimes you may simply want to suspend the running osnaps temporarily. To do this, click the OSNAP button on the status bar at the bottom of the screen or use the F3 key on the keyboard. This button acts as a toggle, so you just need to click it again to set running object snaps back on. Try this now and notice that the OSNAP button appears "pushed in" when toggled on and "popped out" when toggled off. This visual clue is useful because you can see at a glance whether your object snaps are running or not.

Incidentally, you can also use the OSNAP button to launch the Drafting Settings dialogue box. Right-click on the button and select "settings..." from the context menu.

**None**

Sometimes you may only want to suspend running osnaps for a single pick. In such situations it is more efficient to use the None Osnap. This osnap works in the same way as the others, so when you are prompted to pick a point, use None to suspend all running object snaps for that pick only.

- **Toolbar** Object Snap
- **Pull-down** Shift + Right Click **None**
- **Keyboard** NONE (when picking)

The None Osnap is not an osnap in the true sense of the word. It is really an osnap utility but it can be very useful when your drawing becomes complicated and it becomes impossible to pick the point you need without snapping to some other point.

**AutoSnap**

You may not have realised it but you have already been using the AutoSnap features. Using the Drafting tab of the Options dialogue box, part of which is shown on the right, you can control all of the AutoSnap features. By default, all features are turned on except for the aperture box (see below). You can easily toggle the Marker, Magnet and Snap Tip features on and off by checking or unchecking their respective boxes. Notice that you can also adjust the marker size using the slider and you can...
change the marker colour. The default marker colour is yellow which works well with the traditional black AutoCAD background but you may wish to change this if you prefer working with a white background. The illustration on the left shows the Marker, Magnet and Snap Tip features in action.

The Aperture Box

You may have noticed the Drafting tab of the Options dialogue box also includes a slider which controls the size of the “Aperture Box”. The size of the aperture box determines how wide an area AutoCAD uses to look for object snap locations. By default the aperture box is not displayed. However, you can force the aperture box to display by checking the "Display AutoSnap aperture box" option under AutoSnap Settings. Each time you use an osnap to pick a point, the aperture box will appear at the center of the cross hairs (as in the illustration above) to indicate the area AutoCAD uses to search for object snaps. In general the default size setting is perfectly adequate. It may be necessary to reduce the aperture box size if your drawing becomes very complicated and it becomes difficult to easily select the required osnap point. You can also control the aperture box size from the keyboard using the APERTURE command. Use this command to set the object snap target height anywhere from 1 to 50 pixels. The default value is 10.

Object Snap Cycling

Using object snaps is a great way to construct accurate drawings. However, when drawing become very complex, it can be quite difficult to pick the exact point you want. This is particularly problematic if there are a number of possible snap points in close proximity. Fortunately, AutoCAD has a little feature to help in such circumstances. The aperture box, described above, controls the extent of the search for object snaps from the current cursor position. However, it cannot help you select a particular snap point within that area. The Object Snap Cycling feature allows you to cycle through all valid snap points within the aperture area, until you find the one you want. This feature only works when running object snaps are turned on. However, it is not necessary for the aperture box to be displayed.

Once the snap marker appears, you can cycle through other local snap points by pressing the TAB key on the keyboard. Each time TAB is pressed, the next snap point is highlighted along with the object or objects to which it belongs. The illustrations above show just 3 of the valid snap points in this particular arrangement of objects. Using this feature, you can be absolutely sure that you are selecting the point you want, no matter how complex the arrangement of objects.

Using Temporary Tracking Points
Tracking is similar to the From Object Snap in that it can be used to avoid the necessity of drawing construction lines in order to locate points. Consider the following scenario: You have drawn a rectangle in AutoCAD. You do not know the exact size of the rectangle. You need to draw a circumscribed circle i.e. a circle which just touches all four corners of the rectangle (see illustration on the right). Conventionally the only way to accurately find the centre point of this circle is to draw a construction line from two diagonally opposite corners using the Endpoint or Intersection Osnaps. The centre point can then be found by snapping to the Midpoint of this construction line (see illustration on the left). Tracking enables you to accurately locate the centre point without drawing any construction lines. Follow the command sequence below to find out how tracking works.

To Draw the Rectangle

Command: \textbf{RECTANG}

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (pick a point)

Specify other corner point: (pick another point to draw the rectangle, the size is not important)

To Draw the Circle

Command: \textbf{CIRCLE}

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: \textbf{TT}

Specify temporary OTRACK point: \textbf{MID}

of (pick the left side of the rectangle)

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: \textbf{TT}

Specify temporary OTRACK point: \textbf{MID}

of (pick the bottom line of the rectangle)

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: (move the cursor close to the circle center location)

Center lines appear through the two midpoint osnaps and the intersection of these lines is marked with a cross (see the image below). When you see the cross, click your mouse button to pick.

\textbf{Diameter/<Radius>}: \textbf{END}

of (pick the top right corner of the rectangle)

The circle is now drawn and your drawing should look similar to...
the illustration above. As you can see, the use of temporary tracking points can be incredibly useful and can really speed up your drawing technique. Tracking, like the From Osnap can seem quite tricky to use at first but both tools are well worth getting to know well since they can save you hours of drawing time.

**Object Snap Tracking**

Object snap tracking is to temporary tracking points what running object snap is to object snaps. Essentially, it enables you to have tracking running in the background so that you need not use temporary tracking points. However, for object snap tracking to work, running object snaps must also be defined and turned on.

You control the use of object snap tracking with the OTRACK button on the status bar or with the \texttt{F11} key. Just like the other mode buttons on the status bar, the OTRACK button acts as a toggle, switching object snap tracking on and off as required.

In order to demonstrate how useful object snap tracking and running object snaps are in combination, let's try the rectangle and circle example again. First, we must ensure that the midpoint object snap is set as a running object snap and that running object snaps are turned on. We must also turn object snap tracking on.

You can check all three things at the same time, using the Drafting Settings dialogue box. Right-click on the OTRACK button and choose "Settings..." from the context menu. Make sure that the options set in your dialogue box are the same as those shown in the illustration above.

**To Draw the Rectangle**

Command: \texttt{RECTANG}

Specify first corner point or [Chamfer/Elevation/Fillet/Thickness/Width]: (pick a point)

Specify other corner point: (pick another point to draw the rectangle, the size is not important)

**To Draw the Circle**

Command: \texttt{CIRCLE}

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]:

Move the cursor close to the midpoint of one of the vertical sides and hover there for a second or so. The Midpoint osnap marker will appear and a small cross, indicating that a
tracking point has been set. Now, move the cursor close to the midpoint of one of the horizontal sides and hover. When a second marker and cross appears, move the cursor close to the circle center position. Where the two tracking lines intersect, a third cross appears (see illustration). Pick this point to specify the center of the circle.

Diameter/<Radius>: (move close to a corner and use the running endpoint osnap)

Notice that you were able to accurately locate the center point of the circle without using any temporary construction lines and without even picking any temporary points. Object snap tracking is probably one of the most useful tools that AutoCAD provides and it's now difficult to imagine life without it.

Point Filters

The point filters are another set of tools which can save you lots of time by allowing you to specify the third co-ordinate of any point picked in a 2D plane. For example, when you pick a point in plan view, AutoCAD fixes the X and Y co-ordinates from the cursor location. The Z co-ordinate is automatically set to zero or the current elevation value. Using a .XY (dot x y) filter, you can force AutoCAD to prompt you for a Z value. By this method it is possible to draw objects in 3D space whilst viewing your drawing in plan. Although there are six point filters in all, you will most likely find the .XY point filter of most use. This filter is particularly useful for specifying target and camera locations when setting up perspective views with the DVIEW command. See the "Perspectives" tutorial for a worked example using the .XY point filter.

Tips & Tricks

- When you are drawing, take a few moments to consider how you will construct each part of the drawing and which Osnap you will use before starting work. There is always more than one way to draw anything in AutoCAD but the quickest, most accurate and the most efficient way always requires the use of one or more of the Osnap tools.

- Dock the Object Snap toolbar to your drawing window for quick access to the Osnap. You will be using them all the time, one-click access is essential. See Object Snaps to find out how to display the Object Snap toolbar. To dock the toolbar, click on the toolbar title and drag it to the edge of the drawing window.
Object Properties

Introduction

Every AutoCAD object, such as a line or a circle has properties. Some properties such as Colour, Linetype and Layer are common to all objects. Some objects have properties which are specific to themselves. Text, for example, is the only object type which has a Text Style property. In AutoCAD Release 14, the easiest way to control object properties is to use the Object Properties toolbar, illustrated below. This is one of AutoCAD's default toolbars and can usually be found directly below the Standard toolbar in the top left hand corner of the AutoCAD window.

Take time to work through this tutorial, it is particularly important to get to grips with object properties since it can make the difference between a really good AutoCAD drawing and a really terrible one. If you just need information quickly, use the QuickFind toolbar below to go straight to the information you need or select a topic from the contents list above.

Layers

Probably the most important object property to understand well is the layer property. Experienced AutoCAD users use layers all the time and that is why the Object Properties toolbar contains so many layer functions. Good use of layers is the most important aspect of good drawing practice.

The concept of layers is very important in AutoCAD and the correct use of layers can make your drawing much easier to work with. Basically, layers are the computer equivalent of tracing overlays on a drawing board. However, layers are much more powerful because you can have many layers in a single drawing and you can control the visibility, colour and linetype of layers independently. This makes working with very complicated drawings much more efficient. Layers are effectively a way of ordering your drawing. For example, you may need to create a number of construction lines in a drawing which will not form a part of the finished image. You could create a layer called "Construction" and use this for your construction lines. When the drawing is complete, you could simply turn this layer off so that it can't be seen. The beauty is that you could always turn this layer back on at some future time if modifications to the drawing are required. Experienced AutoCAD users will use layers to order their drawings by drawing components. For example, if you were creating a landscape masterplan, you may have layers called "Trees", "Shrubs", "Path" etc. The main reason for this, apart from it being a simple way to control the drawing, is that the different drawing components may need to be printed in different colours, with different linetypes and with different line widths.

Layers can be used to control the way objects are displayed on the computer monitor and how they appear when they are printed.

It is a common misapprehension amongst new users that layers can be used to control the visual hierarchy of objects. In other words, if two objects overlap, it seems reasonable to assume that you could cause one object
to display "above" another with the use of layers. This layer model is common to illustration software such as CorelDRAW. However, AutoCAD uses a 3 dimensional drawing space where all objects coexist and are positioned in their correct co-ordinate locations. The concept of an object being displayed above or below another, therefore, is not consistent with this logic. In AutoCAD the display of one object in relation to another is determined by the objects place in the drawing database. Objects drawn more recently will display over another if the two objects occupy the same physical space. It is possible to override this effect using the Display Order tools found on the Tools pull-down, Tools ➤ Display Order ➤ Options. These options are particularly useful to control the display of overlapping solids and solid hatches that are coplanar. The layer of an object has no effect on its display order.

Although you can have many layers in a drawing, you can only draw on one layer at a time. The layer you are drawing on is said to be the current layer. The Object Properties toolbar displays the current layer information. In the illustration above, you can see that layer "0" is the current layer and that both the colour and linetype are set "ByLayer".

When you start a new drawing, AutoCAD has only one layer. This layer is special and is called layer "0" (zero) Layer 0 is special because you cannot change its name or delete it and it has certain properties which we do not need to consider just now. By default layer 0 is assigned the colour white (colour number 7) and the "Continuous" linetype. Layer 0 is always the current layer when you start a new drawing, however, it is bad drawing practice to use layer 0 for normal drawing. The first thing you should do, therefore, when you start a new AutoCAD drawing is to create some new layers.

The Layer Command

Toolbar ➡️
Pull-down ➤ Format ➤ Layer...
Keyboard ➤ LAYER

Although AutoCAD provides many shortcuts for working with layers, many of which will be covered later, the Layer command provides the most comprehensive control over layers and layer operations. This command uses a dialogue box. The dialogue box is a tabbed dialogue box and can be modified to show more or less details. This is quite nice because in its simplified form it looks much less intimidating to beginners. The following sections demonstrate how the Layer command can be used to perform many of the most common layer operations.

Creating a New Layer

To create a new layer, click on ➡️ in the Object Properties toolbar, the Layer & Linetype Properties dialogue box, illustrated below, appears. This is a tabbed dialogue box and can be used to control either layer properties or linetype properties depending upon which tab is selected. The Layer tab is always selected by default. Now click on the "New" button. A new layer called "Layer1" is automatically created in the layer list below layer 0. As you can see from the illustration, the layer name is automatically highlighted for you so that you can give the layer a more meaningful name. When you have entered an appropriate name, press the ➡️ key to complete the operation. You have now created a new layer and given it a name. Notice that by default i
There are a few restrictions to consider when you are naming layers. The most annoying is that you cannot use spaces within layer names. So, for example, the layer name "Tree trunk" is illegal. However, it is common practice to replace the space with either a hyphen or an underscore, both of which are valid layer name characters. So, the layer names "Tree-trunk" and "Tree_trunk" are both acceptable. Some other special characters are also not allowed. If you do use an illegal character, AutoCAD will alert you with the error message box illustrated above. Notice that it very helpfully tells you which characters are legal. Basically, if you stick with letters and numbers you won't experience any problems. In addition to the hyphen and underscore mentioned above, the dollar sign is the only other symbol allowed.

The only other restriction relating to layer names is the number of characters used. Layer names can be between one and thirty-one characters long. This should give you plenty of scope to devise understandable and descriptive names for your layers. It is good drawing practice to name your layers sensibly, bear in mind that other people may have to work with drawings which you create. If you enter a layer name longer that 31 characters, AutoCAD will display the error message box shown on the left.

Layers are always listed alphabetically in layer lists, the user
has no other way to control the list order. It is worth bearing this in mind when naming your layers. Keep similar object layers together by devising a hierarchical naming structure. For example, if you are drawing a tree symbol which comprises a number of elements, your layer names might be, "Tree_canopy", "Tree_text", "Tree_trunk" etc. This will cause all the Tree layers to be displayed together, see the illustration on the right. This is quite important because in complicated drawings there may be many layers and searching for the right group of layers can waste a lot of time.

**Setting Colour and Linetype "ByLayer"**

AutoCAD offers two methods of setting the colour and linetype of a drawing object. First of all, colour and linetype can be set *ByLayer*. In other words, an object will be displayed in the colour and linetype of its layer. For example, if you draw a circle on a layer which you have called "Detail" and you have also set the colour of Detail to blue and the linetype to dashed, then the circle will be displayed in a dashed blue line. When an object takes on the properties of its layer, the colour and linetype are said to be set "ByLayer".

The second method AutoCAD offers is to set the colour and linetype by object. Setting properties by object overrides those set ByLayer. In general it is good drawing practice to set colour and linetype properties ByLayer, this is more efficient and less confusing in the long-run. For example, imagine that you have drawn hundreds of objects on the same layer and have set their colour to green. Later in the drawing process you decide that these objects should, in fact, be yellow. In order to make the change you would have to use the Properties command and select every one of the objects by picking them. By contrast, if you had set the objects colour to ByLayer, you would only have to change the layer colour from green to yellow and all of the objects would change.

There are times, however, when it is useful to be able to set colour and linetype properties by object. Setting properties by object is covered later in this tutorial. The following sections cover the setting of colour and linetype ByLayer.

**Setting the Colour of a Layer**

It is often convenient to set the layer colour when the layer is created, although this can be done at any time. The layer colour can be changed as many times as you like. Each time it is changed, any objects on that layer will change to the new colour, providing their colour is set to "ByLayer".

To set a layer colour, open the Layer & Linetype Properties dialogue box, click on and then click on the colour icon in the layer list associated with the layer you want. Notice that all layers have their own colour icon and that this changes to display the layer colour. Clicking on the icon brings up the Select Color dialogue box, shown on the right. You can select any of the 255 standard AutoCAD colours by picking on the colour palette or by entering the colour name or
number in the text edit box. When you have selected the colour you want, click on the "OK" button to set the colour. AutoCAD uses only 255 colours plus the drawing background colour, irrespective of the capabilities of your video display.

Assigning different colours to your layers will make working with complex drawings much easier. You will be able to see at a glance what a particular line represents. For example, your construction lines may be on a layer called "Construction" and have the colour yellow. This will visually differentiate these lines from lines on other layers with different colours.

Setting the Linetype of a Layer

In the same way that you can assign a colour to a layer you can also assign a linetype to a layer. For example you could have all the lines on a layer called "Construction" display in a yellow dashed line. To set a linetype to a layer, click on and then click on the current linetype name associated with your layer in the layer list. By default, layers have the "Continuous" linetype. Clicking on the linetype name brings up the Select Linetype dialogue box, shown on the right. You will notice that the "Continuous" linetype is the only one listed. That's because all linetypes, except "Continuous", are stored in an external file and have to be loaded before they can be used.

Loading Linetypes

To load a linetype, click on the "Load..." button in the Select Linetype dialogue box. The Load or Reload Linetypes dialogue box appears and displays a list of the available linetypes. Select as many of the listed linetypes as you wish and then click the OK button to return to the Select Linetype dialogue box.
Selecting from list boxes works the same way in AutoCAD as it does in any other Windows application. For example, if you wish to select a block of linetypes from the list at one time, select the first linetype in the block, hold the **Shift** key down on the keyboard and select the last linetype in the block. All linetypes in the block will be highlighted and you can click the "OK" button to load them all in one go. You can also hold the **Control** (Ctrl) key down on the keyboard to make multiple selections which aren't adjacent in the list (see illustration above).

When you return to the Select Linetype dialogue box the loaded linetypes are displayed in the list. To assign a particular linetype to a layer, simply click on the name to highlight it and then click on the OK button. When you return to the Layer & Linetype Properties dialogue box, the new linetype name will be listed against your layer in the "Linetype" column. From now on, all objects drawn on this layer will be drawn with the chosen linetype. However, just like colours, you may change the linetype at any time and the objects drawn on that layer will
automatically be updated to display the new linetype.

**Making a Layer the Current Layer**

Once you have created some layers you will want to start using them. As indicated above, you can only draw on one layer at a time. In order to draw on a particular layer you must first make it the *current* layer. As usual with AutoCAD there are a number of alternatives. You could, for example, use the Layer command, **Layer...** from the **Format** pull-down or **Layer** from the Object Properties toolbar. As you have seen previously, this command brings up the Layer & Linetype Properties dialogue box. To set the current layer, select a layer name from the list and then click on the "Current" button and then click the "OK" button to finish. The selected layer is now the current layer and its properties are displayed on the Object Properties toolbar.

Most experienced AutoCAD users change the current layer so frequently that the above method starts to seem very long winded. It is much quicker and therefore more efficient to set the current layer directly from the Object Properties toolbar using the "Layer Control" drop-down list. To set the current layer, click on the down arrow next to the Layer Control window to reveal the layer list. Simply click on the name of the layer you wish to make current. If the layer name is not visible because the list is quite long, scroll down the list until you see it. The drop-down list only displays 10 layers at a time. As a beginner, you may feel that this is quite a lot but a complex and well structured drawing may have 50 or 100 layers.

**Toolbar**

- **Layer**

**Pull-down** not available

**Keyboard** **AI_MOLC**

There is an even quicker way to change the current layer providing you know which layer objects are on. You can use the Make Object's Layer Current command to set the current layer to the layer of any picked object.

**Command Sequence**

Select Make Object's Layer Current from the Object Properties toolbar. **Layer**

When AutoCAD prompts

Select object whose layer will become current:

pick the object you know to be on the required layer. If you miss the object you are trying to select, the command is automatically canceled

AutoCAD confirms the action by writing to the command line

**LAYER NAME** is now the current layer.

You will also see the layer details change in the Object Properties toolbar. With a bit of practice and a good awareness of the layers you are using, this command can save lots of time.
Controlling Layer States

One of the best aspects of working with layers is the flexibility with which you can control their visibility. So far we have looked at the colour and linetype properties of layers. However, there are a number of other properties all of which relate to whether or not objects on a layer can be seen and/or modified. The current state of these properties are all indicated by icons in the various layer lists. You will already have seen them if you have been following this tutorial. The meaning of these icons is shown in the table below:

<table>
<thead>
<tr>
<th>Icon</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="On icon" /></td>
<td>On</td>
<td>The layer is visible unless it is also frozen</td>
</tr>
<tr>
<td><img src="image" alt="Off icon" /></td>
<td>Off</td>
<td>The layer is invisible but objects are still regenerated unless it is also frozen</td>
</tr>
<tr>
<td><img src="image" alt="Thaw in all viewports icon" /></td>
<td>Thaw in all viewports</td>
<td>The layer is not frozen</td>
</tr>
<tr>
<td><img src="image" alt="Freeze in all viewports icon" /></td>
<td>Freeze in all viewports</td>
<td>The layer is invisible and objects are suspended from regeneration</td>
</tr>
<tr>
<td><img src="image" alt="Thaw in current viewport icon" /></td>
<td>Thaw in current viewport</td>
<td>The layer is not frozen in the current viewport</td>
</tr>
<tr>
<td><img src="image" alt="Freeze in current viewport icon" /></td>
<td>Freeze in current viewport</td>
<td>The layer is frozen and invisible in the current viewport but may be visible in other viewports.</td>
</tr>
<tr>
<td><img src="image" alt="Thaw in new viewports icon" /></td>
<td>Thaw in new viewports</td>
<td>The layer is not frozen in new viewports when they are created</td>
</tr>
<tr>
<td><img src="image" alt="Freeze in new viewports icon" /></td>
<td>Freeze in new viewports</td>
<td>The layer will be frozen in any new viewport</td>
</tr>
<tr>
<td><img src="image" alt="Unlock icon" /></td>
<td>Unlock</td>
<td>The layer is unlocked</td>
</tr>
<tr>
<td><img src="image" alt="Lock icon" /></td>
<td>Lock</td>
<td>The layer is locked and objects cannot be selected or modified</td>
</tr>
</tbody>
</table>

Turning Layers On and Off

You can turn layers off or on either by using the Layer command, ![Layer command](image) from the Object Properties toolbar or you can more easily do it using the "Layer Control" list, directly from the Object Properties toolbar. In either case, all you have to do is click on the icon you wish to change. The icons all act as toggles, so if a layer is on all you need to do is click on the ![On icon](image) icon and the icon will change to ![Off icon](image), turning the layer off. And conversely, clicking on ![Off icon](image) changes the icon to ![On icon](image) and turns the layer back on.

Objects on a layer which is turned off aren't displayed in the drawing window and they won't be plotted. The objects still exist in the drawing; they are just invisible.

If a layer is turned off and you make it the current layer, AutoCAD turns it on. It's possible to turn off the current layer, but this is rarely desirable. To do so causes no harm, but it can be confusing if you don't realise what has happened; new objects you draw are added to the drawing but are not displayed until the layer is again on.
turned on.

Each designated layer is turned on (made visible) using the colour number and linetype previously associated with it. If the layer is presently frozen, turning it on is not sufficient to make it display again; you must also thaw the layer (see Freezing and Thawing Layers below).

The illustration above shows the Layer & Linetype Properties dialogue box with a number of layers in different states of visibility. Notice also that the dialogue box has been enlarged to show more information. You can do this by clicking on the "Details>>" button.

Freezing and Thawing Layers

Freezing and thawing layers works in exactly the same way as turning them off or on. Simply click on the icon to freeze a layer or to thaw it.

By freezing a layer you are effectively instructing AutoCAD to ignore the objects on that layer when regenerating the drawing. Objects on frozen layers aren't displayed or plotted, and AutoCAD spends no time calculating where they go. Therefore, by freezing layers you can increase the ZOOM, PAN, VPOINT, REGEN, and object selection performance for complex drawings. It is always a good idea to freeze layers that aren't of immediate interest.
Turn Off or Freeze?

Since freezing a layer also makes it invisible, you may be confused about when to select Freeze as opposed to Off. The main difference is a matter of efficiency. If you're frequently switching between layers and changing their visibility, doing a bit of editing on each of them, you should use Off when you want to make objects on a layer invisible. If, on the other hand, you're doing most of your editing on one layer (or a set of layers), and don't need to see the objects on another set of layers, you should freeze those layers. This will speed up your editing and make the drawing clearer to work with.

Objects on layers that are off are recalculated during a regeneration, but simply not displayed. Therefore, when you turn a layer on that was previously off, it will display immediately. On the other hand, layers that are frozen are not recalculated during a regeneration and therefore REGENs and object selection can be much faster because there is less work for AutoCAD to do. When a frozen layer is thawed, however, a regeneration must be performed before objects on that layer can be displayed.

Locking and Unlocking Layers

Locking and unlocking layers work as for turning layers off and on and freezing and thawing them. Simply click on the lock icon to toggle an unlocked layer so that it becomes locked and click the unlock icon to reverse the process.

You can't select or edit the objects on a locked layer; however, the objects are still visible if the layer is on and thawed. This is handy if you are working in detail, but don't want to inadvertently select certain objects. You can make a locked layer current, so you can draw on a locked layer. You can also use inquiry commands (such as LIST or ID) on locked layer objects. You can also use Object Snaps with objects on locked layers and you can even use them as Trim and Extend boundaries.

Layers in Viewports

AutoCAD beginners can operate quite effectively using the On/Off, Freeze/Thaw and Lock/Unlock layer states. However, when you start using Paper Space you will need to understand how to control the visibility of layers in different viewports. By default, all layers are visible in all viewports. However, you can use the "Freeze in current viewport" option to selectively freeze layers in different viewports. This is done by clicking the icon in a layer list when you are in Floating Model Space. This subject is covered in greater detail in the Paper Space tutorial. The viewport layer icons are greyed out when you are in Tiled Model Space.

Renaming a Layer

To rename a layer, start the Layer command by clicking on the button on the Object Properties toolbar. When the Layer & Linetype Properties dialogue box appears, click on the "Details>>" button to reveal the layer details. Pick the layer name you wish to change from the layer list. The name appears in the Name text edit box under "Details". Simply edit or retype the name in the edit box and you will see the name change simultaneously in the layer list. You cannot rename layer "0", the deafault layer, nor can you rename a layer called "Defpoints" which AutoCAD creates automatically when you use Dimensions (see Dimensioning). In theory you can also edit a layer name directly from the layer list but I have always found this to be a bit tricky. Notice that you can also change the layer colour and linetype using the "Details" section of the dialogue box.
Deleting a Layer

To delete a layer, start the Layer command, from the Object Properties toolbar to open the Layer & Linetype Properties dialog box. Click the name of the layer to highlight it, click the "Delete" button and then click "OK".

You cannot delete any layer which has objects on it, you cannot, therefore, use this process to delete all of the objects on a particular layer. You cannot delete the current layer, layer "0", layer "Defpoints" or any layers from external references.

Purging Layers and Linetypes

Layer and linetype definitions add to the size of your drawing because they are kept in the drawing's database. It is, therefore, worthwhile purging layers and linetypes that you are not using. You can delete them (see Deleting a Layer), but it is often difficult to know which layers contain objects and therefore can't be deleted. The Purge command lets you delete many types of unused definitions, including blocks, dimension styles, layers and linetypes. You will find the Purge command on the pull-down menu at File ▶ Drawing Utilities ▶ Purge ▶ Options, there is no toolbar button for this command.

Command Sequence

Command: PURGE

Purge unused Blocks/Dimstyles/Layers/LTypes/SHapes/STyles/Mlinestyles/All: (select option)
Names to purge <*>: (type → to delete all eligible definitions or specify particular names)
Verify each name to be purged? <Y> (Type N to automatically purge all eligible definitions)

The Purge command may not always remove all of the definitions you expect. This usually occurs if you have block definitions in a drawing which reference layers or linetypes etc. In such a case the Purge command will remove any unused block definitions but will not remove the other dependent definitions. All you have to do to get rid of these definitions is to run the Purge command a second time after the block definition has been removed.

Colours

In the same way that you can set a current layer, you can set a current colour so that every object you draw will be displayed in a particular colour irrespective of which layer it is on. As mentioned earlier, this method of assigning colour, by object, is recommended only in special circumstances. In general, colour should be assigned ByLayer. See Setting Colour and Linetype "ByLayer" for more information.

To set a current colour, simply click on the "Color Control" box on the Object Properties toolbar. The drop-down list contains the two logical colours ByLayer and ByBlock, the seven standard AutoCAD colours, Red, Yellow, Green, Cyan, Blue, Magenta and White (colour numbers 1 to 7 respectively) and the "Other..." option. Notice that the default colour for any new drawing is "ByLayer", this is because in most circumstances you will want to assign colours by this method. Select a colour directly from the drop-down list or click on the "Other..." option to bring up the Select Color dialogue box (illustrated...
below) where you can select any of the AutoCAD colours from the Full Color Palette. This dialogue box is the same as the one you see when setting colour by layer, except that the two logical colour buttons, ByLayer and ByBlock are no longer greyed-out.

If you set a current colour, you can always return to assigning object colours by layer by setting the current colour to "ByLayer", either with the button in the Select Color dialogue box or directly from the "Color Control" drop-down list on the Object Properties toolbar. There are also a couple of methods for setting the current color from the keyboard. The DDCOLOR command simply launches the Select Color dialogue box from which you can select a colour, as before. The CECOLOR command allows you to change the CECOLOR system variable by entering a colour number, name or logical colour. The DDCOLOR command is also available from the pull-down menu, Format ▶ Color….

The ByBlock logical colour can be very useful if you need to use a single block in a drawing but have the different insertions of that block displayed in different colours. When a block is inserted into a drawing, those objects which have been assigned the ByBlock colour will acquire the current drawing colour. Changing the current colour between block insertions will change the colour of the ByBlock objects within the block. Only objects which are to be included as part of a block should be assigned to this logical colour.

Linetypes

As with layers and colours, a current linetype can be set so that all objects drawn will be displayed with that linetype. However, the same warnings given above about assigning colour by object also apply to assigning linetypes by object, namely that linetypes should be set ByLayer wherever possible. That said, to set a current linetype, click on the "Linetype Control" box on the Object Properties toolbar, and select a linetype from the drop-down list. The list contains the two logical linetypes, ByLayer and ByBlock, these have the same function as the two logical colours of the same name and a list of the currently loaded linetypes.

The Linetype Command

Toolbar

Pull-down Format ▶ Linetype…

Keyboard LINETYPE
If you have just started a new drawing the only true linetype available will be the "Continuous" linetype. Before you are able to assign any other linetype, you must first load the linetypes you may need. To load linetypes you must use the "Linetype" command. Click on the button on the Object Properties toolbar. You will now see the familiar Layer & Linetype Properties dialogue box but this time the "Linetype" tab is automatically selected to display the linetype information, see illustration below.

In the Layer & Linetype Properties dialogue box, click on the "Load..." button, this brings up the Load or Reload Linetypes dialogue box which you have seen previously in this tutorial. Select the required linetypes from this dialogue box and then click the "OK" button to return to the Layer & Linetype Properties dialogue box, where you will see the newly loaded linetypes in the Linetype list. This selection process is the same as that described in the "Loading Linetypes" section of this tutorial, above. Now that the required linetypes have been loaded you can set the current linetype either by highlighting it in the Linetype list and then clicking the "Current" button in the Layer & Linetype Properties dialogue box or you can simply select the linetype from the drop-down list in the Object Properties toolbar.

**Setting the Linetype Scale**

In many cases your linetypes will display just as you want them. However, it is inevitable that at some time you will need to change the scale at which your linetypes are displayed. By default the linetype scale is set to 1.0, this means that each linetype pattern will repeat every 1.0 drawing units. To make the pattern appear larger, change the scale to a larger number. Setting the linetype scale to 5.0 for example causes the linetype pattern to repeat every 5.0 drawing units so that the pattern will appear 5 times larger. Conversely, setting the scale to...
0.2 causes a repetition every 0.2 drawing units which will make the pattern appear 5 times smaller. See the illustrations below.

To change the linetype scale, click on the button to bring up the Layer & Linetype Properties dialogue box. If the "Details" section of the dialogue box is not visible, click on the "Details>>" button to reveal it. The dialogue box should now look similar to the one shown above. You set the linetype scale by changing the value in the "Global scale factor" edit box. Once you have changed the scale factor, click on the OK button to return to your drawing. AutoCAD automatically regenerates the drawing to display all linetypes with the new scale factor.

You may have noticed from the Layer & Linetype Properties dialogue box that you can also set the linetype scale by object, using the "Current object scale" edit box. Whilst this is perfectly easy to do, the results can sometimes be unexpected, since the linetype scale of any object is a function of both the Global and Current scales. For example, setting the Global scale to 2.0 and the Current scale of an object to 0.5 results in the same appearance as if both scales were set to 1.0, the default values. In short, unless you have a really compelling reason to change it, keep the Current object scale set to 1.0, this will avoid any confusion in the future.
As with other settings, AutoCAD allows the user to set the Global and Current linetype scales using the keyboard. Use the LTSCALE command to change the Global scale and the CELTSCALE command to change the Current linetype scale. It is often quicker to use the LTSCALE command when you are experimenting with linetype scales, this avoids having to navigate the dialogue box each time.

Changing Object Properties

So far we have concentrated on setting object properties so that we can simply draw objects with their required properties pre-set. However, there will be occasions when an object's properties will need to be changed. Say, for example, you have drawn an object on the wrong layer (a very common mistake). It's much simpler to change the layer for that object rather than to erase the object, set the current layer and then draw it again. There are a number of ways in which an object's properties can be changed but the most common method is to use the Properties command. Remember that you cannot change the properties of objects on locked layers.

The Properties Command

This command is unusual in that it is really two commands rolled into one. When you start the Properties command you are asked to "Select Objects:". If you select more than one object you will be able to change only those properties which are common to all objects, namely Colour, Layer, Linetype, Linetype Scale and Thickness. (Bear in mind that the Linetype Scale refers to the Current object scale and not the Global linetype scale, see Setting the Linetype Scale for more details.) This is the equivalent of using the DDCHPROP command and object properties can be changed using the Change Properties dialogue box. If, however, you select only one object you will be able to modify all of the above properties and those properties which are specific to the selected object type. This is the equivalent of the DDMODIFY command and object properties can be modified using an object specific dialogue box.

Command Sequence, multiple objects
After you have created the selection set the Change Properties dialogue box appears. To change the layer of the selected objects, pick the "Layer..." button and you will see the Select Layer dialogue box which lists all the layers in the drawing. Simply pick the name of the layer you want and then pick "OK". On returning to the Change Properties dialogue box, you can either change other properties or return to the drawing by clicking the "OK" button. The selected objects are now on the chosen layer. If the new layer has a different colour, the objects will be redrawn in this colour. If the chosen layer is turned off or frozen, the entities will become invisible.

Changing the colour and linetype of a number of selected objects is very similar. Use the "Color..." and "Linetype..." buttons to invoke the Select Color and Select Linetype dialogue boxes from which you can make your choice of Colour and Linetype respectively. Notice in the dialogue box above that the current linetype is displayed as "Varies", this is because a number of objects have been selected with different linetypes. However, all the objects are on a layer called "Details", so the layer name appears against the "Layer..." button. Linetype scale and Thickness are set by entering a numeric value in the appropriate edit box. The "Thickness" option allows you to give an object a thickness in the Z direction. You can, for example create a cylinder by giving a circle thickness. Thickness should not be confused with Width. Width refers to a property of polylines which can be used to cause the polyline to display as a wide solid line. See the "Basic 3D" tutorial for more information on using object thickness.

Beware of using the Properties command to change the colour and linetype of drawing objects because this will override the settings that you have made in the Layer & Linetype Properties dialogue box. Once a colour or linetype property is changed using this command, any changes to the objects colour or linetype using layer settings will have no effect. To enable an objects colour and linetype to be controlled by layer, the object colour and linetype must be set to "ByLayer".
When you use the Properties command to edit a single object you get a dialogue box which contains options specific to the type of object you have selected. The illustration on the left shows the Modify Circle dialogue box. Notice that you can change two properties which are specific to circles, namely the Center Point and the Radius. Notice also that this dialogue box reports the circumference and area of the circle.

**Command Sequence, single objects**

Command: **DDMODIFY**

Select objects: (pick an object)

When you pick a drawing object the Modify Object dialogue box appears. You can change any of the available properties. As you can see from the Modify MText dialogue box, below, the DDMODIFY version of the Properties command is extremely powerful, allowing you to change almost any property of an object.
Experiment with the DDMODIFY command using different objects to see what properties can be changed. In many cases this command enables you to modify properties which are difficult or impossible to change in any other way. For example, the Modify Block Insertion dialogue box allows you to differentially scale the X, Y and Z scale factors of a block.

The Match Properties Command

Another way to change the properties of an object or objects is to match the properties of any other object using the Match Properties command on the Standard toolbar.

**Toolbar**

 Modify ▶ Match Properties

**Pull-down**

 Modify ▶ Match Properties

**Keyboard**

MATCHPROP

**Command Sequence**

Command: MATCHPROP

Select Source Object: (pick the object you wish to match)

Current active settings = color layer ltype ltscale thickness text dim hatch

Settings/<Select Destination Object(s)>: (pick the objects to inherit properties)

Settings/<Select Destination Object(s)>:

Once the command sequence has been completed, the destination objects will inherit all of the current active settings which are specific to that object type. You can control which properties are matched...
and which are not by using the "Settings"
command line option. The Settings option displays the Propert Settings dialogue box, shown on the right. By
default all property settings are active (checked). You can deselect whichever properties you don't want to
match simply by unchecking the box against that option. The property settings are maintained until the end of
the current AutoCAD session or until you change them.

In addition to all of the above methods for modifying object properties, you will also find some object specific
modify tools on the pull-down menu, Modify ▶ Object ▶ Options.

Editing with the Object Properties Toolbar

Although editing object properties using the Properties command is easy enough, AutoCAD R14 introduces a
new and more efficient way to modify the Layer, Colour and Linetype of an object. By using the Object
Properties toolbar, the Layer, Colour and Linetype of an object or objects can be modified directly, without the
use of a command.

To do this, simply select an object when the command line reads "Command:" (i.e. when no command is
currently in operation). The object will become highlighted and grips appear at key points. Notice that the
Object Properties toolbar changes to show the Layer, Colour and Linetype status of the selected object. To
change either the Layer, Colour or Linetype, simply click on the appropriate Control box on the toolbar and
select the required setting. As mentioned above, the changing of Colour and Linetype by object should be
undertaken with caution. However, this is an excellent and efficient way to change an objects Layer since this
is a common requirement.

You can also use this method to change the properties of multiple objects. To add objects to the pick set,
simply hold the Shift key down and pick as many objects as required. Change the properties as before.

Tips & Tricks 🍔

- Make sure you always start a new drawing by creating some new layers. Two or three will do initially,
you can add more later and you can rename the initial layers if necessary. This is much easier than
drawing entities on layer 0 and then having to change them later.

- Avoid drawing on layer 0, it's bad practice!

- When you are trying to select objects in a complicated drawing it may be easier to turn some layers off
first so that you don't inadvertently select entities you don't want.

- Always stratify your drawing using different layers for different sorts of objects. For example, use
separate layers for trees and shrubs, even if they are the same colour and have the same linetype.

- Make your layer names understandable. Use common names such as "TREE" or "PATH" rather than
simply using numbers or codes unless you must in order to conform to the British Standard or a project
specific naming scheme.

- If you are working on any AutoCAD drawing project which involves others, make sure you devise a
layer naming strategy **before** drawing begins. This will avoid many headaches later on.

- If you turn off a layer containing 3D Faces, the 3D Faces become invisible. However, the 3D Faces still hide objects when you use a command such as HIDE. To prevent 3D Faces hiding other objects you must freeze them. This is particularly annoying when you are plotting with hidden lines removed. I always considered this an AutoCAD bug but since it has been around for such a long time it must be considered a feature.

- If your linetypes do not display correctly along polylines, use the PEDIT command and set "Ltype gen" on. This will force the linetype to display correctly. You can also do this using the DDMODIFY command (Modify ▶ Object ▶ Polyline from the pull-down menu) by checking the "LT Gen" box in the "Modify Polyline" dialogue box.

Learning to work with object properties is a very important aspect of AutoCAD. Layers are particularly important and you need to work with them all the time. If you're not, then you're doing something wrong. Make sure you understand all of the topics covered in this tutorial.
Masterplan Exercise

by David Watsor

Introduction

The following exercise is designed to show you how to construct simple shapes from given dimensions and to allow you to practice the basic AutoCAD commands which you have already learned. Use the tutorials to cover any topics you are unsure of.

Note: When drawing the site outline, you do not need to draw the dimensions.

Client Brief

Your client owns a site that lies on the Greenwich Meridian (the site is shown below). She has decided to celebrate the forthcoming millennium by developing the site as a public park. She hopes the money to develop the park will come from the millennium commission and that the development of this park will form a part of the "Meridian Tree Line" project. In order to help gain funding you have been asked to develop an illustrative masterplan design for the site that will be used to put the case for funding to the commission. All submissions must be in digital format and you will, therefore, have to use CAD techniques to produce the masterplan.

The Millennium Tree Line project is an international project that aims to plant trees along the Greenwich Meridian in celebration of the millennium. This will obviously form a major design element of the site, however, your client would also like to see the introduction of some water into the design and an interpretation centre/cafe.

Site Layout
Hints

- To get started, try drawing the first boundary line using a relative polar co-ordinate in the form, \( @450<60 \), where "450" is a distance and "60" is an angle. You will find lots of information about co-ordinates in the "Using Co-ordinates" tutorial.

- The Offset command will be very useful when you are constructing the site boundary. You will find the Offset command on the Modify pull-down (Modify ▶ Offset) and on the Modify toolbar. You will also find more information about the Offset command on the "Modifying Objects" tutorial.

- The site boundary cannot accurately be drawn without the use of Osnaps such as Endpoint. Use the "Object Snap" tutorial to learn about using object snaps.

- Make sure your drawing has a good layering structure. You can always use the Modify Properties
command, to change the layer of objects after they have been drawn. You can start the Modify Properties command from the Modify pull-down, Modify ▶ Properties or from the Object Properties toolbar.

- Feel free to interpret the brief in any way you feel appropriate, however, you must also concentrate your efforts to produce a good-looking, illustrative plan. Since trees will be an important element of the design, spend some time developing some useful tree symbols.

- Don't forget to save your drawing regularly.
North Point Exercise

by David Watsor

Introduction

This exercise is designed to demonstrate the use of some of the most commonly used Osnap's and how they can be used in conjunction with the From Osnap. The exercise uses some of the basic drawing commands covered in the Drawing Objects tutorial and some of the ideas discussed in the Using Co-ordinates tutorial. If you are unsure about any part of this exercise, have a look at these tutorials and make sure you have worked through the Object Snap tutorial.

To Draw the Triangle

Command: **LINE**

Specify first point: (pick a point in the middle of the drawing area)
Specify next point or [Undo]: @15,0
Specify next point or [Undo]: FROM
Base point: MID
of (pick a point near the middle of the line)
<Offset>: @0,75
Specify next point or [Undo]: C (to close)

To Draw the Vertical Line

Command: **LINE**

Specify first point: MID
of (pick point near the middle of the triangle base)
Specify next point or [Undo]: @0,-100
Specify next point or [Undo]: ↑

To Draw the Horizontal Line

Command: **LINE**

Specify first point: FROM
Base point: MID
of (pick a point near the middle of the vertical line)
<Offset>: @-25,0
Specify next point or [Undo]: @50,0
Specify next point or [Undo]: ←

To Draw the Circle

Command: **CIRCLE**

Specify center point for circle or [3P/2P/Ttr (tan tan radius)]: INT
of (pick a point near the intersection of the two lines)
Specify radius of circle or [Diameter]: 12.5

To Trim the Lines within the Circle

Command: TRIM
Current settings: Projection=UCS Edge=None
Select cutting edges ...
Select objects: (pick the circle on its circumference)
Select objects: (pick one of the lines within the circle)
Select object to trim or [Project/Edge/Undo]: (pick the other line within the circle)
Select object to trim or [Project/Edge/Undo]:

To Draw the Text

Command: DTEXT
Current text style: "Standard" Text height: 2.5000
Specify start point of text or [Justify/Style]: J
Enter an option [Align/Fit/Center/Middle/Right/TL/TC/TR/ML/MC/MR/BL/BC/BR]: M
Specify middle point of text: CEN
of (pick a point on the circumference of the circle)
Specify height <2.5000>: 15
Specify rotation angle of text <0>: 0
Enter text: N
Enter text: 
Command:

Your north point should now look like the one in the illustration above. For more practice, try designing a different north point and then draw it using similar techniques.

If you are still not sure about the use of Object Snaps, perhaps you would like to return to the Object Snap tutorial and have another look at it.
Site Layout Exercise

This exercise is designed to help you understand how to construct drawings from given dimensions and how to use the various drawing and modify tools to create new drawing elements.

The Plan

The illustration above shows the boundary of a development site and two office buildings. All dimensions are in metres. Use the dimensions and co-ordinates to accurately draw the site boundary and building footprints (you do not need to draw the dimensions, these are for information only). Think about layers. Perhaps you should use one layer for the boundary and one for the buildings. There are an infinite number of ways to construct this drawing; there isn't a right way or a wrong way. Use the draw and modify skills you have already learned to construct the drawing in the most logical way. If you get stuck, have another look at some of the tutorials. The Drawing Objects and Modifying Objects tutorials contain lots of information that may help you. Also, think about using direct distance entry.

When you have completed the site layout, you can have some fun. You need to add a road to the site for traffic circulation. You also need to add a lake, an area for car parking and some trees.
Advanced Selection

by David Watsor

Introduction

The selection tools described in the Object Selection tutorial are fine if you only need to pick a few objects at a time or if you can easily see the objects you want to select. Sometimes though, your selection requirements may not be quite so simple. AutoCAD enables you to create selection sets by building database style queries that can make complex selections really quick and accurate. This tutorial describes the use of AutoCAD's advanced selection tools and how the selection options can be configured for better selection efficiency.

Quick Select

Toolbar not available

Pull-down Tools Quick Select...

Keyboard QSELECT

Quick Select made its debut in AutoCAD 2000 and is designed to help users make complex selections quickly. It is also designed to be a simplified version of the Filter command, detailed below. Quick Select allows you to make selections based upon object properties. Say, for example, that you needed to select all circles on a layer called Water. Quick Select can help you do this. If you look at the dialogue box below, you will see that there are a number of parameters to set. To select all circles on the Water layer, you would make the settings shown in the dialogue box.

Let's have a closer look at the selection parameters in the Quick Select dialogue box. As with all dialogue boxes, it is important to move methodically through the various parameters. It is even more important in this case because the choices you make at the beginning of the process will affect the options available to you later. Start at the top of the dialogue with "Apply to" and work your way down.

1. The "Apply to" parameter can be used to cause the selection to be made from the entire drawing or from a selected part of the drawing. Use the Select objects button to create a selection set from which your more detailed selection
will be made.

2. The "Object type" parameter allows you to select objects such as circles, lines etc. The drop-down list contains an inventory of all the different object types in the current drawing. If your selection is to be made from more that one object type, select "Multiple". Note that this parameter only allows you to select one object type or all objects. This is one limitation of Quick Select, although you can append selections to create compound selection sets, see below. However, if you want to make complex selections based upon multiple selection criteria, you may be better of using the more advanced features of the Filter command described below.

3. The "Properties" parameter allows you to specify which particular property of an object type to apply to the selection. For example, circle properties include radius, diameter and circumference in addition to the standard object properties like layer and colour. So you could select all circles with a particular radius or all circles on a particular layer.

4. The "Operator" parameter determines how the value is applied to the selection. For example, using the equals option with a circle radius and a value set to 24 would mean all circles with a radius of 24 are selected. However, other options available for the operator parameter allow you to select all circles of radius less than 24 or greater than 24 or even all circles except those with a radius of 24. Pretty amazing huh?

5. The "Value" parameter is used to specify the value of the property you have already chosen. For example, if you had specified Circle and Radius as your object type and property, you might enter "24" as a value. All circles with a radius of 24 would be selected. Or if you had specified Circle and Layer as your object type and property, you could select a layer name such as "Water". In this case, all circles on the layer called Water would be selected.

Finally, using the "How to apply" box, you have the option to have the selected objects either included or excluded from the new selection set. In addition, you can also have this selection appended to the current selection set. The "Append to current selection set" option is particularly useful because it means that you can use Quick Select repeatedly to build up compound selections. For example, you could use Quick Select to select all blue circles and then use it again to select all blue lines. Appending the blue lines selection to the blue circles selection would mean that you end up with a selection of all blue lines and circles.

As you can see, this is a very powerful tool and takes a little time to get used to. However, it is well worth making the effort as it can drastically improve your drawing efficiency. For your convenience, Quick Select is also available from the right-click context menu.

Object Selection Filters

It may sometimes happen that you need to create a selection set of objects based upon one or more of their properties. For example, you may want to select all objects on a particular layer or more particularly, you may even want to select all circles on that layer. This type of selection is relatively easy with the Quick Select command discussed above. However, what if you wanted to select all green circles and lines on a particular layer? As good as Quick Select is, it cannot create selections from so many parameters. Fortunately AutoCAD
provides a method to filter objects based upon a wide range of selection criteria.

An AutoCAD drawing is simply a database of objects and their properties. Using the Filter command you can define a query just like you would in a database. If you look at the Object Selection Filters dialogue box, shown above, you will see that a filter has been defined that will select all circles on the "Construct" layer.

To create a filter, click the arrow on the drop-down list in the Select Filter area and select the object type or property you would like to add to the filter list. Click on the "Add to List" button. You can add as many object types or properties to the list as you like. Having defined a filter list you can either use it as a one-off or you can save it as a named filter by typing a name in the Save As edit box and then clicking the "Save As" button. Your named filter will then be added to the Named Filters drop-down list and you can use it again at any time.

Although you can create filters using the Filter command from the command prompt, you will mostly want to use it during the course of a selection operation. Fortunately, the Filter command can be used transparently. This means that it can be used whilst another command is still running. To get an idea how this might work, follow the example below.

Create a Drawing

1. Start a new drawing, click on and select "Start from Scratch" from the Create New Drawing dialogue box.

2. Use the Layer command, from the toolbar or Format ▶ Layer… from the pull-down menu to create two new layers called "Construct" and "Boundary". Set the Construct layer colour to Green and the Boundary layer colour to Red. Set the current layer to "Construct".
Note: If you need more information about layers, see the "Object Properties" tutorial.

3. Draw a selection of objects, lines, polylines, ellipses etc. including several circles.

4. Set the current layer to "Boundary" using the Object Properties toolbar.

5. Draw some more circles.

6. Now you are going to erase just the circles on the Construct layer, so start the ERASE command, from the Modify toolbar or Modify ▶ Erase from the pull-down menu.

Compile the Filter

7. At the "Select objects" prompt enter 'filter. The apostrophe is very important, it tells AutoCAD that you want to use a command transparently.

8. When the Object Selection Filter dialogue box appears, select "Layer" from the drop-down list. The list is arranged alphabetically so you will need to scroll down the list to find it. When you have selected "Layer", click on the "Select..." button. The Select Layer(s) dialogue box appears, select "Construct" from the list and click the "OK" button. You are now returned to the Object Selection Filter dialogue box, click the "Add to List" button, your layer selection is added to the list which now displays "Layer = Construct".

9. Next, select Circle from the drop-down list and click the "Add to List" button. "Object = Circle" is added to the list below the Layer entry. You have now completed the filter list.

Apply the Filter

10. Click on the Apply button. The dialogue box disappears and you are returned to the "Select objects" prompt. The principle behind the filter list you have just compiled is that when applied to a selection, all objects which do not match the listed criteria will be filtered out. The simplest way to apply this filter to the whole drawing is to use the All selection option. Enter all at the prompt. All objects are selected but the filter ensures that all objects except the circles on the Construct layer are filtered out. All the circles on the Construct layer are highlighted to indicate that they are selected. and you are returned to the "Select objects" prompt.

11. Enter ← at the prompt, AutoCAD responds:

```
Exiting filtered selection.
```

You now see the "Select objects" prompt again because you can add objects to the selection set without them being filtered. Enter ← again to complete the command. The green circles are erased, leaving all other objects unaltered.
This whole process may seem very long-winded but when you have to make this type of selection on a complex drawing you will thank your lucky stars that the Filter command exists. However, if your selection requirements are more reasonable, try the Quick Select command as an alternative to using Filter.

**Object Selection Modes**

**Toolbar** not available

**Pull-down** Tools ➤ Options…

**Keyboard** DDSELECT

The Selection tab of the Options dialogue box (extract shown on the right) can be used to control many of the settings that have been discussed above and some that have not. In general it is advisable **not** to change any of the default settings unless you have good reason to do so.

**Noun/Verb Selection** allows you to select objects either before or after starting a command when it is checked. **Use Shift to Add**, does just that when checked. The default is to remove objects when shift picking, as described above. **Press and Drag** enables selection windows to be defined by picking and then dragging the mouse when checked. The default method for defining a selection window is to use two pick points. **Implied Windowing** enables this type of selection when checked. See "Implied Windowing" above for details. **Object Grouping** enables a group of objects to be selected by picking only one of the objects in the group when it is checked. **Associative Hatch** causes a hatch boundary to be selected along with the hatch when it is checked.

**Pickbox Size**

You can also use the Selection tab of the Options dialogue box to change the pickbox size. Use the slider bar to increase or decrease the size. The larger the size of the pickbox the wider the area in which AutoCAD looks for objects. Generally the pickbox is better set to a smaller size to make picking more accurate. The default setting works very well and it is unlikely that you will need to change it.

**Object Sorting Methods**

Object sorting methods are controlled from the User Preferences tab on the Options dialogue box, Tools ➤ Options… from the pull-down menu. The object Sorting Methods section of the dialogue is shown on the right. These options enable you to optimise the way objects are selected with respect to different operations. Objects will be added to selection sets in the order in which they appear in the drawing database for each method that is checked. Although the "Plotting" and "PostScript Output" methods
are the only ones set by default, it is often advantageous also to check the
"Object Selection" method so that more recent objects are selected before older ones for general drafting.
Since processing time is increased for each additional method selected, it would also be advantageous to
uncheck the "PostScript Output" method unless you intend to use PostScript output, of course.
User Co-ordinate Systems

by David Watso

Introduction

This tutorial describes what UCSs are, why we need them and how to use them. The correct use of UCSs with AutoCAD is the key to producing good 3D models and they can also help with 2D work. If you just want to quickly find a description of the UCS options, click on the appropriate button on the QuickFind toolbar below.

What is a UCS and why do I need one?

AutoCAD started life as a two-dimensional drafting program. It was not designed for 3D. Almost all the AutoCAD drawing and edit commands can only work in 2D (the exceptions being commands like 3DPOLY and 3DFACE). When Autodesk, the makers of AutoCAD incorporated 3D into the program they needed some method for doing so without completely rewriting the software. The method they decided upon has become known as UCS, User Co-ordinate Systems.

When you first start up AutoCAD you are presented with a plan view of the drawing area. In the bottom left hand corner of the drawing area is an icon, known as the UCS icon. The icon looks like the illustration on the right and shows 3 specific bits of information. First, the icon contains a figure X and an arrow which points from left to right along the bottom of the screen. Second, the icon contains a figure Y and an arrow head which points from bottom to top along the left hand side of the screen. These first two parts of the icon indicate the position and direction of the X and Y axes. As your cursor moves over the screen area you can see the change in X and Y co-ordinates by watching the co-ordinate status area at the bottom left of the screen (X,Y,Z). X and Y co-ordinates increase in the direction indicated by the UCS icon. By implication the Z axis points straight out of the screen towards us. If you have just opened a new drawing the Z co-ordinate will appear as “0.0000” in the status bar and will not change as you move the cursor because you are only moving in the XY Plane. The third piece of information contained in the UCS icon is the letter W. The W stands for "World" and indicates that you are using the World Co-ordinate System.

You can think of the World Co-ordinate System as representing the real world. The 2D drawing plane that you see in plan when you first start AutoCAD can be thought of as the ground under your feet. This plane is known as the XY plane.

As mentioned above, almost all drawing with AutoCAD happens in 2D. For example to draw an open ended box you would simply draw a rectangle in plan and then use Change Properties to give it a thickness. Notice that to produce this 3D box you have only worked in 2D. To produce a 3D effect all you have to do is to change one of the 2D rectangles parameters i.e. its thickness. No actual drawing was done in 3D.
This method works very well for simple 3D objects, but say you wanted to draw a circle on one of the vertical faces of the box you have just drawn. Using only the World Co-ordinate System this would be impossible because circles (like many other AutoCAD entities) can only be drawn in the XY plane.

AutoCAD gets round this problem by allowing you to move the XY plane into a different position. For example, to draw a circle on the vertical face of a box you would need to move the XY plane in such a way that it lay coplanar (in the same plane) with the vertical face of the box.

By moving the XY plane you are by definition changing the co-ordinate system. In fact AutoCAD takes this analogy and turns it around. To move the XY plane the user (i.e. you) must create a new co-ordinate system, in other words, you must define a User Co-ordinate System.

As you can see from the two illustrations above, the UCS icon shifts its position to indicate the orientation of the current User Co-ordinate System. Also, when you are working in a UCS the W disappears from the icon to indicate that you are no longer in the World Co-ordinate System.

How do I define a UCS?

AutoCAD provides a number of ways to define a User Co-ordinate System. All of these options are available to you when you use the UCS command.

The UCS Command

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Tools ➤ UCS ➤ various options</th>
</tr>
</thead>
</table>

When you start the UCS command from the keyboard or from the toolbar you are presented with lots of options on the command line:
These options will be described later.

Note that the pull-down menu allows direct access to all of these options. You can also gain direct access to the options from the fly-out UCS buttons on the standard toolbar or from the UCS toolbar.

First let’s have a look at a practical example of defining a UCS using the 3point option.

The 3 Point Option

Toolbar

Pull-down Tools ➔ UCS ➔ 3 Point

Keyboard UCS ← 3

The 3point option prompts you to pick 3 points in space which it uses to define the position of the new XY plane. The three points represent three positions in the new XY plane. The first point will become the origin of the new co-ordinate system. The second point can be any point on the positive portion of the X axis. The third point can be any point on the positive portion of the Y axis. The illustration below shows the three points you could pick to define a UCS with an XY plane which is coplanar with the front face of the box.

This is a very common sequence which you may need to use in order to draw windows and doors on a building elevation.

Make sure you use the Endpoint Osnap to pick the corners of the box.

An Example
Let's go through the sequence of defining a UCS and then using it to draw on the vertical face of a box.

1. Draw the box
Start AutoCAD and draw a square with sides of 50 drawing units using the **Rectangle** command.

Select Rectangle from the Draw toolbar.

At the **Chamfer/Elevation/Fillet/Thickness/Width/<First point>:** prompt, pick a point near the middle of the drawing area.

At the **Other corner:** prompt, enter `@50,50` at the keyboard (the `@` indicates a relative co-ordinate). The square is now drawn at the required size.

Using **Properties** give the square a *thickness* of 50 drawing units.

Select Properties from the Object Properties toolbar.

Select the rectangle at the **Select objects:** prompt and enter `50` in the Thickness edit box.

Next, change the view using the **DDVPOINT** command, setting the angle from the X Axis to 245 degrees and the angle from the XY Plane to 30 degrees. You can find this command on the view pull-down (**View ▸ 3D Viewpoint ▸ Select...**)

Your box should now look similar to the one in the illustration above.

2. Try to draw a circle
Try to draw a circle on the front vertical face of the box.

Start the **Circle** command (select □ from the Draw toolbar), pick a centre point near the middle of the front vertical face of the box and enter a radius of 20. Notice that the circle ends up flat in the *World XY plane*.

3. Start the UCS Command
Start the **UCS** command by typing "UCS" at the keyboard or by selecting □ from the UCS toolbar.

**Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/?/<World>:**

Type "3" to select the **3point** option at the prompt.

**Origin point <0,0,0>:**

The default (0,0,0) refers to the origin of the current UCS. Using the **Endpoint** Osnap select the lower front left hand corner of the box (refer to the illustration above).

**Point on positive portion of the X-axis <23.00,16.00,0.00>:**
Using **Endpoint** again, select the lower front right hand corner of the box.

Point on positive-Y portion of the UCS XY plane <22.00,17.00,0.00>:

Pick the upper front left hand corner of the box (don’t forget **Endpoint**!).

**Note**: The default co-ordinate values shown in triangular brackets at your command prompt will probably be different from the ones shown here, this will make no difference to the final result.

Notice that two things have happened to the **UCS icon**. The icon has changed position to reflect the orientation of the **current UCS** and the **W** has disappeared to tell you that you are no longer in the **World Co-ordinate System**.

4. **Now try drawing that circle again**

Now that you have successfully defined a UCS you should be able to draw that circle on the front face of the box. Draw a circle of 20 units radius with its centre near the centre point of the front vertical face. Notice that this time the circle is drawn exactly where you wanted it.

5. **Give it a thickness**

Once you have defined a **UCS** all AutoCAD commands will work relative to the new co-ordinate system. In other words AutoCAD treats the **UCS** just as if it were the **WCS** (World Co-ordinate System). For example if you give an **object a thickness**, you know that the **object** will be **extruded** in a direction which is perpendicular to the **XY plane**. Since our **XY plane** is now in a vertical position relative to the **WCS** any **thickness** applied to an **entity** will cause an **extrusion** in a horizontal direction relative to the **WCS**.

Use **Properties** to give the new circle a **thickness** of 20 drawing units.

6. **Define another UCS**

Try the **UCS 3point** option again, start the command by selecting from the UCS toolbar to pre-select the 3 point option and this time define a **UCS** on the left hand face of the box. Draw another circle and give it a **thickness** of 20 units.

Your finished drawing should look something like the one on the right.

7. **Experiment with the Plan command**

The Draw and Modify family of commands are not the
only ones which work with respect to the UCS. View commands like Plan also change to take the new co-ordinate system into account. You can create a plan view of the current UCS by typing PLAN and → at the command prompt (current UCS is the default option) or you can select it from the pull-down menu at View → 3D Viewpoint → Plan View → Current UCS.

Try using the Plan command with different UCS orientations. With a UCS defined as coplanar with the vertical face of a box the UCS plan view will correspond to the WCS elevation of the same face.

Remember, you can return to the World UCS at any time by selecting 📚 from the UCS toolbar or by typing UCS → 3 at the keyboard.

The two illustrations below show this situation. The one on the left shows the result of a plan view with a UCS defined coplanar with the left hand vertical face of the box which you drew in the above exercise. As you can see the result is an elevational view of that face relative to the WCS. The one on the right shows the result of a plan view of the same box with the UCS set to World. In other words this is the true plan view.

Before we go on to have a look at the other UCS command options let's have a look at another command which can help to make life easier when working with UCSs.

The UCSICON Command

The UCSICON command is used to control how the UCS icon is displayed. In the examples above you have been working with the UCS icon in its default position, however there are a couple of options which the UCSICON command provides which can help to prevent certain visual ambiguities. Consider the example below: These two illustrations show a cube. The cube on the left has a UCS set to its front face and the cube on the right has a UCS set to its back face. Notice the problem; you cannot tell by looking at the UCS icon which is which.
You can overcome this problem by using the **ORigin** option of the **UCSICON** command.

Draw a simple cube like the one above and set the UCS to the front face. Then start the **UCSICON** command by typing "UCSICON" at the keyboard.

**ON/OFF/All/Noorigin/ORigin <OFF>:**

The command options are simple:

- **OFF**, the default, turns the **UCS icon** off. This can be useful if you are working with a complicated drawing and the icon is getting in the way. It is also useful if you are creating an AutoCAD slide file or a bitmap using **SAVEIMG** and you do not want the icon to show on the image.

- **ON**, turns the **UCS icon** back on if it has been turned off.

- **All**, applies any change to the **UCS icon** status to all **viewports**, not just the current **viewport**.

- **Noorigin**, displays the **UCS icon** in the bottom left hand corner of the **viewport**, irrespective of where the **UCS** origin is.

- **ORigin**, displays the **UCS icon** at the **UCS** origin position.

You can also toggle the ON/OFF and the ORigin/Noorigin options from the View pull-down menu (**View/Display/UCS Icon/options**). The UCS icon is set to **ON** and will display at the **Origin** when these options are shown as checked with a tick in the menu.

Type **OR** to select the **ORigin** option and hit the RETURN key.

Notice that the **UCS icon** jumps to the bottom left hand corner of the front face of the cube. Now define a **UCS** on the back face of the cube and watch what happens.

As you can see, by using the **ORigin** option of the **UCSICON** command you can be sure that any **UCS** you define is in the correct position. There is no ambiguity as there was in the previous example.

Notice that the icon shows a small cross at the origin position when this option is activated.

**Tips**

The **UCS icon** will only display at the origin position if the origin is in the current **viewport**. If it is not, the icon...
will display in its default position. You can test this by using the **PAN** command to move the **UCS** origin off screen.

Remember, when you want to put the **UCS icon** back to its default position just use the **Noorigin** option of the **UCSICON** command.

**UCS Command Options**

Let's now go back and have a look at the **UCS** command options.

**Origin/ZAxis/3point/OBject/View/X/Y/Z/Prev/Restore/Save/Del/?/<World>:**

**Origin**, defines a new **UCS** by moving the origin of the current **UCS**. The orientation of the **XY plane** remains unchanged. For example, you could have used this option to change the **UCS** from the front face of the cube to the back face of the cube in the above example.

Auto CAD prompts:

**Origin point <0,0,0>:**

Using an appropriate **object snap**, pick the new position for the **UCS** origin.

**ZAxis**, defines a **UCS** with a particular **extrusion** direction (positive **Z** axis). **AutoCAD** determines the position of the **XY plane** based on the new **Z** axis.

AutoCAD prompts:

**Origin point <0,0,0>:**

**Point on positive portion of the **Z** axis <default>:**

In each case pick the new position using an **Osnap**.

**3point**, You should already be expert with this option, if not see the main **UCS** command section above.

**OBject**, lets you define a new **UCS** by pointing to any **object** except a **3D Polyline**, **polygon mesh**, or **Viewport entity**. The new **UCS** will have the same **extrusion** direction as the selected **entity**. The origin of the new **UCS** and the orientation of its **X** axis are found according to the rules given in the table above. For objects other than **3D Faces**, the **XY plane** of the new **UCS** will be parallel to the **XY plane** in effect when the **object** was created. For **3D Faces**, the **XY plane** of the new **UCS** will be coplanar with the face. This can be very useful if you want to draw on a **3D Face**.

<table>
<thead>
<tr>
<th><strong>Object</strong></th>
<th><strong>Method of UCS determination</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Arc</strong></td>
<td>The centre of the arc becomes the new <strong>UCS</strong> origin. The <strong>X</strong> axis passes through the endpoint of the arc, which is closest to the pick point.</td>
</tr>
<tr>
<td><strong>Circle</strong></td>
<td>The Circle's centre becomes the new <strong>UCS</strong> origin, with the <strong>X</strong> axis passing through the pick</td>
</tr>
</tbody>
</table>
View, establishes a new UCS whose XY plane is perpendicular to your viewing direction (i.e., parallel to the screen). The UCS origin remains unchanged.

One useful application of the View option is to set the UCS for text annotation from the current view position. If you are creating an AutoCAD slide file you may want to annotate a 3D object in an oblique view. The illustration on the left shows the result of adding text in the World Co-ordinate System. The one on the right shows the same text added after using the UCS View option.

X/Y/Z, rotates the current User Co-ordinate System around a specified axis.

AutoCAD prompts:

Rotation about $n$ axis <0.0>:

where $n$ is X, Y, or Z. You can indicate the desired angle either by picking two points, or by entering the rotation angle at the keyboard. The new angle is specified relative to the X axis of the current UCS. You can enter either a positive or a negative rotation angle.

Previous, restores the previous UCS. AutoCAD stores the last 10 co-ordinate systems, so you can step back through them by repeating the UCS Previous option.

Restore, restores a saved UCS so that it becomes the current UCS.

When you enter "R", AutoCAD prompts:
?/Name of UCS to restore:

You must enter the name of a UCS which you have previously saved. If you cannot remember the name, enter "?" and then RETURN at the next prompt to see a list.

Save, names and saves the current UCS. The name can be up to 31 characters long and can contain any of the usual valid DOS characters (i.e. spaces are not allowed).

When you enter "S", AutoCAD prompts:

?/Desired UCS name:

Enter a valid name or use the question mark option to see a list of current names.

Delete, removes the specified UCS from the list of saved co-ordinate systems.

When you enter "D", AutoCAD prompts:

UCS name(s) to delete <none>:

If you enter the name of an existing UCS, AutoCAD deletes it. You can delete more than one UCS by using wild-card characters or by entering a list of UCS names separated by commas.

?, Lists the UCS you specify, providing the name, origin, and the XYZ axes for each saved co-ordinate system, relative to the current UCS. If the current UCS is unnamed, it is listed as "WORLD" or "NO NAME", depending on whether or not it is in the World position.

When you enter "?", AutoCAD prompts:

UCS name(s) to list <*>:

Either type the name of the UCS you want listed or hit the RETURN key to see a listing for all User Co-ordinate Systems.

World, sets the current UCS to be the same as the World Co-ordinate System.

The UCS Control Dialogue Box

As you have seen the Save, Restore and Delete options allow you more control over the User Co-ordinate Systems you define. However, they are often difficult to use if you can't remember all the names.

The DDUCS command displays a dialogue box which lists all the co-ordinate systems and allows you to do many of the things the UCS command
allows you to do in a more intuitive manner.

### The UCS Control dialogue box

The UCS Control dialogue box displays a list of the co-ordinate systems you have defined. The *WORLD* Co-ordinate System is always the first entry in the list. If other co-ordinate systems have been defined during the current drawing session, a *PREVIOUS* entry appears next. If you haven’t named the current co-ordinate system, *NO NAME* appears as the third entry in the list.

AutoCAD indicates that a co-ordinate system is currently in effect by displaying "Current" next to its name in the list box. To make a different co-ordinate system current, pick its name and select the Current button.

To rename a co-ordinate system, select its name, enter the new name in the Rename To: edit box, and then pick Rename To:. Once a UCS has been renamed, it is saved and can be restored at a later time. The dialogue box on the right has three named User Co-ordinate Systems. To delete a co-ordinate system, select its name and pick the Delete button. You can't rename or delete the *WORLD* or *PREVIOUS* co-ordinate systems.

To save any changes you have made, pick the OK button.

### The UCS Follow system variable

Keyboard UCSFOLLOW

Changing from one UCS to another does not change the view of the drawing unless the UCSFOLLOW system variable is turned on (set to 1), in which case a plan view of the new UCS is displayed.

At the command prompt enter "UCSFOLLOW", AutoCAD prompts:

New value for UCSFOLLOW <0>:

Entering "1" turns UCSFOLLOW on and "0" turns UCSFOLLOW off.

UCSFOLLOW can be particularly useful if you are working in plan on a scheme which is orientated in such a way that it is awkward to work with. Rather than using the Rotate command to rotate the whole drawing you...
could set **UCSFOLLOW** to 1 and create a UCS which is in your preferred working orientation. UCSFOLLOW will then simply rotate your view (see the illustration below).

![A plan view of a site in the World co-ordinate system. A plan view of the same site with ucsfollow set to 1 and a UCS which is rotated about the Z axis.](image)

**Other UCS Icons**

There are three other common UCS icons which you may come across from time to time.

The "broken pencil" **UCS icon** (shown right) appears if your view direction is edge-on to the current **UCS** (or within one degree of edge-on). The icon indicates that you cannot draw in the current view.

The cube icon indicates that you are in perspective viewing mode. You can produce a perspective view of an AutoCAD drawing using the **DVIEW** command. When you are in perspective viewing mode you cannot select objects or use any of the draw commands. These limitations are the same as those in shaded or rendered view.

The triangular icon illustrated on the right indicates that you are in **Paper Space** and that **Tilemode** is set to 0. Note that if you have defined more than one viewport (using the **MVIEW** command) with **Tilemode** set to 0 and you are in **Model Space**, each viewport has its own UCS icon (see below). However, you cannot define different UCS settings to different viewports. If you set a new UCS in one viewport, the new settings will be applied to all viewports irrespective of which viewport is in current use (see the illustration below).
Tips & Tricks

- If you ever get lost in 3D space or you're not sure which orientation your UCS is in, just return to the World Co-ordinate system and use the Plan command.

- Always look at the UCS icon to check whether you are in a UCS or in WCS.

- Remember, the commands you use will always operate relative to the current UCS.

- Always save a UCS if you need to return to it in the future.

- Always be clear in your mind about which are your X, Y and Z axes.

- Use the UCSICON command with the ORigin option to force the icon to appear at the UCS origin point. This can be very useful when the drawing gets complicated because it may be difficult to see where your UCS plane is.

- If you want to quickly set the UCS to an elevation (relative to WCS) just use one of the presets available from the DDUCSP command.

The UCS Orientation dialogue box is illustrated on the right. Notice that you can also use this dialogue box to
set the UCS to View, Previous and World.

Toolbar

Pull-down Tools ▸ UCS ▸ Preset UCS…

Keyboard DDUCSP

- When you are setting a new UCS it is often easier to do it when looking at your drawing in an axonometric view. Use the DDVPOINT command (View 3D Viewpoint Select… from the Pull-down menu) to get a clear view of your drawing.

- Use the SHADE command (View Shade options from the Pull-down menu) to see 3D objects more clearly. 3D objects in wireline can look ambiguous.

- Always end your drawing session with the UCS set to World. This avoids confusion next time the drawing is opened.

- When using commands like DDVPOINT and DDUCSP, make sure that the option "Absolute to WCS" is checked otherwise the results can be very confusing.

- If you find working in 3D confusing you can always construct a simple 3D box around your work as a visual reference. It is also a good idea to use a box as a constructional guide for complex shapes.
Dimensioning

by David Watso

Introduction

This tutorial describes the options and commands available for dimensioning drawings and how to use them. The correct use of AutoCAD's dimension tools is the key to producing clear and concise measured drawings. If you just need to quickly find a description of the various dimension commands, click on the appropriate button on the QuickFind toolbar below.

AutoCAD provides a whole range of dimensioning tools which can be used to quickly dimension any drawing without the need for measurement. Dimensioning in AutoCAD is automatic; lines, arrows and text are all taken care of by the dimension commands. AutoCAD dimensions are special blocks which can easily be edited or erased as necessary.

AutoCAD provides lots of control over the way dimensions look. Using a system similar to text styles, dimension styles allow you to design dimensions so that they look just the way you want them to.

For example, the illustration above shows two different dimension styles. The one on the left is the default style known as STANDARD. If you do not create a style of your own or modify the standard style, all dimensions will look like this. The dimension line has arrow heads and the dimension text is positioned above the line and is drawn using the current text style. The dimension on the right has been drawn using a new style. The arrows have been changed to obliques, the vertical alignment of the text has been centred and the current text style has been changed.

There are lots of dimension commands which include facilities for indicating tolerances and alternate units dimensioning. However, this tutorial aims to cover the most common commands for general use and constitutes an introduction to dimensioning with AutoCAD. If you would like to learn more about dimensions, refer to the AutoCAD user manual.

AutoCAD divides dimensions into four main categories: Linear, Radial, Ordinate and Angular. For the purposes of this tutorial we will only consider some of the commands within the Linear, Radial and Angular categories.

When you create dimensions, AutoCAD automatically creates a new layer called "Defpoints". This is a special
layer which cannot be deleted or renamed. AutoCAD uses this layer to store dimension information and you can effectively ignore it. (see Object Properties for more information on layers)

When working with dimensions it is very important that line origins are picked accurately so that the resulting measurement and text are correct. Always use an Osnap to pick dimension line origins. If you have a lot of dimensioning work to do, it will be worth using a running Osnap. Running object snaps are set using the Osnap Settings dialogue box. To display this dialogue box type DDOSNAP at the keyboard or select Tools ▶ Object Snap Settings from the Pull-down menu. There is also a keyboard short-cut; you can display the Osnap Settings dialogue box simply by hitting the F3 key.

This tutorial is not designed as a reference for dimensioning conventions. If you wish to learn more about dimensioning conventions, consult BS 308: Part 2.

Selecting Dimension Commands

Selecting and working with the dimension commands in AutoCAD R14 is much easier than in previous versions. All commands can be accessed from the keyboard and now most commands are also available from the Dimension pull-down menu and the Dimension toolbar. The Dimension toolbar is particularly useful because it places all the dimension commands a single mouse click away. Since the Dimension toolbar is not displayed by default you will need to enable it from the Toolbars dialogue box. To display the Toolbars dialogue box, select View ▶ Toolbars… from the pull-down or type TOOLBAR at the keyboard. To display the Dimension toolbar, click in the checkbox against "Dimension" in the toolbar list.

The Linear Dimension Commands

As the name suggests the Linear dimension commands are used to dimension along straight lines. There are five linear dimension commands, namely: DIMLINEAR, DIMCONTINUE, DIMALIGNED, DIMALIGNED and DIMROTATED. The DIMLINEAR command is probably the most common dimension command you will use.

The Linear Dimension Command

<table>
<thead>
<tr>
<th>Toolbar</th>
<th>Dimension ▶ Linear</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pull-down</td>
<td>DIMLINEAR</td>
</tr>
<tr>
<td>Keyboard</td>
<td>DIMLINEAR</td>
</tr>
</tbody>
</table>

You can use this command to generate horizontal and vertical dimensions.
Creating a linear dimension is easy. All you have to do is start the command, specify the two points between which you want the dimension to be drawn and pick a point to fix the position of the dimension line. Consider the diagram (right) whilst working through the following examples.

**Command Sequence**

Command: DIMLINEAR

First extension line origin or press ENTER to select: (pick P1)
Second extension line origin: (pick P2)
Dimension line location (Mtext/Text/Angle/Horizontal/Vertical/Rotated): (pick a point to position the dimension line, you will see the dimension rubber banding)

You may have noticed that the first prompt asks you to pick the first extension line origin or to press the ENTER key. Pressing the Enter/Return key results in the following prompt:

Select object to dimension:

AutoCAD allows you to dimension an object simply by picking it. Try this out. Draw a line or a circle and use this option rather than the two point option to see what happens.

Dimensions will automatically adjust themselves to accommodate most situations. For example, the illustration on the right shows what happens to a dimension if the gap between the two extension lines is too small for the dimension text.

**The Continue Dimension Command**

_Toolbar_  
Pull-down  Dimension ➤ Continue

Keyboard  DIMCONTINUE

You can use the Continue command to add a string of dimensions. In the illustration above the "36mm" dimension has been continued from the "64mm" dimension.

**Command Sequence**

Command: DIMCONTINUE

Specify a second extension line origin or (Undo/<Select>): (pick P3)
Specify a second extension line origin or (Undo/<Select>): (pick another or to end)

**Note:** There is no prompt for the first line origin, AutoCAD automatically selects the second line origin of the previous dimension to be the first of the new dimension. There is also no prompt for the dimension line position, AutoCAD automatically matches up with the previous dimension.
Using the Continue command you can very quickly generate a string of dimensions which align perfectly. In the example above, the "34.41" dimension was drawn with the DIMALIGNED command; all the other dimensions were drawn using the DIMALIGNED command and simply picking the four points, one after the other. You can only continue a dimension in a single direction. To generate the "26mm" dimension in the previous illustration, you will need to use the DIMALIGNED command and pick P3 and P4 or enter ← at the first prompt and pick the line.

The Baseline Dimension Command

You can use this command to generate a series of dimensions from a single base point. You must already have created the first dimension in the sequence using a command such as DIMALIGNED. The DIMALIGNED command then creates further dimensions in a similar way to the DIMALIGNED command. All the user has to do is pick points.

Command Sequence

Command: DIMALIGNED
Specify a second extension line origin or (Undo/<Select>): (pick next point)
Specify a second extension line origin or (Undo/<Select>): (pick another or ← to end)
Select base dimension: (← again to end)

In the example above, the "35.07" dimension was created using the DIMALIGNED command. The others were created using DIMALIGNED and picking points 1 and 2.

The Aligned Dimension Command

You can use this command to generate a series of dimensions from a single base point. You must already have created the first dimension in the sequence using a command such as DIMALIGNED. The DIMALIGNED command then creates further dimensions in a similar way to the DIMALIGNED command. All the user has to do is pick points.

Command Sequence

Command: DIMALIGNED
Specify a second extension line origin or (Undo/<Select>): (pick next point)
Specify a second extension line origin or (Undo/<Select>): (pick another or ← to end)
Select base dimension: (← again to end)
You can use this command to generate aligned dimensions. These are dimensions along inclined lines which cannot be dimensioned with the DIMLINEAR dimension command because that command will only give a measured dimension in either a horizontal or vertical direction. However, as you can see from the command sequence below, this command works in exactly the same way.

Command Sequence

Command: **DIMALIGNED**
First extension line origin or press ENTER to select: (pick P1)
Second extension line origin: (pick P2)
Dimension line location (Mtext/Text/Angle): (pick a point)

The DIMCONTINUE and DIMBASELINE commands can both be used in conjunction with DIMALIGNED dimensions.

Changing the Text

You may have noticed that when you are prompted to pick the dimension line location you are also offered a number of options. The options vary depending upon the particular command that you are using. However, the Mtext and Text options, which are common to all dimension commands are particularly useful. Essentially they do the same thing, they allow you to change the text which will appear on the dimension line. The Text option allows you to enter a single line of text and the Mtext option starts the MTEXT command and enables you to add formatted, multiline text to the dimension. These options can be used to add descriptions to your dimensions or to modify the measured distance.

![Diagonal line with dimension 55mm and labels P1 and P2]

Distance between gate posts = 1.6m

In the example above, the Mtext option has been used to create a multi-line annotation. When you use this option you will notice that the Multiline Text Editor dialogue already has some text in the text window. This is the measured dimension and is displayed as "<>". If you delete this marker the dimension measurement will not appear in the annotation.

If you need to edit dimension text after the dimension is drawn, you can use the DDEDIT command,

Modify/Object/Text... from the pull-down. If you select a dimension, the Multiline Text Editor will appear and you can make any necessary changes to the annotation. The illustration on the right shows an extract from the Multiline Text Editor as it would appear if the dimension above were selected.
The Radial Dimension Commands

There are two main radial dimension commands, DIMDIAMETER and DIMRADIUS. Both commands result in a similar looking dimension so AutoCAD automatically inserts a "R" to indicate a radius and the dimension symbol to indicate a dimension. You can get AutoCAD to display the dimension symbol by including "%%c" in any text string. For example, in order to draw the 40mm diameter text as it is shown in the illustration on the right, you would need to type "%%c40mm". You can use this special character with any of the text commands.

The Diameter and Radius commands are supplemented by the DIMCENTER command which can be used to add a center mark to any circle or arc. The DIMDIAMETER and DIMRADIUS commands do not automatically draw a center mark.

By convention it is usual to dimension full circles using a diameter and arcs (partial circles) using radius. You will find more information on dimensioning conventions in BS 308: Part 2.

The Diameter Dimension Command

You can use the Diameter command to annotate a circle or an arc with a diameter dimension. To achieve this simply start the command, pick a point on the circumference of the circle, pick a second point to determine the length of the leader and then add the dimension text or Return to accept the default.

Command Sequence
Command: DIMDIAMETER
Select arc or circle: (pick the circumference P1)
Dimension line location (Mtext/Text/Angle): (move the cursor until you are happy with the text position and then pick to complete the sequence)

The Radius Dimension Command

You can use the Radius command to annotate a circle or an arc with a radius dimension. To achieve this simply start the command, pick a point on the circumference of the circle, pick a second point to determine the length of the leader and then add the dimension text or Return to accept the default.

Command Sequence
Command: DIMRADIUS
Select arc or circle: (pick the circumference P1)
Dimension line location (Mtext/Text/Angle): (move the cursor until you are happy with the text position and then pick to complete the sequence)
The Radius command is identical to the Diameter command except that the dimension measurement is a radius rather than a dimension and the resulting dimension text is prefixed with a "R" to indicate radius.

**Command Sequence**

**Command:** DIMRADIUS

**Select arc or circle:** (pick the circumference P2)

**Dimension line location (Mtext/Text/Angle):** (move the cursor until you are happy with the text position and then pick to complete the sequence)

Notice that in the illustration above the radius dimension has been positioned inside the circle. Both diameter and radius dimensions can be positioned either inside or outside an arc or circle.

Practice with the Radial and Diameter commands until you understand how they work.

**The Center Mark Command**

**Toolbar**

**Pull-down** Dimension ➤ Center Mark

**Keyboard** DIMCENTER

You can use the Center Mark command to annotate a circle or an arc with a cross at the center. The illustration above shows a center mark added to a circle after a diameter has been drawn.

**Command Sequence**

**Command:** DIMCENTER

**Select arc or circle:** (Pick the circumference of a circle or arc)

A cross is drawn at the center point.

**Angular Dimensions**

There is only one command in this section and it is used to annotate angular measurements.

**The Angular Dimension Command**

**Toolbar**

**Pull-down** Dimension ➤ Angular

**Keyboard** DIMANGULAR

The Angular command is amazingly flexible and can be used to indicate an angle in almost any situation. Just like the other dimension commands, all parts of the process are rubber banded so you can see the results of your actions before you make the final pick.

**Command Sequence**
Command: **DIMANGULAR**

Select arc, circle, line, or press ENTER: *(pick a line)*
Second line: *(pick another line)*
Dimension arc line location (Mtext/Text/Angle): *(pick point)*

Move the cursor position until you are happy with the result. Notice that you can move the cursor to either side of the lines and the angular dimension will change accordingly.

You may have noticed that at the first prompt you are given the option to press ENTER. If you use this option you will be prompted to pick the angle vertex and then the two angle endpoints. This is quite useful if the angle you need to dimension is not defined by physical lines on the drawing. The illustration on the right shows the result of this option. The centre point of circle 1 was picked as the angle vertex and the centre points of circles 2 and 3 were picked for the two angle endpoints.

The degree character is automatically inserted for you, however, if you ever need to type it, you can do so by typing "%%d". This is another of AutoCADs special characters.

**Ordinate Dimensions**

Ordinate dimensions are not really dimensions at all in that they do not indicate a measurement. Rather they annotate known co-ordinate points. The DIMORDINATE command is used to indicate the X and Y ordinate values at any point.

**The Ordinate Dimension Command**

**Toolbar**

**Pull-down**  Dimension ➤ Ordinate

**Keyboard**  DIMORDINATE

The Ordinate command is used to annotate co-ordinate points with X or Y values. This may be useful for setting-out on site plans.

**Command Sequence**

Command: **DIMORDINATE**

Select feature: *(pick the point to annotate)*
Leader endpoint (Xdatum/Ydatum/Mtext/Text): *(pick endpoint or use one of the options)*

By default a vertical leader will display the X ordinate and a horizontal one will display the Y ordinate. However, you can use the Xdatum and Ydatum options to override this default.
In the illustration above, the building corner on the left has been annotated with X and Y ordinates using the default method. The one on the right has a Y ordinate which has been forced to display in a vertical position using the Ydatum option. You could also use the Text or Mtext options to clearly describe the point you are annotating.

### Annotation with Leaders

Ordinate dimensions are not really dimensions at all in that they do not indicate a measurement. Rather they annotate known co-ordinate points. The DIMORDINATE command is used to indicate the X and Y ordinate values at any point.

### The Leader Command

The Leader command can be used to annotate any point on a drawing. The command sequence below was used to draw the leader shown in the illustration above.

#### Command Sequence

Command: **LEADER**

From point: (pick the point to annotate)

To point: (pick vertex point)

To point (Format/Annotation/Undo)<Annotation>: (pick end point)

Annotation (or press ENTER for options): Corner of

MText: building

MText: (to end)

Unlike other dimension commands the leader and annotation text are drawn as separate objects. So, if you need to move or edit the text, you can do so without affecting the leader line.

As you can see by the command line, there are a number of options with this command including "Format" options which include "Spline". Experiment with these options until you understand them.

### Editing Dimensions
The dimension edit commands, DIMEDIT and DMTEDIT are used primarily to adjust the position of the text part of a dimension. This is usually only necessary if the drawing is quite complex and the dimension would read more clearly if it were in a different position.

The Dimension Text Edit Command

The Dimension Text Edit command is used to modify the text position of any single dimension. The command can be used to position the text dynamically (this is the default) or one of the options can be used for a specific type of movement. For example, the dimension shown on the right has been modified by dynamically moving the position of the text and then the text has been rotated using the Angle option.

Command Sequence

Command: DMTEDIT
Select dimension: (pick the dimension you want to edit)
Enter text location (Left/Right/Home/Angle): (pick a new position or use an option)

The results of the four available options are shown in the illustration below.

The **Left** option moves the text to a left justified position within the dimension.

The **Right** option moves the text to a right justified position within the dimension.

The **Home** option returns the text to the home position after it has been modified.

The **Angle** option enables the text to be rotated about its center.

The Dimension Edit Command

The Dimension Edit command can be used to modify and change the text of any number of dimensions. The
Command could, for example, be used to add a standard prefix or suffix to a number of dimensions.

Command Sequence

Command: **DIMEDIT**

Dimension Edit (Home/New/Rotate/Oblique) <Home>: (choose an option)

Select objects: (pick one or more dimensions)

Select objects: (pick more or End)

The command sequence will vary depending upon which option has been chosen but the results of the various options are illustrated below.

The **Home** option returns dimensions to their home position.

The **New** option displays the Multiline Text Editor. The changes you make to the text will be applied to all selected dimensions so it is important not to delete the "<>" marker from the text string. Deleting this marker will remove the values from all selected dimensions.

The **Rotate** option can be used to rotate dimension text about its center point. It works in exactly the same way as the Angle option of the DIMTEDIT command except that you can rotate any number of dimensions at once.

The **Oblique** option is used to set the dimension lines at an angle. This option can be very useful when you are dimensioning a drawing in *isometric projection* (see the illustration on the right). In this case the drawing has been dimensioned using the Aligned command and then the oblique angle modified to suit the dimension position. This usually means setting an angle of 30, 330 or 90 degrees depending upon the dimension orientation. If you are creating details in isometric projection make sure you are using the isometric snap/grid option for greater efficiency. For more information on drawing in isometric projection and the use of the isometric snap grid, see the "Drawing Aids" tutorial.

**Dimension Styles**

Dimension styles are the main method used to control the way dimensions look. Using styles you can change the text font, the arrow head style, the relative position of the text, the scale of dimensions and many other parameters. Styles are created using the DIMSTYLE command.
Dimension styling is a relatively complex area of AutoCAD and the finer points are beyond the scope of this tutorial. However, the main points which will enable you to create clear, good looking styles are set out below.

**The Dimension Style Command**

**Toolbar**

**Pull-down**  Dimension ► Style...

**Keyboard**  DDIM  short-cut  D

Dimension styles are created using the Dimension Styles dialogue box. The dialogue box is shown on the right. As you can see from the dialogue box, a style is applied to a family of dimensions. By default, any style changes are made to the parent. Each style parent has six child styles. The child styles, Linear, Radial, Angular, Diameter, Ordinate and Leader can be used to modify the parent style when that particular type of dimension is used. For example, you may like to use a tick rather than an arrow head for your dimensions but this isn't really appropriate for a leader, so the Leader child style can be changed so that leaders will always be drawn with an arrow head whilst all other dimensions of the same style family are drawn using ticks.

**Creating a new style**

To create a new dimension style, make sure the STANDARD style is the current style, click in the Name edit box and type the name of the new style you wish to create. Click the Save button. You will see a message in
the lower left corner of the dialogue box which says "Created name from STANDARD" where name is the new style name which you typed. The new style is automatically set as the current style. You may rename the new style if you wish, simply by typing a new name in the Name edit box and clicking on the Rename button.

The new style which you have created is identical to the STANDARD style, so you must now modify your new style so that it can be used to create dimensions which conform to your own requirements. Style changes are made in three categories, Geometry, Format and Annotation. As you can see from the Dimension Styles dialogue box, each category is represented by a button which leads to a dialogue box which is used to modify the settings in that particular category.

Setting the Arrow Head Type

The style of arrow heads is set using the Geometry dialogue box, illustrated above. As you can see, the STANDARD style has Closed Filled arrow heads as a default. To change the arrow head style for a new dimension style, make sure the style is current and that the "Parent" radio button is selected (this assumes you are not modifying a child style), click on the "Geometry…” button and select a new arrow head type from the "1st" drop-down list.

Once selected the new arrow type is illustrated in the dialogue box. If you require different arrow heads at each end of your dimensions you can set the other type using the "2nd" drop-down list. Click on "OK" to return to the Dimension Styles dialogue box.
Dimension Scale
When you are working with drawings which will be plotted at different scales, you will need some way of changing the scale of the dimension lines relative to your drawing so that they always appear the same size, irrespective of plotting scale. You can achieve this by using the Scale variable. This option is also available from the Geometry dialogue box. The default value is set to 1.0. The larger the value the larger the dimension will appear. For example, a value of 2.0 would double the text height and the arrow size. To change the scale of dimensions, simply type the required scale in the "Overall Scale" edit box. Try changing the scale factor and check the results. The scaling applies to individual styles, so you could create different styles with different dimension scales to be used for different plotting scales.

Note that changing the scale of dimensions does not affect the dimension value, this is always calculated in drawing units.

Setting the Text Location
To change the text location click on the "Format..." button in the Dimension Styles dialogue box. The Format dialogue box is shown below. By default the horizontal justification is set to "Centred" and the vertical justification to "Above". This means that the dimension text will appear centred above a horizontal dimension line and centred left of a vertical dimension line. To have the text centred within the dimension line, click on the down arrow of the "Vertical Justification" pull-down list to reveal the options and click on "Centered". The illustration changes to reflect your choice. Click on "OK" to return to the Dimension Styles dialogue box. You can see the result of this action by looking at the illustration below. Experiment with the Horizontal Justification and Vertical Justification options to see what results they give.

You can also use Text the option in this dialogue box to change the text orientation in aligned dimensions. By default all dimension text is aligned with the dimension. This option allows you to force text to appear horizontal, irrespective of the orientation of the dimension. You have independent control over dimension text which appears inside and outside of the dimension lines.

The illustration on the left shows a dimension with vertical justification set to "Above" (far left) and to
Setting Text Style and Units

Text style and units are both set using the Annotation dialogue box, illustrated below. To set a text style to a dimension you must first have created the style using the Text Style command (Format ▶ Text Style… from the pull-down menu). To assign the text style to a dimension style, click on the "Annotation…" button in the Dimension Styles dialogue box, click on the drop-down list in the "Text" area of the Annotation dialogue and select the required text style from the list. Click on "OK" to return to the Dimension Styles dialogue.

AutoCAD gives you the option to automatically include a unit prefix or suffix with the dimension text. For example, you could set the dimension style in such a way that it created dimensions with "m" to indicate metres after each dimension text. Most usually, dimensions are drawn without units displayed but with a note on the drawing indicating the units used, such as "All dimensions in metres". However, you may have a drawing where different units are being used for different elements of the drawing. In such a case it is a good idea to include units to avoid confusion. Remember that the main idea behind dimensioning is to give the maximum amount of information in the clearest and most concise way. To add units to a dimension style, click on the "Annotation…" button in the Dimension Styles dialogue box and enter the required unit character(s) in the "Prefix" and/or "Suffix" edit boxes of the "Primary Units" area of the dialogue box. For example, if you wanted to display metres, you would type "m" in the "Suffix" edit box.

The Dimension Update Command

Toolbar Dimension ▶ Update
Pull-down Dimension ▶ Update
Keyboard DIM UPDATE
The Dimension Update command is used to apply the current dimension style to existing dimensions. You can use this command to change the style of a dimension. Unlike text styles, dimension styles do not automatically update when the style is changed. The UPDATE command must be used to force dimensions to appear in the current text style.

Command Sequence

Command: DIM

Dim: UPDATE

Select objects: (pick dimension to update)

Select objects: (pick more dimensions or ← to end)

Dim: (press the escape key, Esc to return to the command prompt)

Tips & Tricks

- Always attempt to use the least number of dimensions in order to provide the maximum amount of information.

- Avoid giving duplicate information. For example, if you use a number of running dimensions along the length of an object, it is not necessary to include an additional dimension for the whole length. In the illustration on the right the "50" dimension is unnecessary because it gives no extra information and simply duplicates that which can be inferred from the "20" and "30" dimensions. This will also avoid any ambiguity which may arise from inaccurate dimensioning.

- Sometimes it may be more appropriate to add notes to your drawing which include dimension information rather than attempt to dimension small or complex items.

- If you do not include any units information with your dimensions you must always add a note to your drawing such as "All dimensions are in millimetres" to make it absolutely clear.
The UCS Icon

by David Watson

Appearance

The UCS icon appears in many different forms, only a few of which are shown below. You may notice, looking at the icons below, that they are all subtly different. Understanding the meaning of these subtle differences can help you to orientate yourself with respect to the current co-ordinate system and in particular, to know where the co-ordinate system origin is located. The captions below each icon describe what it means.

<table>
<thead>
<tr>
<th>Icon Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>World Co-ordinate System</td>
</tr>
<tr>
<td>Set to Origin</td>
</tr>
<tr>
<td>Origin is off screen</td>
</tr>
<tr>
<td>World Co-ordinate System</td>
</tr>
<tr>
<td>Set to Origin</td>
</tr>
<tr>
<td>Icon displayed at origin</td>
</tr>
<tr>
<td>World Co-ordinate System</td>
</tr>
<tr>
<td>Set to No Origin</td>
</tr>
<tr>
<td>Origin is on or off screen</td>
</tr>
</tbody>
</table>

User Co-ordinate System

Set to Origin

Origin is off screen

Icon displayed at origin

User Co-ordinate System

Set to No Origin

Origin is on or off screen

Probably the most important visual clue is the box that appears at the intersection of the axes. When you see the box, you know that you are working in the World Co-ordinate System (WCS). If you do not see the box, you are working in a User Co-ordinate System (UCS).

You may also sometimes see the icon shown on the right. This is the traditional or 2D UCS icon and was used by versions of AutoCAD prior to 2000i. However, you can still use the old style UCS icons if you prefer (AutoCAD always likes to be backwards compatible). You can also change various other parameters that affect the appearance of the UCS Icon using the commands discussed below.

UCS Icon Properties
The UCS Icon properties dialogue box can be used to change the appearance of the UCS Icon. The dialogue box is illustrated below and is shown with all values and parameters set to default.

You can choose from 3 different style options, 2D, 3D with cone pointers and 3D without cone pointers. The default is 3D with cone pointers. You can also change the line width. By default, the UCS Icon is displayed using a line width of 1 pixel. Using the drop-down list, you can choose to beef it up a little by selecting a line width of 2 or 3 pixels. The size of the UCS Icon can also be varied. The default size is 15 but you can change the size in a range from 5 up to 95. The values refer to a percentage of your screen height. If you need to, you can also control the colour of the UCS Icon. You can use any of the 255 standard AutoCAD colours. Notice that you can control the colour of both Model Space and Layout UCS Icons separately.

**UCS Icon Settings**

- **Toolbar**: none
- **Pull-down**: View ➤ Display ➤ UCS Icon ➤ Properties...
- **Keyboard**: UCSICON and P for Properties

If you want control over whether the UCS Icon is displayed or not (yes, you can turn it off), you will need to use another dialogue box or pull-down menu option. (AutoCAD is often useful but rarely rational!). The UCS Settings tab of the UCS dialogue box can be used to control the visibility of the UCS Icon, whether the icon will appear at the coordinate system origin and you can also change these settings for all viewports (assuming...
you have more than one), or for just the current active viewport.

The UCS dialogue box is illustrated above. As you can see, the options are fairly simple and self-explanatory. The settings shown above are the default settings. So, by default, the UCS Icon is On (visible) and it is set to Origin meaning that if the origin of the current coordinate system is within the current drawing area and not too close to the edge, the icon will be displayed at the origin point rather than in the lower left corner of the screen. If Origin is turned off (No Origin), the UCS Icon will always be displayed at the lower left position irrespective of the location of the origin point. The All option, to control all viewports simultaneously is turned off by default.

You can also control the On/Off and Origin/No Origin settings from the pull-down menu at View → Display → UCS Icon → On and View → Display → UCS Icon → Origin respectively. Notice that these settings are changed when the menu item is clicked. The setting is on when you see the tick against the menu item and off if you see no tick. See the illustration on the right.

The UCSICON Command

Toolbar none
Pull-down none
Keyboard UCSICON

Finally, for completeness and backwards compatibility, we must mention the UCSICON command. Largely superceded by the commands we have already covered, the UCSICON command can be used to change all the properties and settings described above. This command is one of the old style command line commands but it has been updated to include all the new options. Entering UCSICON at the command line will give the
following response:

Enter an option [ON/OFF/All/Noorigin/ORigin/Properties] <ON>:

Simply enter the upper case portion of the option you require. The P for properties option will take you to the UCS Icon properties dialogue box described above.
Scaling Images

by David Watsor

Introduction

From time to time, you may need to use a raster image to trace off information. For example, you may want to use a map base to draw the line of a road or to draw some contours. In the past, this would have been done using a digitising tablet and although AutoCAD still supports the use of tablets, the new image support options have, in many respects, made them redundant.

However, the only way to create an accurate drawing from a raster image is to accurately scale the it. AutoCAD can help to scale some images if the file format contains information about the image resolution. This is more likely to be a special case rather than a general rule. The technique described below can be used to scale any raster image in such a way that units on the scanned map or plan correspond to AutoCAD drawing units. It works even if you do not know the image resolution. The only piece of information that you need is a known length that is easily identifiable on the plan. The length of a wall, the width of a road or the distance between grid lines can all be used to scale a raster image providing you can accurately pick each end of the measured length.

If you have little or no experience of working with images in AutoCAD and you would like to learn more, it is recommended that you work through the All About Images tutorial and then have a go at the corresponding Using Images exercise.

If you have experience of working with images in AutoCAD but you need a reminder of some of the finer points, you can use the QuickFind toolbar (above) at any time to get information about a particular command.
Step 1 - Sample Data

- Download sample data

If you would like to follow this exercise step by step, you may like to download the map image, shown on the right. To download the file, right-click on the document icon below and select "Save Target As..." from the menu ("Save Link As..." in Netscape Navigator). Save the file in your working folder.

Map Image.jpg (177KB) - JPEG File

The sample image is a 3km X 3km extract from an Ordnance Survey 1:50,000 scale map. The physical size of the image is 600 X 600 pixels. Using this information, you could easily work out the scale factor to display the raster map with drawing units set to metres. AutoCAD always inserts images in such a way that their width is one drawing unit in length when the scale is set to 1. We could, therefore, work out that in order to correctly scale this sample image in metres, all we need to do is set the scale factor to 3000, the width of the image being 3000 metres. However, this is a special case and you may not always know the true width of an image.

Step 2 - Attaching the Image

- Start a New Drawing
- Create a New Layer
- Attach Map Image.jpg

Start AutoCAD if you have not already done so and create a new drawing. Use the Layers command to create an new layer called "Map Image" and set it to be current.

Next, start the Attach Image command from the Reference toolbar. When the Select Image File dialogue box appears, navigate to your work folder and select the Map Image.jpg file.

The dialogue box should now look something like the one shown above. To complete the selection, click on
the "Open" button. When the Image dialogue box appears, deselect all options. The dialogue box should look like the one illustrated below.

Click the "OK" button to proceed. Since all options were deselected, the image is automatically inserted with default settings. The lower-left corner of the image is at the drawing origin (0,0) and the image width is one drawing unit.

Use the Zoom Extents command, View ▶ Zoom ▶ Extents from the pull-down menu or from the toolbar, so that the map image fills the drawing window.

**Step 3 - Scaling the Image**

- Scale the image using the Reference option

By default, the Scale command requires the user to enter a *scale factor* in order to accurately scale an object. For example, if you wanted to double the size of an object, you would enter a scale factor of 2. The scaling of raster images is rarely this straightforward. In order to determine the scale factor for any given image, you would need to know the current distance between two known points on the image (expressed in drawing units) and the actual distance between the same two points in the real world (expressed in your chosen unit, usually metres or millimetres). Given this information, the scale factor can be calculated by dividing the actual distance by the image distance. For example, we know that the width of the Map Image is one drawing unit (because the insert scale was set to 1). We also know that the actual width of the Map Image is 3km or 3000 metres. So, to scale the image correctly in metres, the scale factor would be 3000/1 = 3000.

This method works perfectly well for most situations. You could use the Distance command, from the toolbar or Tools ▶ Inquiry ▶ Distance from the pull-down menu to measure an image distance and then divide this into the known or "real world" distance to come up with a scale factor. However, there is an easier way that avoids the necessity for measurement.

The Scale command has an option that can be used
to scale an object simply by reference to two pick
points and a known true distance. It works in a similar way to the method described above except that
AutoCAD automatically measures the distance and calculates the scale factor for you. For this exercise, we
will use the two upper grid intersections as the pick points and the true distance between them (1000 metres).

Follow the sequence below to correctly scale the Map Image in metres.

Start the Scale command, **Modify ▶ Scale** from the pull-down or ▶ from the Modify toolbar.

Command: **SCALE**
Select objects: (pick the Map Image frame to select it)
Select objects: ➡
Specify base point: (pick any point or enter 0,0 if you want the lower left corner of the image to remain
at the drawing origin)
Specify scale factor or [Reference]: **R**
Specify reference length <1>: (zoom in ➥ and pick the point where the grid lines cross)
Specify second point: (zoom out ➥ and then zoom in ➥ on the second grid intersection and pick
the point)
Specify new length: **1000**

Obviously you cannot use the Object Snaps to accurately pick points on a raster image. The only way to
achieve a reasonable accuracy is to zoom in as far as possible and pick as precisely as you can. As you can
see from the illustrations above, this is not always easy, the closer you get to a raster image line, the wider it
becomes. This is not ideal but you should be able to achieve accuracy to within a fraction of one percent which
is acceptable for most purposes.

Finally, zoom extents ➥ to display the full image. The Map Image is now correctly scaled in metres. You can
always check this by using the Distance command ➥ to pick the same two points. You should see that the
distance is 1000 drawing units (or thereabouts, depending upon the accuracy of your pick). You can now
"trace" over the raster image using all of the usual AutoCAD commands such as Line and Polyline. Any vector drawing objects thus created will be correctly scaled in metres.

If you need more background information on the use of images with AutoCAD, see the tutorial All About Images and complete the exercise Using Images.
Introduction

AutoCAD is essentially a vector drawing application. However, there are occasions when it would be useful to display raster images as part of your drawing. It would also be useful if you could make basic modifications to images and to be able to scale them. Using such tools, you could use an image to trace some base information. For example, a raster map could be used to draw vector contour lines. You could also use raster images in place of vector symbols to add realism or personality to a drawing. Fortunately, such tools do exist within AutoCAD and although they don't approach the functionality of a dedicated raster image application such as Adobe Photoshop, they are adequate for most purposes.

This tutorial shows you how to use all of the tools on the Image section of the Reference toolbar, shown below. The tutorial will show you how to attach an image to an AutoCAD drawing and how to manipulate the image appearance. The tutorial also covers some of the extended image options included with Express Tools and how to control image objects with the Properties Window. If you would like to follow this tutorial closely, right-click the Tree Image on the right and download it to your work folder. When you have completed this tutorial, you may like to complete the Using Images exercise in order to get some practical experience. There is also a techniques tutorial, Scaling Images that demonstrates the best way to scale raster base information.

To display the Reference toolbar in AutoCAD, select View > Toolbars... from the pull-down menu, scroll down the "Toolbars" list and put a check in the box against "Reference".

You can follow the tutorial from start to finish in order to learn all about images and AutoCAD. However, if you just need information quickly, use the QuickFind toolbar, above to go straight to the command you want or select a topic from the contents list.

Images & AutoCAD

The important thing to remember about images and the thing that causes most confusion amongst novice users is that they are not actually inserted into a drawing as the "Insert" pull-down menu might suggest. Image files are attached to AutoCAD drawings. In other words, images do not become an integral part of a drawing. AutoCAD merely looks for images that have been attached and loads them as required. There are pros and cons to this method.

Pros

- AutoCAD drawing files remain relatively small.
Changes to images will be displayed each time a drawing is opened.

It is consistent with the Xref (External Reference) method.

Cons

- If AutoCAD cannot find the image file, the image cannot be displayed.
- More than one file is required to display the drawing correctly.

When you attach an image to an AutoCAD drawing, AutoCAD remembers where the image file is located, this is known as the path. Each time the drawing is opened, AutoCAD uses the path to find the image file and displays it. This works fine providing both the drawing file and the image file remain in the same place. However, if like me, you travel around and work on different computers, this can cause problems. My solution is very simple and consists of just two rules:

1. Always keep AutoCAD drawings and their attached image files in the same folder.
2. Always deselect the "Retain Path" option in the Image dialogue box.

If you follow these two rules, it doesn't matter where your work folder is, on your home PC, on your work PC, on a USB drive or on a CD, AutoCAD will always find the image file when the drawing is opened.

Attaching an Image

Before inserting an image, it is a good idea to create a new layer for your image. This way, you can easily control the display of the image by turning the layer off or on. Use the Layers command to create a new layer called "Tree Image" and set it to be current.

To begin, start the Attach Image command from either the Insert pull-down menu or the Reference toolbar. The Select Image File dialogue box appears. Use the dialogue box to locate the image you want to insert or the Tree Image if you have downloaded it.
When the file is selected, an image preview appears. To complete the selection, click on the "Open" button. The Image dialogue box displays and allows you to set various parameters that determine how the image will be attached. The Image dialogue box is shown below.

As you can see from the illustration above, the Image dialogue box has two main functions. Firstly it allows you to decide whether AutoCAD remembers the image path. See the Images & AutoCAD section above for a discussion on paths. Secondly it allows you to decide whether the position (insert point), scale and rotation of the image are specified on-screen or within the dialogue box. For most purposes, deselect the "Retain Path" checkbox. Other settings can be left to their default state. Your dialogue box should now look like the one shown above. Click the "OK" button to proceed.

Now look at the command prompt. AutoCAD will now ask you to specify the insertion point (the lower left-hand corner of the image) and the scale because these two parameters were set to "Specify on-screen" in the Image dialogue box. Follow the command sequence below to complete the command.

Specify insertion point <0,0>: (pick a point)

Pick a point in the drawing area to fix the lower-left hand corner of the image. You needn't be too precise at
this stage because you can always move the image later. However, you could always enter a co-ordinate value if you know exactly where the image should be placed.

Base image size: Width: 1.000000, Height: 0.967742, Unitless
Specify scale factor <1>: (scale dynamically)

To scale the image dynamically, simply move the mouse. You will see the image outline change size as the mouse moves. Pick a point when you are happy with the image size and the full image is displayed at the required size. If you want, you could enter a scale factor instead of scaling dynamically. The default scale factor is one. This means that the image will be inserted so that its width is one drawing unit. So, if you want the image to be five drawing units wide, you could set the scale factor to five.

The Image Manager

As the name suggests, the image manager is a general purpose utility for managing your raster images. Using the Image Manager, you can attach new images, detach existing images, unload and reload images, modify the image path and display image details such as pixel size, colour depth etc. The Image Manager is shown below.

The "Attach..." button enables you to attach images to the current drawing. It works in exactly the same way as the Image Attach command described above.

Sometimes you may want to remove an image from your drawing. You can, of course, simply erase an image but since you can have more than one instance of an image in your drawing, only that one instance would be erased and AutoCAD would still look for the image file when the drawing was opened. The only way to remove all instances of a particular image and to stop AutoCAD searching for the image is to detach it. To detach an image, highlight the image name in the list and click the "Detach" button. Beware of using the Detach button. Once an image has been detached, all position, scaling and clipping information will be lost.
If you just want to remove an image temporarily, it is far better to *unload* it. Unloading an image, removes the image from the drawing but AutoCAD remembers any position scaling and clipping information. When the image is *reloaded*, it will reappear just as it was before you unloaded it. To unload an image, highlight the image name and click on the "Unload" button. To reload an unloaded image, highlight the image name and click on the "Reload" button. When an image is unloaded, its boundary remains visible in the drawing. You can turn image frames off using the Image Frame command.

There are a number of reasons why you may want to unload an image. Firstly, images can take up quite a lot of computer memory and so your computer may work more quickly with images unloaded. Secondly, you may simply want to hide images so that the drawing looks clearer while you are working. Of course, you could also do this using layers if your images are on their own layer. See the Controlling Layer States section of the Object Properties tutorial for more information.

The "Details..." button displays a dialogue box showing all relevant information about a particular image. Notice that on the example below, the "Saved path" and the "Active path" details are different. This is because the "Retain Path" option was deselected when the image was attached. The saved path is where AutoCAD looks for the image file when the drawing is opened. In this case, it only looks in the folder where the drawing is saved. The active path is the actual location of the file on this computer. If I copied my working folder onto a Zip disk or to a different computer, the saved path would remain the same but the active path would change to reflect the actual location of the file. Click "OK" to clear the Image File Details dialogue box.
The "Image found at" area of the Image Manager allows you to change the active and saved paths of any attached image. You can change the image path either by clicking on the "Browse..." button and navigating your way to the image location or you can change the image path in the edit box. Changes made to the image path in this way will affect only the active path. If you want the changes to apply also to the saved path, you must click on the "Save Path" button.

**Clipping an Image**

**Toolbar**

Pull-down  Modify ▶ Clip ▶ Image  right-click  Image ▶ Clip

Keyboard  IMAGECLIP  short-cut  ICL

The Image Clip command enables you to *clip* or hide part of an image. There are two types of clipping, *Rectangular* and *Polygonal*. A rectangular clip allows you to hide that part of an image outside of a defined rectangle. A polygonal clip allows you to hide that part of an image outside of a defined polygon. See the images below to see the effect of the two clipping types. Only one clip is allowed per image. However, you can apply different clips to different instances of an image.

![Original Image](image1.png)  ![Rectangular Clip](image2.png)  ![Polygonal Clip](image3.png)

To clip the Tree Image, start the Image Clip command and follow the command sequence below.

**Command Sequence**
Command: IMAGECLIP
Select image to clip: (select the image by picking on its border)
Enter image clipping option [ON/OFF/Delete/New boundary] <New>: ← (default)
Enter clipping type [Polygonal/Rectangular] <Rectangular>: P (for Polygonal)
Specify first point: (pick a point)
Specify next point or [Undo]: (pick the next point)
Specify next point or [Close/Undo]: (continue to pick points to define area)
Specify next point or [Close/Undo]: ← (or C to close the polygon)

You can use "U" to undo any picked point, just as you can with the Polyline command. When the polygon is completed, any pixels outside of the polygon area are hidden.

You may have noticed that there are a number of options with the Image Clip command. We used the "New boundary" option to define a new clip boundary. The "Delete" option can be used to permanently remove a clip boundary. The "OFF" option can be used to turn off the effect of a clipping boundary while the "ON" option is used to turn it back on again.

Editing Image Clips with Grips
Rectangular and Polygonal clipping boundaries can be edited using grips. When a clipping boundary has been applied to an image, selecting the image causes grips to appear at the clipping boundary vertices as opposed to the actual image boundary. You can change the position of any of the clipping boundary grips within the image area. See the example below.

You can also use grips to resize or scale an image. However, you can only do this if no clipping boundary has been applied. If you want to scale an image that has a clipping boundary, you will have to use the Scale command.

Adjusting an Image
The Image Adjust command allows you to modify the brightness, contrast and fade of an image. The Brightness and Contrast controls work in exactly the same way as in any image editing application. The fade control is slightly curious. The fade control can be used to fade the image into the drawing window background colour. Fading the image on a black background causes the image to become darker while a white background will make it lighter. This function should not be confused with the sort of image opacity control that you have over image layers in Adobe Photoshop. You can demonstrate this by placing an image over a solid hatch and then fading it. The hatch does not show through the faded image. It's also worth bearing in mind that if you intend to print a faded image, the result will always be a lighter image since paper is white. You can check the effect by using Print Preview or work with a white window background.

The images below show the effects of various brightness, contrast and fade settings. You can use the "Reset" button to reset all image settings to their default values. The Image Adjust settings are remembered for all image instances when the image is unloaded. Reloading the image will display all image instances with their various settings intact.
Although the Image Adjust command can be used to make fairly basic changes to the displayed image, it does not have anywhere near the functionality of even a basic image editing application. It is always best to adjust the image correctly using Adobe Photoshop or a similar application before attaching it to your AutoCAD drawing. Actually, you can also make changes to the image after it has been attached. Simply open the attached image file in your favourite image editor, edit the image, save it and then in AutoCAD, use the Image Manager to reload it. The image display is updated to show your changes.

**Image Frame Visibility**

Although images look better when their frames are turned off, you cannot select an image in this state. Normally, you will work with image frames turned on (the default) and turn frames off at the end of the drawing process.

**Command Sequence**

Command: **IMAGEFRAME**
Enter image frame setting [ON/OFF] <ON>: **OFF**

Image frames are always displayed in the layer or object colour of the image. See Toggle Frames for a more convenient way of controlling image frame visibility.

**Image Quality**

The Image Quality command is used to control the display quality of images. There are two image quality
modes. High quality (the default), displays the image and antialiases pixels in order to give a smoother look to the image. Draft quality displays only the image pixels.

![High Quality](image1.png) ![Draft Quality](image2.png)

The effect of the two quality modes can be seen in the close-up of a scanned map image, above. Diagonal lines, in particular, look much better in High quality mode than in Draft quality mode.

**Command Sequence**

Command: **IMAGEQUALITY**

Enter image quality setting [High/Draft] <High>: D

High quality images take more memory to display and your computer may work faster if you have image quality set to Draft. You can always set the quality back to High at the end of the drawing process, when you are ready to plot. See True Colour Images for more information on image quality.

**Transparency**

- **Toolbar**: Image Transparency
- **Pull-down**: Modify ▶ Object ▶ Image ▶ Transparency
- **Keyboard**: TRANSPARENCY

The Image Transparency command can be used to make the background colour of a bitonal image transparent. The three illustrations below show the effect of changing the transparency of a bitonal image that has been placed over an orange background image. The image on the left shows the default image state. Transparency is off by default. The middle image has transparency turned on. Notice that the image frame is still visible. You can turn the image frame off to display just the foreground pixels (image on the right).
The foreground pixels of bitonal images are always displayed in the layer or object colour. The background pixels are displayed in the drawing window background colour. If you are using Adobe Photoshop to prepare your bitonal images, the image Mode should be set to "Bitmap" before it is saved. Unfortunately, AutoCAD does not support the GIF image file format and so it is not possible to display multicoloured images with a transparent colour.

The Properties Window
As you have seen, you can easily manipulate the various image properties with the specific commands described above. However, sometimes it may be simpler to use a single tool that allows you to modify image properties.

The Properties Window (new to AutoCAD 2000) allows you to do this from one location and displays the value of all image attributes at a glance.

The Properties Window is not like a normal dialogue box. It can remain on screen for as long as you like and will update to display the properties of the currently selected object. In fact, you can dock the Properties Window to either the left or right hand sides of your drawing window.
As you can see from the image on the right, you can also use the Properties Window to change the scale, position and rotation of the image. In the "General" section, you can change properties such as layer, colour and even add a hyperlink to an image.

Object properties can be displayed in either "Categorized" (see illustration) or "Alphabetic" order. You can change from one to the other by clicking on the appropriate tab. To modify any object property, simply click on the property name. You will then be able to change the property value either by typing it directly into the Properties Window or you will see a small button appear that will:

- let you choose a value from a drop-down list (Layer is a good example of this type)
- take you to a dialogue box (Brightness will take you to the Image Adjust dialogue box)
- allow you to pick a point from the drawing window (Position X, Y and Z)

The Properties Window does allow you to do one thing that no other command can do. It allows you to control the visibility of images. Since it is object specific, you can turn off just one instance of an attached image. When you do this, the image frame remains visible (providing frames are on) so you can still see the image position and scale. The only image property that you can't change via the Properties Window is the image path (these are greyed-out). You will need to use the Image Manager to do this.

**True Colour Images**

While you have been working with images, you may have noticed that they often don't look quite as good when displayed in AutoCAD as they did when viewed in other applications. The issue is most obvious where images have a gradation of similar tones. If you look at the two images below, you will see that the one on the left looks smooth and the one on the right looks speckled. The one on the left is the original image and the one on the right is the way it looks when displayed in AutoCAD.

The speckled effect is known as **dithering** and it happens when an application uses too few colours to accurately display an image. By default, AutoCAD uses a relatively small colour palette. This is because it is easier and quicker to display low colour images. True colour images, like the one above left take more memory to display and so the drawing process can become slow as AutoCAD struggles to display all the required colours (remember, AutoCAD was not originally designed to work with raster images). However, as always, there is a way to display true colour images in AutoCAD.

Pull-down  **Tools**  ▶️**Options**...
The Options command can be used to force AutoCAD to display all images in true colour. To do this, start the command and click on the "Display" tab of the Options dialogue box. The "Display Performance" area of the dialogue box (shown on the right) allows you to change a number of image related settings including the display of true colour images. Notice also that you can force AutoCAD to display images during dynamic pan and zoom operations. Normally AutoCAD shows only the image frame.

Although it is quite nice to work with true colour images, it is not essential. For the sake of speed it may be prudent to work with low colour images and then switch to true colour at the end of the drawing process before you plot.

The Express Image Tools

AutoCAD 2000 comes with a set of additional tools known as Express Tools. The Express Tools are an option when AutoCAD is installed. You can tell if they have been installed on your computer by looking at the pull-down menu bar. If they have been installed, you should see the "Express" pull-down located between "Modify" and "Window". Express Tools provide a range of very useful additional or hybrid commands that compliment the standard AutoCAD toolkit.

Note for users of AutoCAD 2000i and above

Starting with AutoCAD 2000i, The Express Tools are no longer provided free as an integral part of the AutoCAD installation. They have proved so useful that Autodesk has decided to sell them to users at an additional cost. Personally, I think AutoCAD is already expensive enough and the Express Tools should be part of the basic AutoCAD toolkit.

The commands we are going to cover here are most easily accessed from the Express Standard Toolbar. To display this toolbar you need to use the Toolbars dialogue box, shown on the right. View Toolbars…

Change the Menu Group to "EXPRESS" using the drop-down list and you will see a new range of toolbars appear in the “Toolbars” list. Check the box against "Express Standard Toolbar" and the toolbar will appear in the drawing window. Click the "Close" button to clear the Toolbars dialogue box.

If you have not seen the Express Tools before, it is
well worth loading them up and experimenting with them. Some of them are real time-savers. There are two that are particularly useful with respect to images and they are Toggle Frames and Super Hatch, described below.

## Toggle Frames

**Toolbar**

Express

**Pull-down**

Super Hatch

**Keyboard**

TFRAMES

The Toggle Frames command is a simplified version of the Image Frame command, covered above. Rather than prompting to turn frames either on or off and requiring some user input, it simply inverses the current state. If frames are on they will be turned off and vice versa. This avoids any necessity for using the keyboard. It certainly makes working with images a lot quicker.

## Super Hatch

**Toolbar**

Express

**Pull-down**

Super Hatch

**Keyboard**

SUPERHATCH

Super Hatch is a very powerful command that enables you to create hatch patterns from images, blocks, Xrefs and wipeouts. This command has many options that are well worth getting to know but for now we will just look at how to create a hatch pattern from an image.

You can create a hatch pattern from any image that AutoCAD can attach. However, if you want your hatch to look uniform, you will need to use an image that will tile seamlessly rather like the tiles that you use for your Windows wallpaper. If you would like to follow this tutorial, you can download the brick image on the right. Just right-click on the image and save it to your work folder. The image is called *tile.jpg* and is a true colour image, as are all JPEGs.

Before you start the Super Hatch command, draw a circle somewhere within the drawing window. You will use this circle as the hatch boundary. You can use almost any AutoCAD object to form hatch boundaries for Super Hatch. You cannot, however, use Splines although you can use splined polylines.

Start the Super Hatch command and you will be presented with a small dialogue box (shown on the left) that offers a number of options. For the moment, just click on the "Image..." button. We will consider some of the other options and settings later. You should now see the familiar Select Image File dialogue box. Find the tile.jpg file or any file of your choice and then click the "Open" button. When the Image dialogue box appears, make...
and then click the "OK" button.

AutoCAD then prompts from the command line:

Insertion point <0,0>: (pick a point)
Base image size: Width: 1.000000, Height: 1.000000, Millimetres
Specify scale factor <1>: (dynamically scale the image)
Is the placement of this IMAGE acceptable? [Yes/No] <Yes>: 
Selecting visible objects for boundary detection...Done.
Specify an option [Advanced options] <Internal point>: (pick a point within the circle)
Specify an option [Advanced options] <Internal point>: 
Preparing hatch objects for display...
Done.
Use TFRAMES to toggle object frames on and off.

You should now see your image tiled within the circle. Notice that since image frames are turned on, the hatch displays as a matrix of rectangular images. As AutoCAD helpfully suggests, use the Toggle Frames command to turn image frames off. The three illustrations above show the hatch as it first appears (left), with frames turned off (centre) and with the boundary object turned off and colour depth set to True Colour (right).

If you look closely at the images above, you may notice that the hatch does not follow the hatch boundary perfectly. This is particularly noticeable on curved boundaries because Super Hatch uses curve approximations that are composed of straight line segments. You can control how closely Super Hatch approximates curves by changing the "Curve error tolerance" value in the dialogue box. The smaller the value the more accurate the curve approximation.

Once you have created a hatch pattern using a particular image, you needn't go through the same process of attaching the image next time you want to create a similar hatch pattern in the same drawing. You can copy an existing hatch by using the "Select existing <" button. Make sure that frames are turned on before you use this option because otherwise you won't be able to select the hatch.

Now that you have completed the tutorial, why not try the associated exercise Using Images in order to practice your new skills. Also see Scaling Images to find out how to scale scanned base information.
Tips & Tricks

- Although AutoCAD supports the TIFF image file format, it rather annoyingly does not support TIFFs with LZW compression. If you cannot see the image preview of a TIFF file and it won't display in AutoCAD, the chances are that it has been saved with LZW compression. If this is the case, the only option is to open the image in a raster application such as Adobe Photoshop and save the image without compression.

- For general purpose work, the JPEG file format is probably the most convenient for working with AutoCAD. JPEG images display well in true colour and are relatively small (depending upon the level of compression).

- Try to keep image file sizes as small as possible. AutoCAD will work faster with small image files. When you scan your image, you will need to consider the level of detail required. Don't forget that for many file formats, the physical image size (measured in pixels) is directly related to file size. For example, a BMP image scanned at 300dpi will be 4 times larger than the same image scanned at 150dpi.

- Images do not display when a drawing is rendered.

- If you distribute your AutoCAD drawings by email or on disk, don't forget to send any attached image files along with the drawing file so that those viewing the drawing will also see the images.
Using Images

by David Watso

Introduction
This exercise is designed to demonstrate the use of many of the image commands described in the All about Images tutorial. If you have little or no experience of working with images in AutoCAD, it is recommended that you work through the tutorial before attempting the exercise set out below.

Use the QuickFind toolbar at any time to get more information about a particular command.

Step 1 - Sample Data
- Download sample data
- Start AutoCAD
- Display the Reference toolbar
- Open Image.dwg

Before you start this exercise, you need to download the sample image and drawing files. To download the files, right-click on the document icon and select "Save Target As..." from the menu ("Save Link As..." in Netscape Navigator). Save both files in your working folder.

.Tree Image.jpg (21KB) - JPEG File
.Image.dwg (37KB) - AutoCAD 2000 File

Before continuing with the exercise, start AutoCAD, if you have no already done so, display the Reference toolbar if it is not already on-screen and open the "Image" drawing file. The drawing file shows a garden lawn. During the course of this exercise, you will add some trees to the lawn area and cast some shadows using the Tree Image. Take a look at the final drawing to see where we are headed. You are now ready to proceed to the next step.

Step 2 - Attaching the Image
- Create a new Layer
- Attach Tree Image.jpg

Use the Layers command to create a new layer called "Tree Image" and set it to be current. This is just good drawing practice and means that the attached images will be on their own layer.
Next, start the Attach Image command from the Reference toolbar. When the Select Image File dialogue box appears, find your way to your work folder and select the *Tree Image.jpg* file.

The dialogue box should now look something like the one shown above. To complete the selection, click on the "Open" button. When the Image dialogue box appears, deselect the "Retain Path" option. The dialogue box should now look like the one illustrated below.

Click the "OK" button to proceed, look at the command prompt and follow the command sequence below.

*Specify insertion point* <0,0>: *(pick a point for the lower left-hand corner of the image)*

Pick a point in the drawing area to fix the lower-left hand corner of the image. You needn't be too precise at this stage because you can always move the image later.

*Base image size: Width: 1.000000, Height: 0.967742, Unitless*
Specify scale factor <1>: (scale so that the image is similar in size to the one illustrated)

Move the mouse to scale the image dynamically and pick a point when you are happy with the size.

If necessary, use the move command, Modify ▶ Move from the pull-down or from the Modify toolbar to move the image into position. Remember, an image is selected by picking on its frame.

Your drawing should now look something like the one on the right.

Step 3 - Clipping the Image

- Clip the image using the Polygonal option

Step 3 involves clipping the image in order to hide those parts of the image outside of the tree canopy. The illustration (above right) shows what your image should look like after you have clipped it. Start the Image Clip command from the Reference toolbar, and then follow the command sequence below.

Command Sequence

Command: IMAGECLIP
Select image to clip: (select the image by picking on its frame)
Enter image clipping option [ON/OFF/Delete/New boundary] <New>: (default)
Enter clipping type [Polygonal/Rectangular] <Rectangular>: P (for Polygonal)
Specify first point: (pick a point)
Specify next point or [Undo]: (pick the next point)
Specify next point or [Close/Undo]: (continue to pick points to define the tree canopy)

When you have traced around the tree canopy...

Specify next point or [Close/Undo]: (or C to close the polygon)

When you have completed clipping, your drawing should look something like the one on the right. Remember that if you are not entirely happy with the effect when the clipping is complete, you can always modify the clip frame using grips. Failing that, you can always delete the clipping frame using the
"Delete" option and create a new boundary from scratch.

**Step 4 - Copy and Scale the Image**

- Copy the clipped image
- Scale the new instance down slightly

Use the Copy command, **Modify ▶ Copy** from the pull-down menu or from the Modify toolbar to create a copy (a second instance) of the clipped tree image. Place the new image so that it is to the upper-right of the original.

Next, use the Scale command, **Modify ▶ Scale** from the pull-down or from the Modify toolbar to reduce the size of the second image.

Had the image not been clipped, you could have used grips to scale it dynamically. If you select a clipped image, the grips are used to define the clipping frame rather than the true image frame. However, this does not prevent you from using the right-click options. Both the Copy and the Scale operations could be completed by selecting the image first and then right-clicking. Both Copy and Scale are available from the right-click menu.

**Step 5 - Copy both Images**

- Copy the two images

The two images you have already created will be used to form the tree shadows on the final drawing. Step 5 involves copying these two images and placing them over the two originals but slightly to the lower right so that the new images form the tree canopies and the originals cast the "shadow". It is quite important to get this the right way round because new image objects will always hide older image objects when they overlap. Obviously you could remedy any problems with visual hierarchy by using the Display Order options, **Tools ▶ Display Order ▶ Options** from the pull-down menu but I have often found them to be unreliable and it is far better to get your object order right rather than have to rely on display order settings.

So, use the Copy command again to copy the two images as shown in the illustration on the right.

**Step 6 - Adjusting the Shadows**

- Reduce the shadow brightness to 35
Use the Image Adjust command to reduce the brightness of the two shadow images to 35 percent. To do this, start the Image Adjust command, from the reference toolbar, select the two shadow images, and then left.

When the Image Adjust dialogue box appears, click and drag the Brightness slider to the left until the value in the edit box reads "35". Alternatively, click in the edit box and enter the value directly.

Notice that, in the Image Adjust dialogue box, when two or more images are selected, the image name above the preview is replaced by "Multiple images". If you try using this command with different images, only the first selected image will display in the preview area.

Complete Step 6 by clicking the "OK" button. Your drawing should now look something like the illustration on the right.

**Step 7 - Turning off Frames**

- Turn off Image Frames

Finally, turn image frames off using the Image Frame command, from the Reference toolbar.

Your completed drawing should now look like the one in the illustration below.
Remember, you can also have your images display in True Colour. See the tutorial All About Images for details. Also see Scaling Images to find out how to scale scanned base information.
ISO Paper Sizes

by David Watsor

Introduction

There has always been some confusion over the size of standard ISO drawing sheets with AutoCAD. The stated sizes in the plot dialogue box are not the true ISO sizes, rather they relate to the plotted area on standard size cut sheets. Obviously it is not possible to print right to the edge of cut sheets, so the AutoCAD sizes quoted are always smaller than the true cut sheet size. See the "Paper Size" dialogue box on the right.

To some extent this issue has been physically resolved by the use of roll feed plotters. For example, a true A3 print can be made from an A1 roll. Despite this fact, AutoCAD still quotes the plotted area sizes in the plot dialogue box. If you look at the dialogue box above, you will see that it is possible to enter your own "USER" paper sizes which can be set as true ISO sizes. In this example the "USER" size has been set to A3. Use the sizes in the table below, which are the true ISO cut sheet sizes as a guide.

The ISO paper sizes are devised in such a way that each smaller size is exactly half the size of the previous one. For example, cutting an A3 sheet in half so that the cut is perpendicular to the longest side would result in two A4 sheets. See the illustration above.
Drawing ISO Sheets in AutoCAD

The simplest way to draw drawing sheet outlines is to use the Rectangle command, picking the lower left hand point and then entering a relative co-ordinate for the upper right.

For example

To draw an A3 sheet:

1. Start the Rectangle command, type RECTANG at the command prompt, pick "Rectangle" from the "Draw" pull-down or click on the button.

2. At the Chamfer/Elevation/Fillet/Thickness/Width/<First corner>: prompt, pick a point somewhere in the lower left of the drawing area.

3. At the Other corner: prompt, enter a relative co-ordinate using the appropriate drawing sheet dimensions, type \( @420,297 \) and right click or at the keyboard.

4. Your drawing sheet outline will now be drawn at the correct size. If you cannot see all of the rectangle, use Zoom Extents to view the whole thing. You can do this by typing Z \( \leftarrow \) E \( \leftarrow \) at the keyboard (Z is the keyboard shortcut for the Zoom command).

Drawing Scaled ISO Sheets

The drawing sheet sizes in the table above can easily be used to draw sheet outlines in Paper Space since plotting from Paper Space should always normally be at a scale of 1:1 and Paper Space drawing units should be equivalent to millimetres. However, drawing sheet outlines in Model Space is rather more complicated because you need to take into account both the intended plot scale and the drawing units (which may not be millimetres). Fortunately there is a straightforward formula which you can use to determine the actual size of your required sheet outline in drawing units.

**Drawing Units per metre \( \times \) Scale \( \times \) Sheet Size in metres**

For example

An A3 sheet at 1:200 and drawing units in millimeters can be calculated as follows:

\[
1000 \times 200 \times 0.420 = 84000 \\
1000 \times 200 \times 0.297 = 59400
\]

An A3 sheet at 1:500 and drawing units in metres can be calculated as follows:
1 x 500 x 0.420 = 210.0
1 x 500 x 0.297 = 148.5

Plotting from Model Space

The only other consideration you need to make when plotting in Model Space is the plotting scale. This will be different depending upon which drawing units you are using. Working in millimetres is straightforward because you can use the actual scale in the Plot dialogue box since plotted units are also in millimetres. For example, a drawing to be plotted at 1:500 with drawing units in millimetres will have a plot scale of 1=500. Working in metres is a little more complicated. You will need to divide the scale by 1000 to get the correct figure. For example, a drawing to be plotted at 1:500 with drawing units in metres will have a plot scale of 1=0.5 which is 1000 times smaller than the figure for millimetres because there are 1000 millimetres in a metre.

<table>
<thead>
<tr>
<th>Plot Scale</th>
<th>Plotted MM</th>
<th>Drawing Units</th>
</tr>
</thead>
<tbody>
<tr>
<td>1:20</td>
<td>1</td>
<td>= 0.02</td>
</tr>
<tr>
<td>1:50</td>
<td>1</td>
<td>= 0.05</td>
</tr>
<tr>
<td>1:200</td>
<td>1</td>
<td>= 0.2</td>
</tr>
<tr>
<td>1:500</td>
<td>1</td>
<td>= 0.5</td>
</tr>
<tr>
<td>1:1250</td>
<td>1</td>
<td>= 1.25</td>
</tr>
<tr>
<td>1:2500</td>
<td>1</td>
<td>= 2.5</td>
</tr>
</tbody>
</table>

The table above lists a number of common plot scales and their corresponding plot scale factors which should be used when plotting from Model Space and when drawing units are in metres.
Paper Space Exercise

by David Watso

Introduction

AutoCAD's paper space mode is a bit like having a page in a scrapbook onto which you can paste different views of your AutoCAD drawing. This whole page can then be plotted. This exercise is designed to help you create an A3 drawing sheet in Paper Space and to add floating viewports. The exercise also discusses some other Paper Space considerations such as plotting to scale from Paper Space and layer display in viewports.

Overview of Paper Space

To create the paper space page you must set the tilemode variable to 0, you can do this by double-clicking on "TILE" on the status bar at the bottom of the screen. Once you have done this you will notice that the UCS icon in the bottom left corner of your screen changes to a triangle. This is to let you know that you are now in paper space.

Once you are in paper space you can draw an A3 drawing sheet. You could start out simply by drawing the rectangular outline. Create a new layer called something like "SHEET" and then draw a rectangle 420 x 297 drawing units (this is the correct size of an A3 drawing sheet in millimetres). Centre the rectangle on your screen by using the Zoom Extents command.

You are now in a position to create one or more model space viewports. Using the MVIEW command, View ➤ Floating Viewports ➤ 1 Viewport from the pull-down menu, simply pick two corners of a rectangle to define your view area. These viewports can be moved, scaled, copied and stretched just like any AutoCAD entity.

Tip: The viewport border is drawn on the current layer. If you do not want the border to plot, you must create a new layer("VIEWPORTS" would be a good name) specially for the viewports which you can turn off prior to plotting.

Create more viewports as required. Once you are happy with the arrangement of viewports (remember you can overlap viewports) you can move to model space by using the MSPACE command, View ➤ Model Space (Floating) from the pull-down menu.

Once in model space you can work within each viewport as if it were the normal drawing area. You can move from one viewport to another simply by clicking on it. Only one viewport can be active at any one time. The current active viewport is shown with a thick white border. Any changes you make to the drawing in one viewport are simultaneously made in the other viewports.

If you need to make changes to the arrangement of your viewports or to make changes to the drawing sheet you have to move back to paper space using the PSPACE command, View ➤ Paper Space from the pull-down menu. Don't forget to move back to model space afterwards.

Creating a Drawing Sheet in Paper Space
Follow the command sequence below to create your own A3 drawing sheet in Paper Space and to add a number of Viewports to show off your drawing to best effect.

**Setting up the Drawing Sheet**

1. Open the 3D Tree drawing you created in the previous exercise or open any other 3D drawing you have to hand.

2. Move to paper space by double-clicking **TILE** on the status bar or using the Paper Space command, **View ▶ Paper Space**. Don't worry if the screen goes blank!

3. Create a new layer called "SHEET" and make it current.

4. Draw an A3 sheet outline in millimetres (420x297) using the RECTANG command. Pick the first point anywhere on screen and define the second point using the relative co-ordinate @420,297.

5. Zoom to drawing extents so that you can see your whole sheet. **View ▶ Zoom ▶ Extents or Z ← E ←** at the keyboard or **from** the toolbar.

6. Design your own personal title block. Include your name, the drawing name, scale and any other information you consider appropriate. Make sure you create new layers for text, lines etc.

**Creating the Viewports**

7. Create a new layer called "VIEWPORTS".

8. Make "VIEWPORTS" the current layer. Create your viewport(s). **View ▶ Floating Viewports ▶ 1 Viewport** and then pick the two opposite corners of your new viewport window. You will see your tree appear.

9. Arrange your viewports on the sheet. Viewports act just like normal drawing entities so you can move, erase, copy and stretch them.

10. Move to model space **View ▶ Model Space (Floating)**. Notice that the UCS icon appears in the viewports and that the last viewport you drew is bounded by a thicker line than the others. This viewport is the "active" viewport. To make any viewport the active viewport, just click on it.

11. Once a viewport is active you can change the view in exactly the same way as you can when you are in Tiled Model Space. You can use the ZOOM and DDVPOINT commands to modify the view within each viewport. Change the views in each viewport to show your tree off to its best advantage. See the illustration below.

12. Turn the "VIEWPORTS" layer off if you wish to remove the viewport borders and check that the layout looks good. Your drawing is complete and you are ready to plot.

**Plotting from Paper Space**

There are two things to bear in mind when plotting from Paper Space. First of all, since our drawing sheet has been drawn at full size and in millimetres the plot scale is always 1=1.

Secondly, if you are plotting 3D objects from Paper Space and you want hidden lines removed, don't bother
checking that option in the plot dialogue box, it won't work. You have to tell AutoCAD which viewports you want hidden lines removed from before you start plotting. You do this using the Hideplot option of the MVIEW command or by selecting View ▶ Floating Viewports ▶ Hideplot from the pull-down. You are prompted to select viewports so the viewport borders must be visible. If you want hidden lines removed turn Hideplot ON. This may seem a bit of a chore but it does allow you to plot some viewports with hidden lines removed and some without.

**Other Paper Space Considerations**

**Scale**

You may be wondering how it is possible to plot drawings at a particular scale in Paper Space if drawings are always plotted using a scale of 1=1. The answer is that the scale of a viewport is determined by its zoom factor. You can use the XP option of the ZOOM command to scale your viewports relative to Paper Space. For example, if you zoom a viewport using 1XP, the scale of the drawing in the viewport would be 1:1 when it was plotted. To calculate the XP factor required simply divide 1 by the scale required. For example to zoom to 1:200 the XP factor would be 1/200=0.005.

The XP zoom factor described above only holds true when the drawing units are millimetres. Most of the time landscape drawings are in metres so we need to add a correction to the calculation to take this into account. Since there are 1000 millimetres in a metre all we have to do is multiply the XP factor by 1000. So, to plot at a scale of 1:200 when the drawing units are metres the XP factor would be 1/200x1000=5.

**Layers**

It is possible to freeze layers in the current viewport but have them remain visible in all other viewports. Using the DDLMODES command or Format ▶ Layer… from the pull-down you can freeze any layer in the current viewport by clicking the icon in the dialogue box. See the section "Layers in Viewports" in the Object Properties tutorial for more information.

**The Finished Drawing**
There are three viewports in the above example, all showing different views of the same drawing. The middle viewport overlaps the other two and plotting of the viewport borders has been suppressed by turning off the layer on which they were created.
AutoCAD to Photoshop

by David Watso

Introduction

One of the most common questions I am asked is "How do you move AutoCAD drawings into Adobe Photoshop?". In fact, I have been asked it so frequently recently that I have created this tutorial, which I hope will form the definitive answer.

There are many reasons why you might want to move your AutoCAD drawings into Adobe Photoshop. You may have realised by now that although AutoCAD is great for creating accurate, clear and intelligent drawings it often is found wanting when it comes to presentation. Various add-on applications have been written to improve and extend the use of AutoCAD into the presentation arena. M-Color is a good example of such an application. However, I think most people would now accept that if you want ultimate control over presentation drawings, you have to move away from AutoCAD's vector DWG file format and use a raster (pixel) based application, of which, Adobe Photoshop is probably the best known example.

The two illustrations on the right demonstrate the problem. The outline image was drawn in AutoCAD using polylines. This sort of accurate drafting is very difficult to achieve in Photoshop but AutoCAD makes it easy. However, if we want to create any kind of illustrative material based upon the outline, like the example shown far right, we have to leave AutoCAD and move to Photoshop where we can make the most of the raster imaging tools. Neither one application could have successfully completed the job alone. It is true to say that AutoCAD and Photoshop make perfect partners in a workflow aimed at creating accurate presentation drawings. AutoCAD looks after the "accurate" and Photoshop deals with the "presentation". Have a look at the Architect web site for more examples of AutoCAD and Photoshop working hand-in-hand.

Overview

The truth of the matter is that there is not a single answer to the question of how to move from AutoCAD to Photoshop. It all depends upon the required resolution, the quality of image and whether you are exporting line drawings or rendered images. This tutorial explains a number of techniques which cover all of the above issues.
Whatever method you choose, the trip from AutoCAD to Photoshop involves the conversion of a Vector image (geometry) to a Raster image (pixels). Inevitably some compromises have to be made but it is now possible to create high resolution, high quality Photoshop images from AutoCAD drawings. As with all things in life, though, quality comes at a cost. The highest quality results are also the most complicated to achieve.

This tutorial covers 4 techniques for moving from AutoCAD to Photoshop. The techniques covered are not interchangeable since the outcome of each is different so you need to know what you want before you decide which is right for you. I suggest that you read through the whole tutorial to get a good feel for what's on offer. However, I set out some guidelines below to help in making the correct choice.

1. You just need low resolution images for inclusion on a web page or for small images in printed documents. Use the Quick and Simple method.

2. You need high resolution images of line work but you don't need control over line weights. Use the Export to EPS method.

3. You need high resolution and high quality images of line work and you need control over line weight. Use the Plot to EPS method and see the Matching Scales and Pixels tip.

4. You need high resolution rendered images or rendered images with additional channel information. Use the Render to File method and see the Using Channel Information tip.

The term "High Resolution" is used here to describe images with pixel dimensions larger than the display on your computer monitor and "Low Resolution" describes images with pixel dimensions smaller than the display on your monitor.

**Quick and Simple (Print Screen)**

The quickest and simplest way to move from AutoCAD to Photoshop is to use the Windows clip board. The Windows operating system allows you to take a "screen grab" (essentially, a snapshot of what you see on your monitor) and save that as an image to the clip board. This image can then be pasted into a new document in Photoshop.

To do this, all you need to do is make sure that your AutoCAD drawing is displayed on the screen as you would want to see it in Photoshop. Then press the Print Screen button on the keyboard. On a standard keyboard, this button is always located to the right of the F12 key. See the illustration on the right.

If you are using a recent version of Windows and the option is turned on, you will see a small message box telling you that the print screen operation has worked. If you are using an older version of Windows or if the Print Screen notification has been turned off, you will be given no indication that anything has happened at all.

Now, open Adobe Photoshop if it is not already open and create a new document, *File > New…* from the pull-down menu or Ctrl+N from the keyboard. When the New dialogue box appears, simply click the OK button, do
not change any of the settings. Photoshop is relatively smart and when you create a new document, it looks to see if there is an image on the clip board. If there is, Photoshop sets the Width and Height parameters to the pixel dimensions of the image on the clip board, assuming that you might want to paste this image.

Next, paste the clipboard image into the new document, **Edit > Paste** from the pull-down or **Ctrl+V** from the keyboard. You should now see your screen grab appear. Notice that as well as the AutoCAD drawing area, you also have the toolbars and command line. In fact, everything that was visible on screen when you pressed the Print Screen button is copied to the clip board. The illustration below shows a typical screen grab.

Once you have the image in Photoshop, you can use the crop tool to remove the borders, toolbars, command line etc. However, you may also notice that when you pressed the Print Screen key, the UCS icon and the cursor were both visible in the AutoCAD drawing area and consequently, they are also in the pasted image. Of course it may be possible to paint them out using the appropriate Photoshop tools but a better option is to remove them at source.

First of all, you can turn off the UCS icon before using Print Screen. See the Settings section of the UCS Icon tutorial to find out how to do this. Secondly, make sure that the cursor is moved out of the AutoCAD drawing area when you use Print Screen. Having taken these two simple steps, you will find that you can get a decent image of your AutoCAD drawing into Photoshop.
The illustration above shows the final image in Photoshop with the UCS icon and the cursor removed before using Print Screen. This image can now be manipulated in any way you want using any of the Photoshop tools and filters.

The illustration on the left shows the AutoCAD model on a photographic background, created using Photoshop layers. This is just one of the many things you can do with your AutoCAD drawing once you get it into Photoshop.

Remember that you are not tied to the standard background color (black) in AutoCAD. If you want an image on a white background or any other colour, simply change the AutoCAD background colour. To do this, select Tools > Options… from the AutoCAD pull-down menu and click the Display tab in the Options dialogue box. In the Window Elements section, you will see the Colors… button, this will take you to the Color Options dialogue box.

Set the Window Element to "Model tab background" and then select a colour from the Color drop-down list. The list only shows the AutoCAD standard colours but you can set the background to any
custom colour by selecting Windows… from the list and then using the standard Windows colour palette.

The Print Screen method is one that will work in any situation and with any type of AutoCAD drawing, whether it be line work, shaded solids or rendered. However, it has one major drawback. If you use Print Screen, you are fundamentally tied to the maximum resolution of your monitor. If you are working at say, 1280x1024, that's the largest image size (in pixels) that Print Screen can deliver and you always know that you will lose some of that to toolbars and the like. If you need a higher resolution image of your AutoCAD drawings, you will have to use a different method.

Encapsulated PostScript Files

Probably the best file format to use when moving line work from AutoCAD to Photoshop is the EPS (Encapsulated PostScript) file format. This is because EPS is actually a vector file format. The rasterisation takes place within Photoshop and you can control the size and resolution of the resulting image. AutoCAD offers two methods for creating EPS files from drawings. The simplest method involves using the Export command and that is the method we will cover next. The second method involves plotting to an EPS file using a dummy plotter configuration. Although this second method sounds a little complicated, it is well worth trying since it produces superlative results. We will cover that method later in this tutorial.

Exporting to EPS

This next method is only really suitable for line work. However, it is relatively quick and easy and it gives moderately good results as long as you don't need high resolution images with fine control over line weight.

First of all, arrange your AutoCAD drawing within the drawing area so that you can see everything you want to export. Exporting to EPS works like the Plot Display option so that if there are objects in your drawing that are off screen, they won't be exported. If you want to export the whole drawing, use the Zoom Extents command before you start.

Next, select File ▶ Export… from the pull-down menu. When the Export Data dialogue box appears, set the "Files of type" to "Encapsulated PS" using the drop-down list. Next, select a suitable location for the file you are about to create and give the file a name. Finally, click the Save button to create the EPS file.

When the exported file is opened in Photoshop, the result can be quite crude. The two images above show the comparison between the original AutoCAD image and the exported image in Photoshop. In some cases, you can improve upon this by using the PostScript Out Options dialogue box. This dialogue box allows you to set the notional paper size of the exported image and this will help to bring the raster line width down in relation to the overall size of the image. You can also play about with the scale settings but generally, it is very difficult to control the resulting line weights. Setting the line weights by layer has no effect when using Export, all lines end up with the default weight.

To access the PostScript Out Options dialogue box (which is extremely well hidden), select File ▶ Export… from the pull-
down menu, set the file type to "Encapsulated PS" and then click Tools at the top right of the Export Data dialogue box. Select Options… from the menu. If you are using AutoCAD 2000, the dialogue box is accessed using the Options… button. The resulting dialogue box is shown above. Notice that you can also set "What to plot" by changing the default (Display) to Extents, Limits, View or Window. This can be very handy if you just want to export a specific section of a drawing.

You may find that using the export to EPS option suits your purposes fine, despite the limitations. However, on many occasions, you will find that the results are simply not good enough or perhaps you want the resulting image to display the different line weights that you have set in AutoCAD. The best way to achieve superb and controllable results when converting from AutoCAD to Encapsulated PostScript is to use the plotting option.

**Plotting to EPS**

Plotting to EPS files is no more complicated than plotting to a physical plotter. In fact, there are actually fewer parameters to configure so in some senses it's easier. In order to plot to an EPS file, you must first set up a logical PostScript plotter, assuming that there isn't already one on your system. This is a relatively simple process. The Setting up a PostScript Plotter tutorial gives you a step-by-step guide. If you are not sure whether you have a PostScript plotter or not, see Checking your Plotter for details.

Once you have confirmed the existence of an EPS plotter on your system, select File → Plot… from the pull-down menu or from the Standard toolbar.

When the Plot dialogue box appears, click the Plot Device tab. The first thing you must do is set the plotter name to your PostScript plotter in the Plotter configuration section. Second, enter a file name and third, set the
location of the file in the Plot to file section. To change the file location, click ... and use the Browse for Folder dialogue to set the folder where you want the file saved.

Now, click the Plot Settings tab and make settings such as paper size, orientation and scale. Pay particular attention to the paper size setting because when you open the file in Photoshop, you will want to create a page of the same size. This will enable you to maintain the scale of the drawing when you print from Photoshop.

Don't forget to preview the plot before committing yourself. When you are happy with the plot preview, click Ok to write the EPS file.

The images above show the relationship between the original AutoCAD drawing and the rasterised EPS file in Photoshop. As you can see, the resulting line quality is at least as good, if not better than the original. In fact, with a bit of care and practice, you should be able to create high quality raster images from AutoCAD vector drawings. Once the images are in Photoshop, it is relatively easy, using Photoshop tools, to create nicely finished images. The image shown below is just one example of what's possible.

So, now that you know how to create high quality EPS files using a logical plotter, you need to know how to open those files in Photoshop so that you can start making beautiful images.

**Opening the EPS file in Photoshop**

The next most common question I am asked after "How do you move AutoCAD drawings into Adobe Photoshop?" is "How do you maintain the scale of a drawing when moving from AutoCAD to Photoshop?".
Actually, the answer is quite simple and Photoshop deals with it almost automatically.

In Photoshop, select **File ▶ Open** from the pull-down menu. Use the Open dialogue box to find the EPS file and click the Open button. You should now see the Rasterize Generic EPS Format dialogue box as shown on the right.

You must now change both the Width and Height parameters so that they show the paper dimensions. These should automatically match the paper size you set in AutoCAD. This information is stored in the EPS file, so that what you see in AutoCAD should be what you get in Photoshop. In the example shown here, you can see that the paper size is A4 in portrait format.

The next thing you need to consider is the resolution of the image. Curiously enough, the resolution does not affect the scale of your drawing but it will affect the quality of the final image. If your final artwork will be printed, you should set the image resolution to the same value as the print resolution of your printer. This will ensure maximum quality when the final print is made. Once you have set the Height, Width and Resolution parameters, click the OK button to start the rasterisation process. This normally takes just a few seconds but will vary depending upon the image dimensions, the resolution and the speed of your computer. Progress is shown on the status bar at the bottom of the screen. When rasterisation is complete, the image appears in a new window.

When the image appears, you will see that your AutoCAD lines are drawn on a floating layer (there is no background layer). You will also notice that the rasterised lines appear on a transparent background so you can see the grey and white checker pattern. This is very convenient because it means you can easily create a new layer, drag it below Layer 1 and fill it with whatever colour or effect you like.

Before we finish talking about opening EPS files in Photoshop, it's worth considering the options in the Rasterize Generic EPS Format dialogue box that we didn't cover earlier. If you look at the dialogue box again, you will see that there are 3 additional options; Mode, Anti-aliased and Constrain Proportions.

You can use the Mode option to control the colour mode of the incoming file. Although RGB Color is probably the best option for most circumstances, you can choose from a number of others. However, this isn't a critical decision because if need be, the colour mode can always be changed at any time after the image is created by selecting **Image ▶ Mode ▶ Option** from the pull-down menu.
Probably the most useful is the Anti-aliased option. EPS files are anti-aliased by default and this results in smooth-looking lines. However, sometimes it is useful to be able to turn this feature off. It is particularly useful if you want to use the rasterised lines to form the boundaries of selected areas using the Magic Wand tool. Lines created without anti-aliasing will facilitate accurate and discrete selections. The two images above show the difference between anti-aliased lines (on the left) and lines drawn without anti-aliasing (on the right). The images are magnified X2 to demonstrate the difference more clearly.

Finally, the Constrain Proportions option allows you to modify the aspect ratio of the new image. In other words, it removes the link between width and height. I would caution against this unless you have a specific reason. Changing the aspect ratio of the incoming image can affect the scale of the printed image.

**Render to File**

The EPS file format is great for transferring line images from AutoCAD to Photoshop but it isn't much use if you need to transfer a shaded or rendered image. For that, we must use a different approach.

As you have probably discovered, if you have used the AutoCAD renderer, the rendered image appears on the screen so that you can see the results. This option works fine if you intend to use Print Screen to transfer the image to Photoshop. However, this is only the default option and you can direct the rendered image to other destinations. If you look at the Render dialogue box, you will notice that there is a section called "Destination". By default, the destination is set to Viewport. This means that the rendered image will be displayed in the current viewport. If you click the down-arrow, you will see that there are two other destinations, "Render Window" and "File".

The Render Window option causes the rendered image to be displayed within a separate render window. The render window is useful for certain things; for example, you can print a rendered image directly from the render window and this is the only way that this can be done from within AutoCAD. You can also save rendered images to file but the range of options is very limited. In fact, you can only save BMP format files.

The File option is much the better option for creating high resolution rendered images because it offers a range of parameters that give a great deal of control over file format, colour depth and image size.

Rendering to file is no more difficult than rendering to viewport. Simply make all the usual settings in the Render dialogue box for the type of render you want and then set
the destination to "File". When you do this, you will notice that the More Options… button becomes active. Click on this button to display the File Output Configuration dialogue box, shown on the right.

Setting the raster file output parameters is a simple 3-step process, described below.

1. From the first drop-down list in the File Type section of the dialogue box, select your preferred raster file format. There are a number to choose from. If you are not sure which one is right for you, I suggest using TIFF (Transfer Image File Format) since this is probably the most widely compatible format.

2. Now, click on the next drop-down list under File Type and select a size for the rendered image. These sizes are expressed in pixels. Most of the preset sizes are relatively modest and if you want to create an image with large pixel dimensions that is capable of being printed in high quality (usually 300dpi), you will need to set the size to "User Defined" and then enter the required dimensions in the edit boxes labelled "X" and "Y".

3. Finally, select the required colour depth. For most purposes the "24 Bits" option will give you what you need. 24 bit colour depth, also known as "True Colour", uses 16 million colours to describe raster images and is widely compatible. The 32 Bits option does not add any more colour information but it can be used to store additional channel information. In fact, if you intend using your rendered images in Photoshop for photomontage purposes, using a 32 bit colour depth may well be advantageous. AutoCAD uses the additional information to store an alpha channel that can be used to define a selection in Photoshop. See the Tips & Tricks section to find out how this works.

Once you have set all the necessary parameters in the File Output Configuration dialogue box, click the OK button to return to the Render dialogue box. Provided you are happy with the other render settings, click on the Render button. Since you have specified the destination as "File", you now see the Rendering File dialogue box where you can specify the file name and location. When you click the Save button, the AutoCAD drawing will be rendered and written to the specified file. You will not see the rendered image appear in the viewport, so don't assume that something has gone wrong. In fact, this is a rather annoying feature since it means that there is no preview of the rendered image. I suggest that you keep the render destination set to Viewport so that you can preview the rendered image and then change to File when you are happy with what you see. That way, you know what you are going to get.

The final step in this process is a very simple one. Start Adobe Photoshop (or any other image editor) and open the file you just created, File ➤ Open… from the pull-down menu.
Be aware that there are a number of render types selectable from the Render dialogue box. The two images above illustrate the range of render effects available. The default render type gives an effect similar to Gourad shading and there are no materials, no lights and no shadows. The Photo Raytrace render type gives the best render quality that AutoCAD can muster and this includes materials (if assigned), lights (if existing) and shadows (if configured).

**Tips & Tricks 👁️**

**Matching Scales and Pixels**

There may be many occasions when you want to match the scale of an EPS file to an existing raster image. This is a very common requirement when dealing with maps. You may have drawn some information in AutoCAD and you then want to overlay it onto a raster plan or map base in Photoshop. The illustrations below show a typical example. The results of a topographical analysis created in AutoCAD are shown on the left and this data needs to be overlaid on an Ordnance Survey 1:50,000 raster map tile in Photoshop, shown on the right.
Initially, this seems rather a conundrum but in fact, all we need to know is the map scale and the resolution of the raster image. Since we know the map scale (in this case 1:50,000), all we need to find is the resolution of the raster map. Even this is relatively straight forward.

We know that the grid lines on the raster map are 1km apart. We also know that the grid lines on a printed 1:50,000 scale map are 2cm apart. All we need to know now is how many pixels there are between the grid lines on the raster image. This can be achieved using the Measure tool in Photoshop. If we measure the distance between grid lines, we find that there are 200 pixels per kilometer. This is consistent with the overall dimensions of Ordnance Survey raster maps. The 1:50,000 data set comes in 20km x 20km tiles and each tile measures 4,000 pixels x 4,000 pixels. A quick calculation confirms our measurement. Now that we know this, we can calculate the resolution. If there are 200 pixels per kilometer and each kilometer prints at 2cm, the resolution must be 100 pixels per centimeter. See the Ordnance Survey web site for more information on the 1:50,000 raster map series.

So, we must now print the AutoCAD drawing to an EPS file at a scale of 1:50,000 and then open the resulting file in Photoshop at a resolution of 100 pixels/cm.

In AutoCAD, plot the drawing to EPS, setting the scale to 1:50,000 or 1mm = 50000 drawing units (assuming that your drawing units are in millimeters). In most cases the drawing unit used for mapping data is the meter. If this is the case, your scale should be set to 1000mm = 50000 drawing units. Select an appropriate paper size and make sure that you preview the plot to ensure you get what you expect when you open the EPS file.

Of course, all of the above assumes that you will be plotting from Model Space, which is probably the simplest thing to do but you can plot from a Paper Space layout if you want to. In this case, you will need to scale the view in the viewport rather than the plot.

In Photoshop, open the EPS file you just created. File Open... from the pull-down menu. Select the EPS file and when you see the Rasterize Generic EPS Format dialogue box, ensure that the Width and Height are expressed in centimeters and that the Resolution is expressed in pixels/cm. Once you have done this, you can set the resolution value to 100. The dialogue should now look like the one shown on the above. Click the OK button to rasterise the file. This may take a couple of minutes if the required pixel dimensions are large.
Once you have both the map base image and the imported EPS image in Photoshop, you can use the layers palette to drag the EPS layer and drop it over the map base. Make sure that the colour mode of the two images is the same otherwise nothing will happen. Ordnance Survey raster maps tend to be saved in Index Colour so you may have to change the mode to RGB Colour. You should find that the image created from you AutoCAD drawing corresponds exactly to the scale of the underlying image. All you need to do now is position the image accurately over the map base to create a perfect match.

One final tip worth mentioning at this stage is that if you have mapping information that you want to combine with an underlying map, consider setting the layer blending mode to "Multiply". The illustrations above show the effect of the layer blending mode set to "Normal" (the default) on the left and set to "Multiply" on the right. Notice that although the colour remains strong, you can see the underlying detail. This gives a much better effect than simply reducing the opacity of the layer.

To set the blending mode of a layer, click on the layer name in the Layers palette to make that layer current. Then, click the down arrow at the top left of the Layers palette and choose from the list of blending modes. As you will see, there are lots of them. If you haven't come across the layer blending mode options before, try them out and see the various effects you can create.

**Using Channel Information (32 bit colour)**
You may have noticed that when you set the colour depth for a render to file, some of the file formats offer a 32 bit colour option. You may well wonder what the point of this is when a 24 bit colour depth will give a "True Colour" result. The truth is that the extra data space assigned to each pixel in a 32 bit image is not used to store extra colour information but it can be used for other things.

When AutoCAD renders at 32 bit colour, it uses the extra data to save "channel" information. This channel information can be used for various things but most commonly it is used to create selections. When AutoCAD renders in 32 bit colour, it sets rendered pixels as selected and background pixels as unselected. So, for example, as well as knowing what colour it is, each pixel also knows whether it is selected or not selected. We can use this extra information in Photoshop to quickly select the rendered object. This is really useful if you intend to place your render onto a photographic background.

To test this out, try rendering some 3D object in AutoCAD using the 32 bit colour option and open the resulting file in Photoshop. On first inspection, the image looks just like any 24 bit image. However, if you click on the Channels tab on the Layers palette, you will see that in addition to the usual four RGB channels, there is an extra channel called "Alpha 1". Channels that contain selection information are often referred to as "Alpha Channels".

You can use this alpha channel to quickly and easily create a selection of the rendered object. There are two ways this can be done. Firstly, select Select > Load Selection... from the pull-down menu. When the Load Selection dialogue box appears, you should see that the Channel value is set to "Alpha 1". Click the OK button to make the selection. You should now see the familiar selection marquee appear around the rendered object. The second method has the same result but uses the Channels Palette. Select the Alpha 1 channel in the list of channels. You will see the image turn black and white (selected pixels are white and unselected pixels are black). Now, click the "Load channel as selection" button at the bottom of the palette. The selection marquee appears but the image remains black and white. Select the RGB channel, at the top of the list to return to normal view. You can now cut and paste in the usual way.
Now that you have selected the rendered object, it is easy to cut and then paste it over a photographic background to create a simple photomontage like the one shown above.

Other Resources

You will find plenty of free web resources for AutoCAD and for Photoshop but very few that cover the two applications working together. I hope this will change in the future because it seems to me that the AutoCAD/Photoshop workflow route is particularly fruitful. One of the few good resources can be found at ARCHIdigm where you will find the excellent Photoshop Gradient Masks over AutoCAD Drawings tutorial. This tutorial demonstrates a useful technique that can be used to give effects like the one shown on the right.
Setting up a PostScript Plotter

by David Watson

Introduction

AutoCAD does allow you to export your drawings to the PostScript format, see the Exporting to EPS section of the AutoCAD to Photoshop tutorial for details. However, as you may have discovered if you have tried, this option often gives less than satisfactory results. By far the best way to create Encapsulated PostScript files from AutoCAD via the Plot dialogue box. However, before you can plot to EPS, you must first set up and configure a PostScript plotter on your computer.

In most cases, when you plot a drawing in AutoCAD, you are sending the plot to a physical plotter and the result is a sheet of paper with your drawing printed on it. However, it is also possible to plot to what is usually known as a "logical" or "dummy" plotter. The plotter does not actually exist but you can use the plotter configuration settings to create a file in a format specific to that plotter. To create EPS files, all you need to do is to add a plotter that uses the EPS format and then configure it to plot to a file rather than to a physical plotter.

Although AutoCAD does not automatically create a PostScript plotter for you when the software is installed, all the necessary files are copied to your hard disk during a standard installation. In fact, all you need to do is to follow a simple wizard.

Add a Plotter

To add a plotter to AutoCAD so that it appears as an option in the Plot dialogue box, you must use the Add Plotter wizard.

1. Select Tools ▶ Wizards ▶ Add Plotter... from the pull-down menu. You will see the Add Plotter Introduction Page, which tells you a little about the wizard. Click the Next button to continue.

2. You will now see the Begin page. This page asks you to specify the type of plotter you want to add. Select the "My Computer" option and click the Next button.

3. The next page is the Plotter Model page. Select "Adobe" from the Manufacturers list. You should now see just 3 options in the list of models.

AutoCAD can create 3 different flavours of PostScript. If you are using Photoshop 6 or above, you can use any of the three options. If you are using versions of Photoshop below 6, you must use PostScript Level 1 or Level 1 Plus. If you are not sure how the files will be used, select Level 1. In fact, there is little difference between the results of the various options although Level 2 does produce noticeably smaller files and these are quicker to work with. Of course, you can always set up two plotters, one for Level 1 and another for Level 2.

Select the appropriate model and then click the Next button.
4. The next page you see is the Import PcP or Pc2 page. This page is specifically for physical plotter configuration and is of no interest to us here. Click Next to continue.

5. The next page is the Ports page and this is where we tell AutoCAD how to deal with the output of the plotting process. You must select the "Plot to File" option. This is important because it will force AutoCAD to plot to file by default and avoid the possibility of inadvertently sending your EPS plot to your printer port. Click the Next button to continue.

6. The penultimate page is the Plotter Name page. This is where you assign the name that will be displayed in the Plot dialogue box when selecting the plot device so make sure that is inadvertently something descriptive. For example, "PostScript Level 2" would be a good choice if you have chosen that option on the Plotter Model page. Enter a suitable name for your plotter and click Next to continue.

7. Finally, the Finish page gives you the option of editing the plotter configuration or calibrating the plotter. Since these options relate mainly to physical plotters, we need not concern ourselves with them. Simply click the Finish button to complete the process.

Checking your Plotter

Your new EPS plotter should now be correctly set up and available for use. First of all, check that it appears in the Plotter configuration list on the Plot Device tab of the Plot dialogue box. Select File > Plot… from the pull-down menu or from the standard toolbar. When the Plot dialogue box appears, click the Plot Device tab and then check that your new plotter appears in the drop-down list in the Plotter configuration section. You should see something similar to that shown in the illustration below.

To give your EPS plotter a proper test, use the Plot dialogue box to plot a file and then open that file in Adobe Photoshop. See the Plotting to EPS section of the AutoCAD to Photoshop tutorial for details.
Adding Sunlight to your Drawings

by David Watso

Introduction

Once you start working with solid models and rendering them, you will want to add lighting effects to your model. One of the most common requirements is to add sunlight to your drawing. AutoCAD has some very powerful and useful features for accurately creating sunlight effects.

As you may have realised by now, you don’t need lights in a scene in order to render a model. Figure number 1 on the left shows the effect of rendering without lights. As you can see, the results are rather uninspiring and there are no shadows. AutoCAD calculates the lighting in a scene where there are no lights by determining the the angle of incidence between the object faces and the line of sight. Faces that are perpendicular or near perpendicular to the line of sight are displayed brighter and faces further from the perpendicular are shown darker. The effect is similar to what you would see if the light source was placed at the camera position; perpendicular faces would reflect more light and faces further from the perpendicular would reflect less light. In figure 1, you can see that the vertical faces of the hedge, facing the viewer are bright, whereas the ground plane is quite dark. Although this effect enables you to clearly see your model, it is far from realistic.

In order to add some sunlight to our scene, we will need to add a light that simulates the sun; AutoCAD calls this type of light a "Distant Light". This is much easier than it sounds and AutoCAD has some very user-friendly tools to help.

As you can see from figures 2, 3 and 4, not only can you simulate sunlight but you can control the time of day, the day of the year and the geographic location. Also, because the renderer can create accurate shadows based upon your parameters, you could even use these techniques to create a shadow analysis.
The three sunlight images on the left show the light and shadow effects on a garden at different times of the day on the 25th June in London. This is all possible without needing to know the first thing about solar geometry!

This tutorial will take you, step-by-step through the process of creating sunlight, modifying it and making the necessary shadow and render settings.

Overview & Fast Track

Adding sunlight and rendering a drawing is essentially a 5 step process. If you are familiar with AutoCAD, you may be able to create sunlight by following the Fast Track steps below. If you have never worked with lights before or have never used the renderer, I suggest you follow the full tutorial. Start by downloading the Sample Data or go straight to Getting Started.

Fast Track

1. Create a Distant Light using the Light command, View ➤ Render ➤ Light… from the pull-down menu. Set the light type to "Distant Light" and click the New… button.

2. Name the light and set Shadow Type to "Raytraced" in the New Distant Light dialogue box. Give the new light a name. Click the checkbox to turn shadows on and then click the Shadow Options… button. Click the checkbox to turn "Ray Traced Shadows" on.

3. Set the Time using the Sun Angle Calculator. Click the Sun Angle Calculator… button in the New Distant Light dialogue box.

4. Set the Location from the Sun Angle Calculator dialogue box. Click the Geographic Location… button in the Sun Angle Calculator dialogue box.

5. Render the Scene using the Render command, View ➤ Render ➤ Render… from the pull-down menu. Set the "Rendering Type" to Photo Raytrace and click the checkbox to turn "Shadows" on.

Download Sample Data

You can use any 3D drawing to follow this tutorial providing that you have drawn a ground plane on which the shadows can be projected. Alternatively, you can download the file shown in the images above. Click on the icon below to download the AutoCAD drawing file Garden.dwg. There are two download options, you can either download the drawing file or you can download the smaller compressed file. The compressed Zip file can be uncompressed with a utility such as WinZip.

- Garden.dwg (367KB) - AutoCAD 2000 Drawing File
- Garden.zip (73KB) - AutoCAD File Zipped

Save the file to the folder where you keep your AutoCAD drawing files. If you downloaded the zipped version,
you will need to unzip it before continuing.

Getting Started

Open the Garden.dwg file. You may notice that it is a little slow to open. This is because the garden is constructed from solid objects and AutoCAD has to load some extra bits of the program to deal with them. The opening view is an aerial perspective. This was created using the DVIEW command but you could also use 3D Orbit. The view has been saved so that you can return to it at any time using the Named Views command, from the Standard toolbar or View >> Named Views…. Highlight the view name, "Sun View", click the "Set Current" button and then click OK.

In addition to the saved view, the garden drawing also has the various render settings already saved for you. However, if you are not familiar with rendering, it would be useful to have a quick go now so that you know what to expect later in the tutorial.

After opening the Garden.dwg, select View >> Render >> Render… from the pull-down menu or click on the render toolbar to display the Render dialogue box. Since all of the settings are already made, simply click the OK button. After a few moments, the rendered image will appear in your viewport and your screen should look something like the image above. Notice that the render background has been set to white. This just makes the rendered objects easier to see. Notice also that some of the objects have materials assigned.

Note that rendered views are not interactive, they are just still images, like photographs. You cannot pan, zoom or pick objects in a rendered view as you can in shaded views. Therefore, you must return to your previous viewing mode before continuing with any drawing work. To do this, you must regenerate the view, select View >> Regen from the pull-down menu.

The rendered image that you see is shown with the default lighting as described above and illustrated in figure 1. We have not yet added any lights, so this is the next thing to do.

Adding a Light

Toolbar

Pull-down View >> Render >> Light…

Keyboard LIGHT

The first step toward simulating sunlight is to create a new "Distant Light".
AutoCAD can create 3 different types of light, namely, Point Light, Spotlight and Distant Light. It is important to understand how each of these light types affects the final rendered image. A point light radiates light in all directions from a single point. A real-world example of this type of light is the bulb of a ceiling pendant light. A spotlight creates a conical light that is also directional. This is similar to a real-world spotlight. Distant lights differ from both point lights and spotlights in that their light rays are not radial, they are parallel.

![Image of Lights dialog box]

Why are distant lights used to simulate sunlight? Well, although light rays from the Sun are radial, we are so far away from the Sun that the angle between light rays is very small by the time they reach the Earth. To all intents and purposes, they are parallel and since light rays from distant lights are parallel, they most closely resemble sunlight.

So, to create a new distant light, select View ➤ Render ➤ Light… from the pull-down menu. When the Lights dialogue box appears, select "Distant Light" from the drop-down list and then click the New… button. This will take you to the New Distant Light dialogue box.

**Configuring a Distant Light**

The second step to simulating sunlight is to name the light and to set the shadow options.

Click in the "Light Name" edit box and type the name of your new distant light. For the sake of simplicity, it might be sensible to call the light "SUN". However, you can call it anything you like providing that it is eight characters or less and doesn't include any of the normal illegal characters such as spaces, asterisks, slashes and dots. If the light name you choose is not liked by AutoCAD, you will see a small error message in the lower left-hand corner of the dialogue box saying "Invalid name".
Setting shadow options for a light involves turning shadows on and then specifying the shadow type. When you create any light, you can decide whether it will cast shadows or not. In some cases it is desirable that lights do not cast shadows. This ability to control shadow casting means that you could build a scene with a number of lights, some of which cast shadows and some of which don't. To turn shadows on, click in the "Shadow On" checkbox (shadows are turned off by default).

Now you can set the shadow type. Click the Shadow Options… button to display the Shadow Options dialogue box.

**Setting Shadow Options**

The AutoCAD renderer can create three different types of shadows. The default shadow type is "Shadow Map" and the alternatives are "Volumetric" and "Ray Traced". You can see from the illustrations below that the shadow map and ray traced shadow types give quite different results. For most objects, the difference between Volumetric and Ray Traced shadows is very small. See All about Shadows for a full description of these shadow types. The type of shadow you use is entirely up to you but in general, ray traced shadows tend to give a better result.
The Shadow Options dialogue box is used to specify which shadow type is used when you render the scene. The default shadow type is the shadow map.

Click the "Shadow Volumes/Ray Traced Shadows" check box to change the shadow type. Your dialogue box should now look like the one on the right. Click the OK button to return to the New Distant Light dialogue box.

Using the Sun Angle Calculator

The third step in simulating sunlight is to set the date and time using the Sun Angle Calculator. From the New Distant Light dialogue box, click the Sun Angle Calculator... button to display the Sun Angle Calculator dialogue box.
In order to set the date and time, you must specify the date, the time, the time zone and decide whether you want daylight savings or not.

Starting at the top of the left-hand column in the dialogue box, click in the "Date" edit box and type the date. Note that dates are in the American format (mm/dd). Next, click in the "Clock Time" edit box and enter the time. Note that this is in 24 hour format or military time. If you wish, you can use the adjacent slider bars to set the date and time but it is very difficult to control accurately and is therefore not recommended.

Using the drop-down list, select the required time zone. For example, if your site is in the UK, select the "GMT/WET" option. Finally, you need to decide whether you would like daylight savings to be calculated. This option will automatically convert GMT (Greenwich Mean Time) to BST (British Summer Time). Most likely you will want to have this option turned on, so click the "Daylight Savings" checkbox.

You will notice that AutoCAD allows you to specify the latitude and longitude of your site. These values must be known in order for AutoCAD to accurately calculate the angle of the Sun. In most cases you won't know these values but fortunately, AutoCAD can help us to locate our site Geographically. Click the Geographic Location… button.

**Setting the Geographic Location**

The fourth step in simulating sunlight is to specify the geographic location of your site. The Geographic Location dialogue box enables you to do this in a number of ways.
The first thing to do is to specify which continent your site is in. Use the drop-down list, centre top of the dialogue box, to select a continent. Once you have done this, you have a number of options. You can simply select the name of a city from the list on the left. You can also select a city by checking the "Nearest Big City" option and picking a point on the map. If your site is not near a big city, you can deselect this option and simply pick any point on the map. Obviously it is very difficult to accurately pick a location from such a small map but you should be able to get close enough to generate realistic shadows.

You have now made all the settings that are needed to simulate sunlight. Click the OK button to return to the Sun Angle Calculator dialogue box. Click the OK button again to return to the New Distant Light dialogue box, click OK a third time to return to the Lights dialogue box and finally, click OK one more time to complete the specification for your distant light.

This might be a good time to save your drawing if you haven't already done so.

Rendering the Scene

The fifth and final step to simulating sunlight is to render a view of your drawing in order to show the effects of light and shadow.
Start the Render command by selecting View > Render > Render… from the pull-down menu. The Render dialogue box will appear. First, make sure that the Rendering Type option is set to "Photo Raytrace". Next, make sure that "Shadows" is checked in the Rendering Options section of the dialogue box. Shadows will not be generated if this option is not checked, even if shadows are turned on for your lights.

If you are not using the Garden sample drawing, you should also check that the Destination is set to "Viewport". You may also like to set the render background colour to white.

When you are sure that all settings have been made correctly (your dialogue box should look similar to the one illustrated above), click the Render button. AutoCAD will take a few seconds to render the scene (times will vary depending upon the complexity of the scene and the speed of your computer).

Modifying Sun Light

Once you have created your first sunlight render, you may want to change the time of day or date of the year in order to demonstrate the changing effect of sunlight on your site. You can modify your distant light settings at any time. To do so, select View > Render > Light… from the pull-down menu to go to the Lights dialogue box. Select your light from the list on the left of the dialogue box and click the Modify… button. This will take you to the Modify Distant Light dialogue box.
From here you can modify any of the settings you made when you first configured the light. When your changes have been made, render the scene again and you will see the results of your modification. You could use this technique to create images of your site at hourly intervals during a single day or at the same time of day at different times of the year. This will give a good idea how sunlight will affect your site at different times.

Tips & Tricks

- You may notice that when you create a light for the first time in a drawing, you not only gain a light but you also gain a small icon representing the light and a special new layer. Distant lights are displayed using the icon shown on the right and the name of the light is also shown. Do not move or erase distant light icons. Erasing the icon will delete the light. The new layer created for the light icon is called "ASHADE" and it is a special AutoCAD layer. Do not use this layer for anything else. However, if you would like to hide your light icons, turn this layer off or freeze it.

- To save your rendered images to file, set the Destination in the Render dialogue box to "File" and then use the More Options… button to configure file output.

- Remember that shadows are only visible if they are cast against some solid object. For example, if you want to see shadows cast on the ground, you will need to draw a ground plane.

- Working with shadow mapped shadows can be tricky and AutoCAD can sometimes throw up unexpected results. Use raytraced shadows to avoid confusion. See the All about Shadows tutorial for more details.
Creating Custom Bitmap Materials

by David Watso

Introduction

This tutorial describes how to create custom bitmap based materials in AutoCAD and how to create the bitmap tile from scratch in Photoshop. If you would like to follow this tutorial closely, you can download the Garden drawing used in the examples. See Download Sample Data, below.

In many cases, rendering using object colours or the use of materials from the AutoCAD Material Library is all that's required to produce a semi-realistic render of a scene. However, sometimes you might want something specific. This tutorial shows you how to create and use a material that looks just the way you want it.

Consider the example above. In the image on the left, the ground has been rendered in the object colour and this looks perfectly fine. But say we wanted to give the impression of a close mown lawn as illustrated in the image on the right. Object colour alone can't do this and none of the materials in the Material Library look like this. The only option is to create our own material. This tutorial uses the example of mown grass but the basic principles hold true for any custom bitmap material.

Creating the Bitmap Tile

Before we get to grips with AutoCAD materials, we need to create an image that will be used as the basis of the AutoCAD material. In this tutorial, we will use Photoshop for this part of the process but you can use another bitmap editor if you prefer.

1. Start Photoshop and open a new image. File ➔ New... from the pull-down menu. You will now see the New image dialogue box. You can use this dialogue box to give your image a Name and to set the Width and Height dimensions. OK, so how big should the bitmap tile be? Well, it depends on how complex your material is. In this case and in most cases where the pattern is relatively simple, a tile of 100 pixels by 100 pixels will work just fine. So, give the image a suitable name, set the measurement units to pixels (if they aren't already) and enter a value of 100 for both the Width and the Height. Click the OK button.

2. Next, use the Rectangular Marquee Tool to select one half of the image. You can do this with precision by looking at the Info Palette as you drag the
3. Now use the Color palette to select a green for the grass and then use the Paint Bucket Tool to flood fill the half of the bitmap which is selected. Your image should now look something like the illustration on the right.

4. Select the other half of the image by inverting the selection, Select \[Select Inverse\] from the pull-down menu. Select a complimentary green from the Color palette for the other half of the image and use the Paint Bucket Tool to fill the selection. Your image should now look similar to the one on the right. So far, we've just used flat colours to create our bitmap but grass has a texture to it that our image doesn't have. In order to make our grass look a little more realistic, we'll add some texture to the image.

5. The Photoshop Noise filter is probably one of the most useful filters that comes with the application. Most materials look better with a bit of texture, whether you are creating grass, concrete, rock or whatever. In all cases, the Noise filter can be used to add just the right amount of texture.

   Start the Noise filter from the pull-down menu, Filter \[Noise \rightarrow Add Noise\]. You will be presented with a small dialogue box that enables you to control the amount and type of noise you want to add to the image.

   As you can see from the illustration on the right, there are three basic controls. The first, Amount, is fairly obvious, use the slider to set the percentage of noise. The Distribution option changes the pattern of noise; Gaussian looks slightly more random than Uniform. Finally, the Monochromatic option can be used to determine the colour of the noise. Basic noise adds a range of colours to the image, irrespective of the colour of the background. When Monochromatic is selected, the colour of the added noise matches that of the background. The best way to get to grips with these controls is to play about with them. For the grass image, the settings shown in the illustration were used.

6. When you are happy with the image, you will need to save it so that it can be used by AutoCAD. What format should be used and where should it be saved? Well, AutoCAD can use a number of common bitmap file formats and so the sensible option is to keep the file size as small as possible, so JPEG is a good format to use.

   If you intend to keep this material for future use, it is a good idea to save the image somewhere sensible (not the Desktop!) like the folder where you keep your textures or to the AutoCAD texture folder, usually C:/Program Files/AutoCAD/Textures. This is important because every time you render using the new material, AutoCAD must find the image file in order to render the material correctly. If the
image file is moved or deleted, AutoCAD will not find it and your rendered image will not look right.

To save the image, use the Photoshop Save for Web option, **File ▶ Save for Web…** from the pull-down menu. This will allow you to choose a suitable compression level.

## Creating the Material

Start AutoCAD and open the drawing you want to render. Go to the Materials dialogue box, **View ▶ Render ▶ Materials…** from the pull-down menu. In the right hand column, you will see a drop-down list with a "New..." button above it. Select "Standard" from the list if it is not already selected and then click the **New...** button. You will now see the New Standard Material dialogue box, illustrated below.

![New Standard Material dialogue box](image)

Creating the material is very simple.

1. **Give the material a suitable name.**

2. **Click the Find File…** button and select the image you just created in Photoshop. Remember to set the file type in the Bitmap File dialogue.

3. **Finally, click the Preview button to check that all is well. That's it! Click the OK button to return to the Materials dialogue box.**

The next step is to attach the new material to an object and render it to see what it looks like.

## Attaching the Material by Layer

Materials can be attached to objects by selecting them or they can be attached by association with the object's
colour or layer. In most cases, if your drawing is correctly layered, attaching materials by layer is the most sensible option. In the case of the example used here, the ground plane is on a layer called "GROUND". Since the new material is called MOWN GRASS, all we need to do is attach the MOWN GRASS material to the GROUND layer.

Go to the Materials dialogue box if you don't already have it open and click the By Layer… button at the bottom of the right hand column. The next thing you will see is the Attach by Layer dialogue box, shown below.

Simply select the material you want to attach from the list on the left, select the layer you want to attach it to from the list on the right and then click the Attach-> button. When you have done this, the material name will appear adjacent to the layer name in the list on the right. Click the OK button to complete the process and return to the Materials dialogue box. Finally, click the OK button in the Materials dialogue box to return to the Command prompt.

Rendering the Model

Now that you have created and attached the new material to part of your model, you will want to render the model to see what the new material looks like. Bear in mind that the material will look different in different lighting conditions, so make sure that you have set up any lights you might need before you render the model. See the Adding Sunlight to your Drawings tutorial for details on how to set up a light that simulates sunlight.
To render the model, select View ➤ Render ➤ Render... from the pull-down menu. You will now see the Render dialogue box, shown above. Set the Render Type to either "Photo Real" or "Photo Raytrace". Materials will not be displayed if the default "Render" render type is used. Also, make sure that the Apply Materials option is checked in the Rendering Options section of the dialogue box. Click the Render button to begin the render.

The first render with the new material is shown in the illustration on the right. As you can see, there are two problems with it. First of all, the stripes are too narrow, they should be about twice the width. Second, the rendered effect in the prevailing lighting conditions is far too bright. In order to get the material to display the way we want, we're going to have to make some modifications.

Modifying the Material

AutoCAD enables you to modify materials in many ways. There are lots of parameters that can be used to change the way a material looks. In this particular case, we'll look only at methods for modifying the scale and the brightness.

Modifying Scale
If we want the grass stripes to appear twice as wide as they are shown, we'll need to scale up the bitmap by a factor of two. We could go back to Photoshop and double the size of the image but that wouldn't be particularly efficient. Instead, we'll work with AutoCAD. Go to the Materials dialogue box, View > Render > Materials… from the pull-down menu. Select the material from the list on the left and click the Modify… button at the top of the right hand column. Then, click on the button that says "Adjust Bitmap…". The next thing you see will be the Adjust Material Bitmap Placement dialogue box, shown below.

You can use the settings in this dialogue to change many aspect of the bitmap geometry. However, all we want to do is double the scale at which the bitmap is displayed. First, check the Maintain Aspect Ratio option at the bottom left of the dialogue box. Then, enter the value 2 in either the U or V scale edit boxes. Since the default scale is 1, setting the value to 2 will double it. Click the OK button to return to the Modify Standard Material dialogue box, OK again to return to the Materials dialogue and OK a third time to return to the AutoCAD Command prompt. Now render the model again to see the result of your modification. You can see from the illustration on the right that the scale is now correct but the material is still too bright.

Modifying the Brightness

Go once again to the Materials dialogue box, View > Render > Materials… from the pull-down menu. Select the material from the list on the left and click the Modify… button at the top of the right hand column. You now see the Modify Standard Material dialogue box, shown below.
The brightness and the strength or contrast of the material can be adjusted using a combination of two parameters, "Bitmap Blend" and "Value". The way a bitmap material looks is a combination of two components, the bitmap itself and the colour of the object to which it is attached. The Bitmap Blend parameter determines how much of the bitmap or object colour are seen. By default, when you create a new material, AutoCAD sets the Bitmap Blend value to 1.00. This means that only the bitmap is seen and none of the object colour. Setting this value to 0.00 means that only the object colour is seen and none of the bitmap. Between these two values, varying proportions of both bitmap and object colour are seen. The Value parameter controls the brightness of the object colour. The default value of 0.70 gives the true object colour. A lower value causes the colour to darken and a higher value causes the colour to brighten. The Value parameter has absolutely no effect on the material when Bitmap Blend is set to 1.00 because none of the object colour can be seen. However, by adjusting the two values together, it is possible to get just the effect you want.

The settings shown in the illustration above result in the rendered image on the right. Again, this is another of those situations where you really need to play about with the parameters to get a feeling for them and to finish up with just the result you are looking for.

You can use the Preview to get a crude idea of how the changing values affect the material but you will need to render the model to see the results properly. So, when the preview looks about right, click the OK button to return to the Materials dialogue box, OK again to return to the command prompt and then do a final render.
More on Bitmap Blend

Bitmap Blend and the object colour can be used in combination to vary the way the rendered material appears. For example, the 3 cubes on the left have object colours of magenta, red and blue. Each cube also has the Grass material attached. The cubes on the top row have Bitmap Blend set to 0.0, so none of the bitmap is seen. The cubes in the middle row have a Bitmap Blend value of 0.5, so we see 50% of the object colour and 50% of the bitmap. The cubes on the bottom row have a Bitmap Blend value of 1.0, in this case, we see none of the object colour.

The four cubes below all have an object colour of blue. Each cube has the Grass material attached and the Bitmap Blend variable has been set (from left to right) to 0.2, 0.4, 0.6 and 0.8 respectively. You can clearly see the change from object colour to bitmap.

Bear in mind that once Bitmap Blend has been set to a value of less than 1.0, you can also use the Value variable to change the brightness of the object colour. Used in combination, these parameters give amazing control over the way a material looks when it is rendered. As usual, in order to achieve a good understanding of how these parameters affect the final result, you need to experiment.

Download Sample Data

You can use any 3D drawing to follow this tutorial providing that you have drawn a 3D object onto which a
material can be attached. Alternatively, you can download the file shown in the images above. Click on the icon below to download the AutoCAD drawing file **Garden.dwg**. There are two download options, you can either download the drawing file or you can download the smaller compressed file. The compressed Zip file can be uncompressed with a utility such as WinZip.

- **Garden.dwg** (367KB) - AutoCAD 2000 Drawing File

- **Garden.zip** (73KB) - AutoCAD File Zipped

Save the file to the folder where you keep your AutoCAD drawing files. If you downloaded the zipped version, you will need to unzip it before continuing.
Creating Seamless Tiles
by David Watso

Introduction

One of the main problems with the creation of bitmap based materials is getting them to look as though they repeat or tile seamlessly across a rendered surface. This tutorial explains the various ways by which this can be achieved.

By way of an illustration of the problem, look at the two bitmap tiles illustrated on the right. They are both 100px by 100px. They are both JPEGs and superficially they both look similar. However, when used as a material, one of them displays obvious seams while the other doesn't. The bluewave1.jpg image was created simply by scribbling with the Airbrush Tool in Photoshop. The bluewave2.jpg image has been tweaked so that it will tile seamlessly. The rendered result of each of these two images are illustrated below. The material based on the bluewave1.jpg image is shown on the left and the material based on the bluewave2.jpg material is shown on the right. The bluewave1 material displays obvious vertical seams. In this case, the horizontal seams aren't too obvious but that's more a case of luck than judgement. What we need is a sure fire method of creating a material that can be tiled without showing any seams.

So, how can an image be tweaked to avoid such seams? At the heart of this technique lies the Photoshop Offset filter. You may have been working with Photoshop for some time and never come across this filter but this is exactly the purpose for which it was designed. Let's first have a look at how bluewave2 was created.

Creating the bluewave tile

1. Start Photoshop and open a new image, File ➤ New... from the pull-down menu. Set the new image size to 100px by 100px. Select a pale blue as the
foreground colour and then use the Paint Bucket Tool to flood fill the new image. Select a slightly deeper blue and then use the Airbrush Tool to draw some blobs on the background. Select a dark blue and use the Airbrush Tool again to draw some wiggly lines. You can build up deeper textures by repeating this process a number of times. When you're done, the image should look something like the one on the right.

2. Use the pull-down menu to start the Offset Filter, Filter ▶ Offset… The Offset Filter dialogue box appears and offers just a few options.

The first thing we must do is enter values for Horizontal and Vertical offset. In each case, the offset value should be set to exactly half of the full size of the bitmap. In our case, since the bitmap is 100px by 100px, the offset values for both the horizontal and vertical directions should be set to 50px.

The option for Undefined Areas must be set to "Wrap Around" in order to get the effect we need.

When you have made the settings shown in the illustration above, click the OK button to apply the filter. When you have done this, your image should look something like the one shown on the right. Notice that we now have the edge seams running across the middle of the image. This is because we have offset the image by half of its width and height and wrapped it round. We now have the opportunity to do something about the seams.

3. Use the Airbrush Tool with the same colours you used previously to join up the wiggly lines across the seam. Since we know that the edges of the image already wrap around, thanks to the Offset Filter, all we need to do is eliminate the visible seam in the middle of the image to produce a truly seamless tile. The finished result should look something like the one shown on the right.

4. Finally, save the file as a JPEG using the Save for Web option, File ▶ Save for Web… This will give you the opportunity to control the compression level. Remember to save the file to your textures folder so that it can easily be found in the future. To test the tile, create a new bitmap material in AutoCAD, attach it to an object and render it. See the Creating Custom Bitmap Materials tutorial for more details.
Other Strategies

The sequence above illustrates just one strategy for creating seamless tiles. Although in every case, the Offset Filter should be used, there are lots of different ways you might go about building up the texture. For example, one of the simplest methods is illustrated below.

1. Make a random pattern of splodges but keep away from the edges of the image.
2. Use the Offset Filter to offset half the bitmap height and width and Wrap Around.
3. Simply fill in the gaps with more splodges and Hey Presto! you have a seamless tile.

If this simple 3 step process is repeated a number of times, you can create beautiful deep seamless textures. After 3 or 4 more iterations using different colours, the tile above finished up as the scrub.jpg file shown on the right. The result of an AutoCAD render using our Garden.dwg file is shown below.

To get some really good results, you need to experiment. Try using different Photoshop filters, consider using Layers to build up your textures. The textures below are the result of a few minutes experimentation using various brushes, the noise and blur filters and gradient fills; they are all completely seamless. The possibilities are almost limitless.
bluegrass.jpg  furrow.jpg  steel.jpg  swamp.jpg

To download any of the images above, right-click on them and select **Save Picture As ...** from the pop-up menu. Save the image to your textures folder and test them out as materials in AutoCAD.
AutoCAD to Bryce

by David Watso

Introduction

Although Bryce does have some 3D modelling tools, they are a little basic. Also, building accurate 3D models in Bryce is difficult. If you need to build an accurate 3D model, you're much better off using an application specifically designed for this purpose such as AutoCAD. Models built in AutoCAD can easily be imported into Bryce where they can be given an appropriate setting. The bonus is that Bryce has a much better renderer than AutoCAD and much better control over materials.

![Model built in AutoCAD](Image1.png) ![Finished model in Bryce](Image2.png)

This tutorial explains how to take a model built in AutoCAD into Bryce, how to assign materials to the various components of your model, how to use image textures, how to create a simple setting and how to render the resulting scene. Although the key skills shown in this tutorial are directed at the "dressing up" of AutoCAD models, they are also generally applicable to many other situations.

Will any old model do?

Well, sort of. It's true that any 3D model built in AutoCAD can be imported to Bryce but a little finesse and forethought goes a long way.

It's all in the Layers

When you get your model into Bryce, one of the first things you'll want to do is to assign materials to the various parts of the model. So, we need to differentiate the various parts of the model so that each material type can be assigned to a specific object. During the transfer process from AutoCAD to Bryce we get to choose how objects are derived. We can, for example have like for like; in other words, each AutoCAD object becomes a Bryce object. The problem with this approach is that everything gets a bit fiddly, especially with complex models. A better method is to derive objects by layer; all objects on a particular AutoCAD layer will become a single object on arrival in Bryce. This is very convenient as you will see, but it does mean that you need to think carefully about layers before you start.
Layers = Materials
When you build your AutoCAD model, create a new layer for each material type you are using and make sure that objects you want to appear rendered in that material are on the corresponding layer. For example, you might have a layer called "Glass" where all glass objects should be and "Steel" for steel objects, "Wood" for wooden objects etc. The benefit of this is that since each layer becomes a single object in Bryce, you need only assign each material type once and this makes life much easier.

General Overview
Let's start by looking at an overview of the process. The first thing we need is a completed AutoCAD model that has been correctly layered. We'll then export the model to the 3DS file format. The 3DS file can then be imported to Bryce. Once in Bryce, the materials can be assigned and an appropriate setting constructed.

FastTrack AutoCAD to Bryce
OK, maybe you've done this before but you just need a little reminder how the whole thing works. If this is the case, use the FastTrack steps below as a check list. If you have never done this before, the details below should give you a little more information and should help you get a good feeling for what we're about to do during the rest of the tutorial.

Step 1  In AutoCAD, go to File ► Export… select the 3DS file type and follow the prompts.
Step 2  In Bryce, go to File ► Import Object… and select the 3DS file you just created.
Step 3  When the model appears, land it down.
Step 4  Ungroup the model.
Step 5  Use the object edit option to smooth any curved objects.
Step 6  Assign appropriate materials to the objects.
Step 7  Add any Image Textures as materials.
Step 8  When you are happy with the appearance of the model, group the objects.
Step 9  Create a setting by assigning a material to the ground plane and modifying the sky.
Step 10 Render to disk if you want an image of your rendered model, File ► Render to Disk…

The ten step sequence described above works well for all situations where you need to bring an AutoCAD model into Bryce. However, if you want to follow this tutorial closely, you might want to download the sample data in the section below before continuing.

Sample Data
We'll be using two files during this tutorial. The AutoCAD 2000 drawing file is a 3D model of the Information Panel shown in the images above. The JPEG file will be used as an image texture and will be mapped onto the panel.
There are two download options, you can either download the AutoCAD and JPEG files separately or you can download the two together as a compressed Zip file. The Zip file can be uncompressed with a utility such as WinZip.

- Information Panel.dwg (112KB) - AutoCAD 2000 File
- wild.jpg (35KB) - JPEG Image File
- atob.zip (51KB) - Compressed Zip File (contains both the above)

Save the downloaded files to your work folder. Now, start AutoCAD and open the Information Panel.dwg file. We're now ready to start.

1 Export to 3DS

Select File ▶ Export... from the pull-down menu. When the Export Data file dialogue box appears, change the file type to 3D Studio and click the Save button, making sure to check which folder you are saving the file to. By default, exported files are saved to the same folder as the drawing file.

You are now prompted to select objects. If you want, you can export part of a drawing using this facility. In this case, we want to export the whole model so select all objects and Enter to complete the selection.

The 3D Studio File Export Options dialogue box now appears. You can use this dialogue box to control how your AutoCAD objects are converted to 3DS. In most cases, as in this one, there is no need to make any changes. The default settings are just fine but for future reference, it's worth looking at the "Derive 3D Studio Objects From" section. You will see that there are three methods for deriving 3DS objects from your AutoCAD objects. 3DS objects can be derived by layer (the default), by colour or by object. For this exercise, we are using the layer option as discussed above but it's worth knowing that you have other options.

Click the OK button to save the 3DS file. AutoCAD may take a few moments to do this depending upon the complexity of the objects you are exporting. You now have a version of your AutoCAD model in 3DS format. Close AutoCAD. From this point on, we'll be using Bryce.

2 Import to Bryce

Start Bryce and select File ▶ Import Object... from the pull-down menu. You will see a file Open dialogue box. Navigate to the folder where you saved the 3DS file. Highlight the file and click the Open...
button. The model should appear in the center of your work area. The model is automatically selected so it appears highlighted in red.

3 Land the Model Down

For some reason, Bryce always places imported objects just above the ground plane. This is eccentric rather than annoying because the solution is very simple. You can tell the model is floating above the ground plane because even in wireline view, Bryce objects cast shadows. Just click the Land Object Down icon and the model will be placed exactly on the ground plane.

4 Ungroup the Model

When 3DS files are imported into Bryce, all the separate objects contained in the file are automatically grouped. This is very useful if you want to move or scale a compound object when it arrives. In general it's much easier working with models if they are grouped because there's no chance of the various objects being inadvertently separated. However, in this particular case, we need to have access to the individual objects because we are going to assign materials. We'll regroup the objects later but for now we must ungroup them. To ungroup the model, click on the Ungroup Objects icon. Initially, not much seems to change because all the various objects are still selected.

Click the Time/Selection Palette Toggle in the bottom-right hand corner of the screen to reveal the Selection Palette. This palette can be used to help in making complex selections. For example, you can easily select all objects of a particular type simply by clicking on the appropriate icon. To deselect all objects, click on the small down arrow on the palette and pick "Select None" from the menu. All objects are now deselected and the model turns grey to indicate this. You can now select any of the component objects simply by picking them. Don't forget that you can select multiple objects by shift-clicking.

**Note:** There are ways to select grouped objects without having to ungroup them first. See Selecting Objects in an Imported Group in the Tips & Tricks section below.

5 Smoothing Objects

When 3DS files are imported into Bryce, curved surfaces and solids often appear facetted. This is because objects are converted to meshes and meshes are composed of polygons. To overcome this
problem, you can smooth the objects to make them look more like the original. For example, the image on the right shows 3 spheres. The one on the left is an AutoCAD solid sphere imported into Bryce via 3DS. As you can see, the sphere is clearly faceted. The sphere in the middle is an AutoCAD solid sphere after smoothing. The Sphere on the right is a native Bryce sphere. If you compare the middle and right-hand sphere, you can see that the smoothing process is not perfect but in most situations, the difference will not be noticed.

You can smooth an object by clicking on the Edit Object icon when the object is selected and then clicking the Smooth button.

For example, the Information Panel we are working with has a curved roof that needs to be smoothed. Select the roof by clicking it and then click the Edit Object Icon. You should now see the Edit Mesh dialogue box. There are 3 main components to this dialogue box. On the left there is a sliding scale that runs from 0 degrees up to 180 degrees. The default value is set at 85 degrees. To the right of the slider is the smooth button and to the right of that is the unsmooth button. It's a little confusing because the two sphere images are in fact buttons and not preview images.

The slider can be used to control the range of angles that will be smoothed. The default setting of 85 degrees means that all angles up to and including 85 degrees will be smoothed. Angles greater than 85 degrees will not be smoothed. Effectively, the default will smooth anything less than a right angle and in most cases this turns out to be the most common requirement.

So, to smooth the roof of the Information Panel, leave the slider set to the default value and click on the Smooth button. When you have done this, click the check mark ✓. When you have smoothed the object, you will see no difference in the wireline because Bryce does not add more polygons to the object. Rather, it just interpolates between the existing polygons and this is only apparent when the object is rendered. When you have smoothed the roof, you’ll also need to smooth the steel uprights.

**Note:** You may have noticed that there is an option for smoothing exported objects on the 3D Studio File Export Options dialogue box in AutoCAD. You can play about with this setting all you like but it has
absolutely no effect on the imported object as it arrives in Bryce.

6 Assign Materials

Bryce has some very powerful tools for creating custom materials. Unfortunately, most of them are beyond the scope of this tutorial. We'll assign materials to our Information Panel by choosing some off-the-peg materials from the Material Library.

As an example, we're going to assign a material called "Standard Glass" to the roof of the Information Panel. Start by selecting the roof, if it is not already selected. Make sure no other objects are selected. Now, click the Edit Material icon to enter the Materials Lab. Initially, the settings in the Materials Lab reflect the current material and at the moment, this is the object colour that was assigned in AutoCAD.

To select a new material from the Materials library, click on the small grey arrow at the top right of the Material Preview Area, shown in the image on the right.

When you do this, the Preview Area changes to show the selected material and the button is highlighted in red. Your dialogue should look similar to the one shown on the left.

Click on just below the palette to return to the Materials Lab. Now click the button in the Materials Lab to assign the material to the object and return to the drawing.

When you return to the drawing, you should see the new material shown in the Nano Preview at the top left of the screen. It's often difficult to see if a material looks right by using the Nano Preview so you may have to do a render to see the effects of the material in the main work area. You can do this by clicking the large sphere below the Camera Trackball on the Control Panel.
Repeat this process for each of the Information Panel object components. In each case, select an appropriate material from the Material Library. When you are finished, render your model to see a full preview.

You may notice that in the illustration above, we still haven’t got an image displayed on the Panel. That’s because we need to use a different procedure to create what’s called an Image Texture.

7 **Using an Image Texture as a Material**

Sadly, working with the Materials Lab is not always an intuitive process. However, once you get used to the way things work, it can be a rewarding experience. Keep your wits about you and follow the steps below with reference to the dialogue box image.

1. Click the circular depression at the top of column "A" next to "DIFFUSE". This effectively causes the diffuse element of the material (the colour or texture) to be controlled by "Texture A". You will see a new texture palette appear at the top right of the Materials Lab.

2. Click the small "P" (Picture) button. This tells Bryce that Texture A will be defined as an image.

3. Next, we need to select the image. Click the
small button above the P button to go to the Texture Source Editor. In this case, since the texture is defined by an image, you are taken to the Picture Room, where you can select an existing picture or add one of your own. When you get to the Picture Room, you should see at least one picture already there. It's our old friend Leo. Click on the next blank button and using the Open file dialogue, find the *wild.jpg* file, select it and click on the Open button. You should now see that the image has been added to the blank button and the Picture Room should look like the one shown in the illustration above. Click ✅ to return to the Materials Lab.

4. Now that the image has been assigned as the material texture, we need to tell Bryce how we want the image mapped over the object surface. We can do this by setting the Texture Mapping Mode. The default mode is "Parametric" which means that the image is mapped proportional to the object. Although this works fine for most organic shaped objects, in this particular case, it doesn't give the effect we need. We want the image to be mapped onto the front face of the board. So, click on the Texture Mapping Mode button and select "Object Front" from the drop-down menu.

5. We're almost done now but you may find that you need to make some slight adjustments to some of the other material components. In this particular case, a better result can be achieved by changing the colour of the Specularity (the light bouncing off the object) from white to a mid/dark grey. To do this, simply click on the Component Colour icon next to "SPECULAR" and select a colour from the pop-up palette. Effectively, this makes the image clearer by reducing the amount of white light bouncing off the object surface.

When you have completed the five steps above, render the view to get a full preview. You should have something like the illustration shown here. As you can see, the image now looks as though it has been printed directly onto the Panel and that's exactly the effect we wanted.

8 Group the Objects

Once all the various changes have been made to the separate objects, it's a good idea to group them so that the whole Information Panel can once again be treated like a single object. This makes working with it much easier.

To group the objects, you must first select them all. The simplest way to do this is by using the Selection Palette. Click on the small down arrow to reveal the Select Options, click on "Select Meshes
to reveal the sub menu and then click on "Select All Meshes". All you need to do now is click the Group Objects icon. This makes no obvious visual change to the model but it now acts as a single object rather than a number of separate objects.

9 Create a Simple Setting

The quickest way to create a simple setting is to assign one of the library materials to the ground plane and then select a sky from the Sky & Fog library.

To assign a material to the ground plane, use the same procedure as in Step 6, above. Click the ground plane to select it and then click the Edit Material icon. When you get to the Materials Lab, click on the arrow at the top right of the Preview Area to go to the Materials library. You will see that there is a category called "Planes & Terrains" Click on this option and select something suitable from the palette.

To select an appropriate sky (assuming you're not happy with the default sky) we need to visit the Sky & Fog library. You can go directly to the Sky & Fog library by clicking the arrow to the right of "Sky & Fog" above the toolbar. You are presented with a palette of preset skies. Select one you like the look of and then click to implement the change. You may want to render the scene to see a full preview.

Finally, you may want to adjust the position of the sun in order to show the model to best advantage. To do this, click on "Sky & Fog" to flip to the Sky & Fog toolbar. On the right hand side of this toolbar you will see a large black sphere. This is the Sun Control. Click and drag the Sun Control to change the position of the sun in your scene. You get instant feedback through the Nano Preview so you can see what effect you are having on the scene. When you are happy with the result, render the scene to see a full preview.

The image below shows just one of an almost infinite number of combinations of ground plane material sky preset and sun position. With a little bit of experience, you'll soon be able to create realistic looking settings for your models.
10 Render to Disk

The final step in this tutorial is to render the scene to disk. There are many reasons why you might want to do this. Maybe you want to add a caption to the image in Photoshop or maybe you want to add the image to a PowerPoint presentation. Whatever, the procedure is the same.

Select File ▶ Render to Disk… from the pull-down menu. The Render to Disk dialogue box appears. You will need to think how big you want the image to be. You have the option to enter the size in pixels or in inches. If you are printing the image, you can set the printed size in inches and then set the resolution (the default, 72dpi is probably fine for most purposes). If the image is to be displayed on a computer screen in a web browser or in a PowerPoint presentation, it’s more natural to enter the image size in pixels so that you know exactly what you’re going to get.

![Render to Disk](image)

<table>
<thead>
<tr>
<th>Information Panel</th>
</tr>
</thead>
<tbody>
<tr>
<td>Output Size in Pixels</td>
</tr>
<tr>
<td>Print Resolution</td>
</tr>
<tr>
<td>Output Size in Inches</td>
</tr>
</tbody>
</table>

Having entered an appropriate size for the image, click ✔ and you will be presented with the Save As file dialogue box. Using this dialogue you can choose an appropriate file format. Options include BMP, TIFF and PSD (native Photoshop format). Also enter a filename and decide which folder the image will be saved to. Rendering begins when you click on the Save button. A progress bar will appear so that you can estimate how long the render is likely to take. Render time will vary depending upon image size, processor speed and anti-aliasing.

Conclusion

We've covered a lot of ground in this tutorial but most of the skills we have learned can be used in other
situations. Indeed, things like assigning materials are really basic fundamentals of working with Bryce.

Clearly, Bryce offers much more in the way of materials, atmospherics and render than AutoCAD and the two applications compliment each other very well. If you would like to learn more about Bryce and how it can be used to animate your AutoCAD models, have a look at the Keyframe Animation tutorial.

Tips & Tricks 🍎

Save frequently and use Save As

When working with Bryce, it's a good idea to save your work frequently, especially when you come to the end of a particular part of the work process. Unlike AutoCAD, there's no auto save feature, no backup file and no undo history so it's a good idea to save as you work. It's also a good idea to use Save As to create versions of your drawing at different stages of development. This will enable you to go back to previous versions of the project in the event of the whole thing going "pear shaped". Having only one Undo means that it's quite easy to mess things up with no way back so having previous versions to go back to is essential.

Selecting Objects in an Imported Group

In this tutorial, I have chosen to demonstrate the use of groups and in Step 4 we ungrouped the imported model and in Step 8 we grouped it again after having assigned all the materials. Working with ungrouped models is more intuitive because it is possible to select a component object simply by clicking it and you don't need to remember object names. However, it is also possible to select component objects while they are still part of a group.

There are actually 2 ways of doing this and they are both described below. The first is to use the Selection Palette. If you do not see the selection palette, click on the Time/Selection Palette toggle at the bottom right of the screen. This palette can be used to select any object or group in Bryce.

If you need to select a component object of an imported group, click the small down arrow on the Select Palette to reveal the options menu and choose: **Select Meshes ⫷ Mesh Name.** The mesh name is derived from the AutoCAD layer name. For example, all objects on the AutoCAD layer "Wood" will become the mesh object called "Wood_1" in Bryce. Obviously, this assumes that we derived objects by layer when creating the 3DS file.

Once the object has been selected in this way, you can edit it just as if it were not part of a group. You can assign materials, smooth it and even Resize, Rotate and Reposition it while it remains a part of the group.

Using the selection palette can be a real time saver when you have a complex model to deal with but there is an even quicker way to select component objects of a group (or any other object). If you hold down the **Ctrl** (control) key on the keyboard when you pick
an object, you will be presented with a menu listing all the objects under the cursor. Simply select the object name from the menu to select the object.
Importing AutoCAD Meshes to Bryce

by David Watson

This tutorial describes how to create a triangular ground model using Key Terra-Firma and AutoCAD and how to import this ground model into Bryce. The import technique described will work with any mesh or complex of 3D faces created with AutoCAD. If you do not have access to Key Terra-Firma, see the Alternative Method section below. This describes how 3D Studio VIZ can be used to create the terrain model.

Although you can create very realistic terrain objects in Bryce, it is often difficult to get them to look just like a real place. However, you can use Key Terra-Firma with AutoCAD to create an accurate terrain model from contour or other height data and then import this into Bryce. There are some limitations. An imported terrain model cannot be edited using the Terrain Editor. However, the imported terrain can be moved, scaled and rotated just like any other object in Bryce. The terrain or mesh can also be smoothed to give a better appearance and you can even apply Bryce terrain materials.

Step 1

Draw, trace or acquire the contours for the terrain you are interested in. Remember that your contours must be drawn using 2D polylines. Each contour should have an elevation corresponding to its height value. If you are using Terra-Firma, you can give specific elevations to your contours using the "Move Vertically to" command. You will find this on the pull-down menu at Key-T-F 3D utilities Move Vertically to. See the Contours section of the Ground Modelling tutorial for more tips on drawing contours.

Step 2

Create a ground model (KGM file) using your contours. From the pull-down menu, KeyT-F Ground Modelling Create Ground Model…. See The Create Ground Model Command section of the Ground Modelling tutorial for details.

Step 3

Once you have created the Ground Model file, you can use it to create a triangular mesh. The triangular mesh is the most accurate representation of the surface which was represented by your contours. You can create a triangular mesh using the Key Terra-Firma Draw Triangles command. You will find this command at KeyT-F Ground Modelling Draw Triangles…

First, select the ground model you just created by clicking the Select… button and navigating your way to the file. In some cases your KGM file will already be selected, in which case you can skip this operation.
Now, specify a layer name. Terra-Firma will automatically create a layer if it does not exist. It is a good idea to give your layer a useful name because when the mesh is imported into Bryce, the layer name will be used as the name of the imported object.

Also, choose a suitable colour for the mesh. The colour you choose will be the colour that your mesh appears when it is imported into Bryce.

Finally, set the "Draw as" option to "3D faces" and click on the Start button.

You should now have a triangular mesh, something like the one in the illustration on the left. This is a 3D representation of your contour data.

See The Draw Triangles Command section of the Ground Modelling tutorial for more details on the use of this command.

Step 4
You must now export your triangles to a 3DS file. Bryce cannot import native AutoCAD (DWG) files and so you must convert your drawing objects to a format that Bryce understands. Bryce can also import DXF files but you will find that the 3DS file format gives much better results.

To export AutoCAD objects to a 3DS file, go to File Export… on the pull-down menu. When the Export Data file dialogue box appears, set the export format to "3D Studio" using the "Save as type" drop-down list at the bottom of the dialogue box. Then, select a location for the file, give the file a name and click the Save button. AutoCAD then prompts, "Select objects:". Select the objects you want to export (in this case, just the triangular mesh) and then press the key to complete the selection.

The next thing you will see is the 3D Studio File Export Options dialogue box. You can use this dialogue box to control how the 3D Studio objects are derived from the AutoCAD objects you have just selected. In most cases, as in this one, the default settings are good and nothing need be changed. New objects will be derived by layer. Since the triangular grid is on a single layer, this will result in a single object when the 3DS file is imported into Bryce.

Step 5
Now that you have created a 3DS file, you can
close AutoCAD/Key Terra-Firma and open Bryce.

Once in Bryce, you must import the 3DS file into the current Bryce scene. You can import a 3DS file into a new Bryce document or you can import it into a scene that you have already started building. From the Bryce pull-down menu, select File > Import Object…. When the file Open dialogue box appears, select your 3DS file and click on the Open button. As soon as you do this, the triangular mesh appears in the centre of the scene.

Step 6

If you now render the scene, you will see that the imported terrain appears in the colour you selected as the layer colour in AutoCAD. You will also notice that the triangular mesh looks highly faceted, giving a crude overall appearance. Fortunately, you can improve upon this.

When the mesh is selected (highlighted in red), you will see a set of icons displayed in a column next to it. These are the Object Control icons. One of the icons says "E". This is the Edit icon. What happens when you click on the Edit icon depends upon what type of object is selected. With mesh objects, as in this case, the Edit icon takes you to a small dialogue box which allows you to smooth the mesh.

Simply click on the image of the smooth sphere and click on the icon at the bottom right of the dialogue box. When you return to the drawing, you may notice that the mesh object is visually unchanged. However, render the scene again and you should now see that the rendered mesh is much smoother than it was previously. The rendered mesh will always appear smooth but if you want to change it back, use the Edit Mesh dialogue box again and this time click on the faceted sphere image to unsmooth the mesh.

Step 7
Finally, you will probably want to apply a material to your mesh. Fortunately, you can do this in just the same way as you would for a Bryce terrain object and you will find that the results are just as pleasing.

To assign a material, select the mesh (if it is not already selected) and then click on the “M” (Materials Lab) icon. You are taken to the Materials Lab. When you arrive, click on the little arrow at the top right of the preview image. This will take you to the Material Library.

When you arrive, select “Planes & Terrains” from the list and select a suitable material type from those shown. Click on the ✓ icon to return to the Material Library. Then click the ✓ icon again to return to the drawing. Render the scene again to see your terrain in all its glory. The material used for the terrain in the illustration above is Mossy Rock.

An Alternative Method

If you do not have access to Key Terra-Firma, you could create a terrain model from contours using 3D Studio VIZ R2 or later. Save your AutoCAD contour drawing as a Release 14 drawing and then import the drawing into 3D Studio. See the Creating Contour Data and Importing the .DWG File sections of the Creating Terrain Objects tutorial to find out how to do this.

Once you have imported your contours, create a terrain object in VIZ, see Creating the Terrain Object for details. Now, all you need to do is to export the VIZ terrain to a 3DS file, File ➤ Export… from the pull-down menu. Choose a folder, give the file a name and set the format to 3D Studio (*.3DS) using the “Save as type” list.

As you can see from the illustration on the right, one of the advantages of using VIZ to create your terrain is that you can elect to give your terrain vertical walls (known as a skirt) around the edges. This is done by setting the Form option to "Graded Solid" and can help to improve the look of the terrain when imported into Bryce. From here on, the process is exactly the same as it is for importing an AutoCAD mesh created with Key Terra-Firma. Go to Step 5 above to continue. One important point is that although the terrain looks smoothed in VIZ, it will appear faceted when it is imported into Bryce, so you will still need to smooth it.
Introduction

AutoCAD can be used to create a simple "walk through" of any 3D model. For example, if you have designed a new pedestrianisation scheme for a town centre, you could use AutoCAD to give a slide presentation to show how the scheme would look from a pedestrian eye view as the person moved through the space. This is an extremely useful technique for presenting schemes to clients or the general public who may not necessarily have a good understanding of plans.

In order to create such a slide show you need to learn a number of new commands. This handout will describe those commands in the order in which they will normally be used to create a slide show. The commands are: DVIEW which is used to create the perspective views, DDVIEW to save the perspective views, SHADE to shade the views, MSLIDE to make the slides, VSLIDE to view the slides and SCRIPT to run a script file which will automate the process of viewing a number of slides in a predetermined order.

The DVIEW command

Toolbar None
Pull-down View ▶ 3D Dynamic View
Keyboard DVIEW

The DVIEW command is not an easy command to use, however, it is the only way to create perspective views using AutoCAD. Many third party add-ons for AutoCAD have improved on the DVIEW command, the Perceive command in AEC is a good example. However, the DVIEW command is very flexible and if you learn to use it well you will be able to do much more than is possible with the Perceive command.

Command Sequence

Command: DVIEW
Select objects: (pick a few key objects in the view for visual reference)
Select objects: (pick more or ← to end)
Camera/Target/Distance/Points/Pan/Zoom/TWist/Clip/Hide/Off/Undo/<exit>: PO (for the points option)
Enter target point <36.484,25.000,0.000>: .XY (the .XY filter forces AutoCAD to prompt you for a Z value)
of (pick target point)
(need Z): 1.7
Enter camera point <36.484,25.000,0.000>: .XY
of (pick camera point)
(need Z): 1.7 (a viewers eye height is assumed to be 1.7m above ground level)
Camera/Target/Distance/Points/Pan/Zoom/TWist/Clip/Hide/Off/Undo/<exit>: D (for
An Example

Since the DVIEW command is one of the more complicated AutoCAD commands you may find it useful to work through the example below. In order to follow this example you will first need to construct a box and a couple of points as follows:

1. Begin a new drawing, select from the Standard toolbar or File New… from the pull-down. Select the “Start from Scratch” option.

2. Using the RECTANG command, draw a square with corners at 250,150 and 270,170.

3. Start the Properties command, DDCHPROP at the keyboard or select from the Object Properties toolbar and give the square a thickness of 15.

4. Change the current point style to something more easily visible. Use the DDPTYPE command, Format Point Style… from the pull-down.

5. Using the POINT command, from the Draw toolbar, draw two points, one at 260,160 (the Target point) and one at 205,135 (the Camera point). You do not need to draw points in order to use the DVIEW command but for the purpose of this example it will help you to visualise what is happening.

6. Now, follow the command sequence, taking care to respond to all command prompts exactly as detailed below.

Before starting the DVIEW command, make sure you are in plan view, this makes it easier to correctly locate the Target and Camera points. The AutoCAD drawing area should look something like the illustration on the right.

Command: DVIEW
Select objects: (pick the box and the two points)
Select objects:

The DVIEW command prompts you to select objects because the command works more quickly if it only has to use a few simple objects when it is generating a perspective view. For a relatively small drawing such as the one we’re working with at the moment you can select all objects without causing any problems but for large drawings it is advisable to select just a few key objects which you can use as a visual reference while the perspective is constructed. For example, if you wanted a perspective view of a complicated site drawing it would be appropriate to select the site boundary as a reference.

Although there are a number of ways to construct a perspective view using DVIEW, the Points option is the most appropriate for constructing views when we want to specify particular target and camera points. This is
the easiest method to construct a perspective which most closely approximates to a human eye view from a particular point and looking in a particular direction. The Points option prompts us to specify the position of two points, a **Target** point and a **Camera** point. The Target point is the point that we want to look at and will appear in the centre of the view. The Camera point is the point from which we look at the Target point. In other words the Camera point is our eye.

Enter target point \<36.484,25.000,0.000\>: \_XY

In order to correctly specify the target point, we need to be able to give AutoCAD a 3D co-ordinate \(x,y,z\). We can simply enter an \(xyz\) co-ordinate at the keyboard if we know the co-ordinates of the point we are interested in. However, in most cases we will need to pick the point in plan. Picking a point in plan gives AutoCAD a 3D co-ordinate but the program assumes that the \(z\) value is zero (or whatever elevation is set using Entity Modes). We therefore need to force AutoCAD to prompt us for a \(z\) value to add to the \(xy\) point which we pick. We can do this by using a "Dot xy filter". Whenever AutoCAD prompts you to pick a point you can use a dot \(xy\) filter by typing ".XY" at the prompt.

**of (pick \(xy\) position of target point)**

This is the point you drew at 260,160 using the **POINT** command. For the purposes of this example just pick a point near the drawn point. If you need to be perfectly accurate when picking a drawn point, you should use the **Node** Object Snap, on the Object Snap toolbar.

**(need \(Z\)): \_10** (enter the \(z\) value of the target point, in this case 10m)

Enter camera point \<36.484,25.000,0.000\>: \_XY

The same argument applies to the selection of the camera point as to the target point, so we again must use the dot \(xy\) filter.

**of (pick camera point)**

This is the point you drew at 205,135 using the **POINT** command.

**(need \(Z\)): \_1.7**

By convention it is accepted that adult human eye height is at 1.7m above ground level. Providing that the base plane of our drawing is at zero elevation the \(z\) value of the eye height will be 1.7 (if we are working in metres). If the base plane is not at zero then the eye height will be 1.7 plus the base plane elevation. This convention assumes that the viewer is standing on the base plane. If the viewer is sitting, standing on a raised platform, or viewing from the upper storey of a building, the elevation of the Camera point must be adjusted accordingly.

When specifying the \(z\) values of the Target and Camera points it is worth considering the effect upon the line of sight. If the Target point elevation is higher than the Camera elevation, the line of sight will be inclined upwards, giving the effect of a viewer looking up towards some elevated point. If the Target point is lower, the line of sight will be inclined downwards. To construct a perspective along a horizontal line of sight, the elevations of Target and Camera points must be the same.
When we have specified the Target and Camera points the `DVIEW` command displays an axonometric view from the Camera point (see illustration, right) and returns to the main options prompt. To turn this axonometric view into a perspective we must use the Distance option.

New camera/target distance <60.98>: ⏎

The distance prompt requests a target distance and gives a default value. The default value is the calculated distance between the Target and Camera points which have just been specified. It is, therefore, the value which should be used. Hit the ⏎ key on the keyboard to accept the default value.

The `DVIEW` command now displays a perspective view from the Camera point (see illustration, right) and the UCS icon changes to the box symbol to inform you that you are in perspective mode. At the moment you will only see the objects you initially selected in perspective. To complete the `DVIEW` sequence, hit ⏎ to exit from the `DVIEW` command and the whole drawing will be regenerated in perspective.

When in perspective mode there are a number of restrictions which apply. You cannot pick objects and you cannot use the `ZOOM` command (changes to the view can only be made with the `DVIEW` command). It is not really feasible to work in perspective mode. To return to normal viewing at any time, use the `PLAN` command. This will take you from any perspective view back to a plan view of your drawing.

As you can see by the number of options available, there are many ways to create a perspective using `DVIEW`. This handout concentrates on the most straightforward option for creating perspectives quickly. Many of the other options are very useful and can be used to create interesting effects like wide-angle and telephoto lens simulation (the Zoom option). You may find it useful to experiment with the other options and to refer to the AutoCAD Reference Manual for more information on their use.

Constructing perspective views with the `DVIEW` command can be quite a tricky process but fortunately there is a way to save any view of your drawing so that it can easily be restored without going through `DVIEW` again.

**Saving perspective views, the DDVIEW command**

**Toolbar**

**Pull-down** View ▶ Named Views…

**Keyboard** DDVIEW

This command can be used to save any view
of a drawing, plan, elevation, axonometric or perspective and can also be used to restore these views at any time with just a few mouse clicks.

As you can probably guess by the name, the **DDVIEW** command is dialogue box driven. The "View Control" dialogue box is shown on the right.

The **DDVIEW** command saves the current view, so if you want to save a perspective view (or any other view), it must be shown in the AutoCAD drawing area when you start the **DDVIEW** command.

**Saving a New View**

To save the current view, start the **DDVIEW** command and click on the "New…" button which is located near the bottom of the dialogue box.

On clicking the "New…" button you are presented with the "Define New View" dialogue box (shown, left). To save the current view, enter a view name in the "New Name" edit box at the top of the dialogue box and click on the "Save View" button.

In common with filenames and names of other AutoCAD properties, view names cannot contain most of the special characters, including: a space, period, asterisk, question mark, brackets, ampersand (&), the "at" symbol (@) or the pound sign. However, as with layer names, you may use hyphens and underscores. If you use an illegal character as part of a view name you will get the error message "Invalid view name" at the bottom of the "Define New Name" dialogue box.

You can save as many views as you like, so it is a good idea to save all the views you need to complete a walk through sequence so that you have easy access to all of the views you need. View names appear in alphabetical order in the "View Control" dialogue box, so if you are saving views which should be viewed in a particular order, you should give them names that will appear in the correct order in an alphabetical list. For example, if you decide to call your views "View-number" and there will be ten or more of them, the first view should be called "View-01", the next "View-02" etc. The reason for this is that alphabetically "View-1" is followed by "View-10" and not "View-2".

**Restoring a Saved View**

To restore a saved view, start the **DDVIEW** command again and highlight the name of the view you wish to restore in the view name list (see illustration, right). Click on the "Restore" button, the text above the "Restore button will change to reflect the view you
have selected. When you click on the "OK" button the view you have selected will be restored as the current view.

The **DDVIEW** command saves only the geometry of the view as constructed with the **DVIEW** command. If you have made changes to your drawing since you saved the view, the restored view will show those changes. It is possible, therefore, to create and save all of your views before completing the drawing. This can be quite effective if you need to return to a view repeatedly in order to consider the implications of design changes.

**Deleting a Saved View**

To delete a saved view, highlight the view name in the "View Control" dialogue box and click on the "Delete" button. The view name will be removed from the list.

**Displaying the View Description**

To display the "View Description" dialogue box, highlight a view name in the "View Control" dialogue box and then click on the "Description..." button. The "View Description" dialogue box is illustrated on the right.

![View Description Dialogue Box]

**Shading the view, the SHADE command**

*Toolbar*

*Pull-down*  View ▶ Shade ▶ Options

*Keyboard*  SHADE

The **SHADE** command can be used to give a 3D perspective view a solid look. It works by shading every 3D face with a solid colour.

The illustration on the right shows a view of a cylinder as it would look in an AutoCAD drawing. The cylinder on the left has been shaded using the **SHADE** command. Notice that all hidden lines are obscured by the shaded faces, giving a solid effect.

When you have shaded a view, you cannot pick drawing entities, nor can you use the **ZOOM** command. A shaded view is just like a photograph of the original drawing, it cannot be modified. To return to normal viewing mode you must use the **REGEN** command to regenerate the drawing. The shaded view will then disappear and you can continue as normal.

**The SHADEDGE variable**

You can change the shaded effect that the Shade command gives to
your drawing using the SHADEDGE variable. To change the SHADEDGE variable just enter "SHADEDGE" at the keyboard and enter a value between 0 and 3. The default value for SHADEDGE is 3. The shaded cylinder above was shaded with SHADEDGE set to 3. You can also use the SHADE command with preset SHADEDGE values from the View pull-down (View/Shade/options).

The following list describes how each SHADEDGE value affects the shaded image and indicates the corresponding option from the pull-down.

SHADEEDGE = 0 gives a shaded colour surface with no lines, "256 Color" (below left).
SHADEEDGE = 1 gives a shaded colour surface with lines, "256 Color Edge Highlight". This tends to give the best overall results (below centre).
SHADEEDGE = 2 gives a background colour surface which creates a similar effect to the HIDE command, "16 Color Hidden Line" (below right).
SHADEEDGE = 3 gives a block colour surface, "16 Color Filled", this is the AutoCAD default.

Slides

AutoCAD Slide files contain snapshots of the AutoCAD drawing area. An AutoCAD slide is a file with a ".SLD" extension. For example, if you create a number of slides which are to appear in sequence, the first one might be called "VIEW-01.SLD". You can save any view of a drawing as a slide, but slides are particularly useful for saving shaded images.

Making slides, the MSLIDE command

Toolbar none
Pull-down none
Keyboard MSLIDE

The MSLIDE command can be used to save any view of a drawing to a file.

When you start the MSLIDE command you are presented with the familiar file dialogue box. The main difference between the "Create Slide File" dialogue box and the "Save Drawing As" dialogue box is that the file pattern has been changed from "*.DWG" to "*.SLD". This means that you will be creating a slide file and not a drawing file. To create a slide file, enter the slide name in the file edit box and click on the "OK" button. Remember, you cannot use any of the special characters (see above).

Viewing slide files, the VSLIDE command
The **VSLIDE** command can be used to view any slide file created with the **MSLIDE** command.

The **VSLIDE** command also uses the familiar file dialogue box. To view a slide, highlight the file you wish to view and click the "OK" button. The slide is displayed on the monitor screen in the AutoCAD drawing area. The slide is just a two dimensional image, like a photograph, and cannot be modified in any way. To return to your drawing, use the **REDRAW** command, the slide will disappear and the normal drawing view will be displayed.

**Script Files**

Script files can be used to automate any AutoCAD command sequence. Scripts are text files which list a sequence of AutoCAD commands, one on each line. When the script is run, AutoCAD executes each command just as if you typed them from the keyboard. Scripts provide an ideal method for automating the process of displaying a number of slide files in a predetermined sequence.

To create a script file you need to use a text editor such as **Notepad**. It doesn’t matter which text editor you use provided that the file format is plain ASCII text and that the saved file has a ".SCR" extension. To start Notepad, click on the "Start" button at the bottom left of your screen, select "Programs" then "Accessories" and click on the Notepad icon.

Below is an example of a script file which displays three slides, one after the other and then returns to the normal drawing view by issuing the **REDRAW** command:

```
VSLIDE VIEW-01
VSLIDE VIEW-02
VSLIDE VIEW-03
REDRAW
```

As you can see, each command is on a new line and the command parameter, in this case the slide file name is separated from the command string by a single space. There is no need to add the ".SLD" extension since the **VSLIDE** command assumes that you will want to view a slide file.

**The DELAY command**

If you ran the script above just as it is shown, each slide would be displayed on the screen and then immediately replaced with the next slide. This doesn't give enough time for us to view the slide properly. We need some method of pausing before moving on to the next slide. The **DELAY** command can be used to insert a pause between each **VSLIDE** command. If we add **DELAY** to the script above, the script file would look like the one below:

```
VSLIDE VIEW-01
```
The syntax for the `DELAY` command is:

```
DELAY Time in milliseconds
```

There are 1000 milliseconds in a second, so there is a pause of 6 seconds between each slide in the script above. You can use any number between 1 and 32767 with the `DELAY` command. This means that you can pause between any two commands from one millisecond to just under 33 seconds. Of course, if you need to pause for more than 33 seconds, you could use two `DELAY` commands, one after the other.

**The RSCRIPT command**

The script above displays each slide, pauses for 6 seconds, views the next slide and then uses the `REDRAW` command to return to normal viewing. However, sometimes we may want to have the script loop, so that when it gets to the end of the script it will start again at the top. We can do this using the `RSCRIPT` command and create a rolling slide show which will continue to repeat itself until we stop it. To change the script above into a loop, just replace the `REDRAW` command with the `RSCRIPT` command.

The final script would look like the one below:

```
VSLIDE VIEW-01
DELAY 6000
VSLIDE VIEW-02
DELAY 6000
VSLIDE VIEW-03
DELAY 6000
RSCRIPT
```

You must always end a script file with a carriage return, otherwise the script will pause indefinitely and the last command will never be issued. In the above example a carriage return must be added after the "T" of "RSCRIPT". This is a common mistake and is difficult to spot because the script file doesn't look any different.

**The RESUME command**

You can suspend the operation of a script at any time by hitting the Backspace key. You may, for example, want to pause a little longer at a particular slide in order to talk about it if you are giving a presentation. Once the Backspace key is pressed the script stops. To continue the script where you left off, use the `RESUME` command. Just type "RESUME" at the command prompt and the script will restart from the point at which Backspace was pressed.
Running a script file, the SCRIPT command

To start the operation of a script file, use the SCRIPT command. This command uses the familiar file dialogue box, but only displays ".SCR" files. To start running a script, highlight the script file you want and then click the "OK" button at the bottom of the "Select Script File" dialogue box.

Creating a "Walk Through"

We have now covered all the commands required to put together a walk through. To recap, the steps to creating a simple walk through are set out below:

1. Create a 3D drawing of your design scheme.
2. Decide on the position of the Camera and Target points and use DVIEW to construct a perspective view.
3. Save the perspective view as a "Named View" using the DDVIEW command.
4. Shade the perspective view using the SHADE command, consider the different SHADEDGE options.
5. Create a slide file from the shaded view using the MSLIDE command.
6. Repeat steps 2-5 for each view you want to use as part of the walk through.
7. Use a text editor to write a script file which will display your slides.
8. Run the script file using the SCRIPT command.

This tutorial has concentrated on creating slide shows which are composed of perspective views but you could use slides to display any view of an AutoCAD drawing. For example, you may want to start a presentation with a logo or some introductory text. You may also want to add annotation or a title slide between each view. You can even create slides from Paperspace, so you could add annotation to your perspective views, or any other view. Be creative in your use of slides and scripts and consider using script files for other purposes.
Entering Survey Data using AutoCAD

Introduction
These techniques apply to basic CAD programs such as AutoCAD, IntelliCAD, etc. If you have a civil/survey program or add-on, such as Land Desktop, SurvCADD, Eagle Point, etc., then there are built-in tools for entering lines and curves.

Lines and tangent curves
Let's say you have a paper plot or a legal description of a closed boundary. Let's work our way around it. Below is an example of what you might have. Start with a line segment if there is one. Let's start in the lower left (or most southwesterly) corner and work clockwise for this example.

For each line segment, a bearing and distance is given.

Start the \_LINE command and pick a starting point. If you have XY or Northing and Easting coordinates, you can enter them, otherwise just pick any point in the drawing. Then at the next prompt enter @107.65<N28D45'21"E.

Now stay in the line command and draw the next segment. Enter @27.23<S61D14'39"E

Now end the \_LINE command because you need to draw a curve next. We will assume that this curve is tangent to the previous segment (we'll cover non-tangent curves later).

Draw a line perpendicular to the previous segment towards the inside of the curve. Make this line the same
length as the radius of the curve. You can use the \_LENGTHEN command to set the exact length. The opposite endpoint is the center point for the next curve. The image below is how it should look now (the green line is the new one).

Now rotate this line, using the opposite endpoint as the radius point. Since this curve is to the right, rotate the line clockwise (meaning you will have to enter a negative angle) the amount of the delta of the curve. -6035'03" in this case.

Now you have the three points needed to draw the ARC. See the picture below.
Start the \_ARC command, enter "C" for center point and pick the endpoint of the line that represents the center point. Next pick the other endpoint of the line, that is the startpoint of the ARC. Next pick the endpoint of the previous line segment. Your curve is complete.

Now we have another curve to draw. This curve is also tangent, but in this case the previous entity is a curve. If the second curve goes in the same direction, it's called a compound curve, if the second curve goes in the opposite direction, it's called a reverse curve.

Notice that this curve is to the left, not the right, so this is a reverse curve. We need to do the same as above to find the center point, except rather than draw a perpendicular line, we need to draw a radial line from the previous curve.

In this case we already have the green line in place, so extend it out past the last curve a bit. Now trim off the part that is inside the previous curve. It should look like this now.

Now use the \_LENGTHEN command to make this line 500 foot long (the radius of this curve). The other end
is the center point for the next curve.

Now rotate this line the amount of the delta, just like before. Because this curve is to the left, the rotation angle will be positive, not negative. Now it should look like the picture below (the radius point is not shown since it is so far away).

Now you have your three points from which you can construct the arc.

The last line segment is constructed just like the first two. Start the .LINE command and pick the endpoint of the last arc, then enter \texttt{@116.77<N86D32'54"W}

\textbf{Non-Tangent curves}

The orientation of tangent curves is determined by the previous entity, but for non-tangent curves you need to know how the curve is oriented. This is the case for non-tangent curves in the middle of a figure or if you want to start your figure with a curve. You can use either the Chord Bearing and Chord Distance or you can use the Radial Bearing.
Chord Bearing and Chord Distance

The Chord Bearing is the bearing from the start point of the curve to the end point of the curve.

Going back to the first curve in the figure above, we can see that the Chord Bearing is \textbf{N30D57'08"W}. However, take a look at the figure. Is the other end of this curve really in the NW direction? No. This is something else you may run into. Depending on the direction you are traversing a figure, you may need to reverse bearings by 180 degrees.

Remember, the Chord Bearing is the bearing from the start point to the end point so in this case, the Chord Bearing is in the SE direction, not NE. So just replace the NE with SW. The actual Chord Bearing is \textbf{S30D57'08"E}.

So now, draw a line that represents this Chord Bearing, using the same syntax as above. The string you will use is \texttt{@75.66<S30D57'08"E}.

After you have this line, you can draw the curve. Start the \texttt{:_ARC} command and select the start point, then choose the "E" option and pick the end point, then use the "R" option and enter the radius. If the curve is opposite of what you expect, select the start and end points in the opposite order.
Use this same technique for non-tangent curves.

Radial Bearing

The Radial Bearing is the bearing from the start point of the curve to the radius point of the curve.

If you are given a radial bearing, you can use this to lay out a non-tangent curve also. This line will run from the last endpoint to the center point of the next curve. In our original example, the radial bearing is not given but it is S28d45'21"W. So start the .LINE command and use the string \texttt{@75.00<S28D45'21"W}. It should look like this.

This should look familiar. From this point on, you can follow the same steps as above when you constructed the perpendicular line and rotated it.

Summary

Using most CAD programs including vanilla AutoCAD, you can enter survey data from a drawing or deed without needing any special tools or add-ons. However, if entering this type of data is a frequent occurrence, you may consider upgrading to a program that includes faster methods for this type of data entry.
Basic 3D and Surface Modelling

by David Watsor

Introduction

Although AutoCAD has a number of commands for creating special 3D objects, a lot can be achieved by changing the properties of basic 2D objects like polylines. Most 2D objects can be given a thickness using the thickness option in the Properties (DDCHPROP) command. Although objects with a thickness can be said to be extruded, this should not be confused with the EXTRUDE command which creates solid extrusions; giving an object thickness produces a surface extrusion. All objects can be given an elevation by moving them in the Z direction using the MOVE command. With a combination of the MOVE and Properties commands you can quickly create simple 3D drawings.

Using this tutorial you will learn how to give objects a thickness, how to move them vertically, how to view your 3D creations and how to use the 3DFACE and SHADE commands.

The DDVPOINT Command

You can use this command to get an axonometric view of your drawing.

There are a number of ways to get an axonometric view of your AutoCAD drawing but the DDVPOINT command is probably the easiest and quickest to use. It is, however, buried two layers deep in the pull-down menu so it's often quicker simply to type it at the keyboard, since there is no toolbar button. As you probably recognise from the command name it is a dialogue box driven command. The Viewpoint Presets dialogue box is illustrated on the right. As you can see, you define a view by specifying two angles. The first angle is the rotation from the X axis (the horizontal angle). The second is the angle from the XY plane (the vertical angle). Using the dialogue box you can specify an angle either by picking on the two dials or by entering an angle into each of the two angle edit boxes. You can even look at your drawing from underneath by specifying a negative vertical angle. For most purposes a horizontal angle along one of the diagonals, 45, 135, 225 and 315 and a vertical angle of 30 give the best results.

You can return to a plan view of your drawing by using the PLAN command. To do this, just enter "PLAN" at the command prompt and then ← to accept the “Current UCS” default. You can also return to any previous view by using the Zoom Previous command option, Z ← P ← at the keyboard or  from the Standard toolbar.

The Properties Command
You can use the **DDCHPROP** command to change the colour, layer, linetype, linetype scale and thickness of any single or multiple object selection. The **DDMODIFY** command gives all of these change options in addition to those which are specific to the object type. **DDMODIFY** is always used by AutoCAD as a default for single object selections when the **Properties** command is selected from the toolbar or from the pull-down menu.

**Command Sequence**

**Command:** **DDCHPROP**

**Select objects:** (pick one or more objects)

When you have selected the objects, the Change Properties dialogue box appears. To change the thickness, simply enter a value (in drawing units) in the Thickness edit box. When you click the "OK" button your objects will be extruded by the amount specified.

The illustration (right) shows the result of applying a thickness to a circle. A circle with no thickness is shown on the left and a circle with thickness on the right.

Effectively a circle with thickness becomes a cylinder. You can tell by the orientation of the UCS icon in this illustration that this is an axonometric view (see "The DDVPOINT Command" above for details).

**Moving in the Z Direction**

By now you should be quite used to using the Move command but up until now you've only been moving 2D objects in the XY Plane. Move can just as easily be used to move a drawing object vertically, perpendicular to the XY Plane. You can do this by using XY and Z co-ordinates or by picking points in 3D space.

In the illustration on the left a circle has been moved from the base plane of a cube to the top face of a cube. This is done by using the **MOVE** command (Modify ▶ Move from...
the pull-down or \(\text{from the Modify toolbar}\). Just start the **MOVE** command, select the circle, pick one of the lower corners of the cube as the base point (use the end point Osnap!) and then pick the corresponding top corner as the second point, again using the end point Osnap. If you look at the circle in plan there appears to be no difference in its position because it has not been moved in the XY plane but perpendicular to it. You can use the same principle to move any drawing entity. Bear in mind that you must **always** use an Osnap when you are picking points in 3D space. If you do not, the picked point will always be on the base plane, which doesn't make any sense. One of the problems with this is that you may not realise your mistake until you change your view position because in the current view the objects will appear to have been moved normally. It's a good idea to keep switching your view point as a check.

In the above example the move was fairly easy because we had a cube to use as a guide. Very often you will need to move an object vertically without any guide. In such a case you should use co-ordinates. For example if the cube in the illustration above was 40 drawing units high then I could move the circle using the following command sequence.

**Command Sequence**

Command: **MOVE**
Select objects: (select the circle)
Select objects: \(\rightarrow\)
Base point or displacement: \(0,0,0\)
Second point of displacement: \(0,0,40\)

Notice that I use the UCS origin point as a base point, that's because it's standard practice but in principle it could be any point in space. The most important thing is that the X and Y co-ordinates remain the same (because we do not want to move in the XY Plane) and the Z co-ordinate must increase by the distance you want to move up. Using co-ordinate 25,43,16 as the base point and 25,43,56 as the second point would have resulted in exactly the same move. To move down you just need to specify a negative Z co-ordinate. For example to move the circle down by 40 units the second point co-ordinate would be \(0,0,-40\).

**The 3D Face Command**

**Toolbar**

```
\[\text{Draw} \rightarrow \text{Surfaces} \rightarrow \text{3D Face}\]
```

**Keyboard**

\[3DFACE\]

The 3D Face command is used to draw 3D surfaces with 3 or 4 edges.

**Command Sequence**

Command: **3DFACE**
First Point: (pick point)
Second Point: (pick point)
Third Point: (pick point)
Fourth Point: (pick point or ← for only 3 edges)
Third Point: (start another 3D Face or ← to end)

Why do I need a 3D Face?
The reason is that when you give an entity like a rectangle a thickness it is given solid sides in the direction of the extrusion but it is left open ended like a tube. To add a top and a bottom to a box you must use 3D Faces. In the illustration on the right, two boxes have been shaded using the Shade command, SHADE from the keyboard, View ▶ Shade ▶ Options from the pull-down or  from the Render toolbar. See SHADE for a description of the Shade command options. The box on the right is a rectangle which has been given a thickness. As you can see, it does not have a top. A 3D Face has been added to the top of the box on the left which gives the effect of a solid surface when shaded.

When you use the Shade command, don't forget to use the Regen command to get back to the wireline drawing. AutoCAD does not allow you to pick points on a shaded drawing.

For complicated shapes you may need to use a number of 3D Faces to fill a surface. Fortunately, extruded circles are automatically given a solid top and bottom so you don't need any 3D Faces. If you do need to use a complex of faces to fill a surface there is a way to hide the join lines between faces. If you type "I" and ← before the first pick point of any edge, that edge will be made invisible. If you are careful you can easily fill a complicated surface with many 3D Faces which will simply appear as a single continuous surface. If you need to create a very complex surface it may be better to use the EXTRUDE command which creates solid extrusions i.e. they already have top and bottom surfaces.

An Exercise
The exercise below is designed so that you can practice all of the new commands and techniques outlined above. It is a simple table which is composed of 9 main elements, 4 legs, 4 rails, and a top. These elements are all constructed using the Rectangle command, RECTANG from the keyboard or Draw ▶ Rectangle from the pull-down menu. Remember, there is nothing special about rectangles, they are just 4 sided closed polylines, so if you prefer using the PLINE command, then feel free.

These rectangles will be given a thickness using the Properties command and an elevation using the MOVE command. Some 3D Faces are used for the finishing touches using the 3DFACE command.

Drawing the Table
Step 1
First of all draw the table plan using the dimensions on the illustration and inset detail below. All dimensions are in millimetres. The plan is composed of nine rectangles. You may need to use other commands like Line and Offset to construct the rectangles. Alternatively you can work out the rectangle co-ordinates and construct them manually. Remember to use the Copy and/or Mirror commands to duplicate identical objects. For example, it's really only necessary to draw one leg since they are all the same.
Step 2

Next, using the **Properties** command, select the four table legs and give them a *thickness* of 700. Using the **Properties** command a second time, select the four table rails and give them a *thickness* of 100. Move the rails vertically through 600 with the **MOVE** command using a co-ordinate value of \((0,0,0)\) for the base point and \((0,0,600)\) for the second point. Finally use the **Properties** command a third time to give the table top a *thickness* of 40 and use **MOVE** again to give the top an *elevation* of 700. Now look at what you have created using the **DDVPOINT** command, **View ➤ 3D Viewpoint ➤ Select...** from the pull-down or **DDVPOINT** at the keyboard. Use the **SHADE** command to see the solid effect, **View ➤ Shade ➤ Options** from the pull-down or **SHADE** at the keyboard.

Step 3

As you will have noticed, your table does not yet have a solid top. You can achieve this using 3D Face. You can start the **3D Face** command from the pull-down, **Draw ➤ 3D Surfaces ➤ 3D Face**, from the Render toolbar, or from the keyboard, **3DFACE**. 3D Faces are defined by picking the four points of a rectangle in either a clockwise or anticlockwise direction. Start the 3D Face command and using the **endpoint Osnap**, select the four upper corners of the table top. Use the **Shade** command again to see the effect. You can use more 3D Faces to complete the model. By looking at the table from various angles you will notice that the underside of the rails, the underside of the legs and the underside of the table top all need 3D Faces in order to create a completely solid model.

Now that you have completed your model, experiment with the **Shade** command and the various *shade edge*...
settings (see “Tips and Tricks” below).

Step 4
To finish your drawing, set tilemode to 0, create an A3 drawing sheet and insert some tiled viewports, see thePaper Space exercise for details. Your drawing should end up looking something like the one below. The vase was created using the REVSURF command, see REVSURF for details.

3D Objects
In addition to the simple 3D objects you can create by giving objects thickness and adding 3D Faces, AutoCAD provides a number of ready made 3D objects. These objects can be chosen from the 3D Objects dialogue box. As you can see from the illustration of the dialogue box below, you can create very simple objects like a box and complex ones like the torus.
You must invoke the 3D objects dialogue box from the pull-down menu, Draw > 3D Surfaces > 3D Objects… as there is no keyboard equivalent. Alternatively you can select individual 3D Object commands from the Surfaces toolbar. Each 3D Object requires different input from the user but the command line is quite explicit so you shouldn't have any problems.

One of the most useful objects is the Sphere. In the illustration on the right a 3D tree has been created using a circle with thickness as the trunk and a sphere as the canopy. One thing to bear in mind when creating spheres is that the centre of the sphere will be on the ground plane. Therefore, half of the sphere is below ground level and half above. If you want the sphere to sit on the ground plane, all you have to do is move it up through a distance which is the same as it's radius.

Another consideration when creating spheres and some of the other shapes is the number of segments to use. It is very tempting to use a lot and create a smooth shape but this does take lots of drawing memory so go carefully. The default value (16) is usually adequate for most purposes.

Command Sequence
Invoke the dialogue box from the pull-down (Draw > 3D Surfaces > 3D Objects…), pick the sphere icon and then the "OK" button or pick 🔄 from the Surfaces toolbar.

Center of sphere: (pick point)
Diameter/<radius>: (pick point or enter value)
Number of longitudinal segments<16>: (enter number or ←→)
Number of latitudinal segments<16>: (enter number or ←→)
Your Sphere is drawn.

Tips & Tricks

- If you would like to try creating the vase as shown in the table drawing. You will need to know a little bit about UCS, User Co-ordinate Systems (see UCS) and how the Revolved Surface command works (see the 3D Tree exercise for details).

- You can change the shaded effect that the Shade command gives to your drawing using the SHADEDGE variable. To change the shade edge variable just enter SHADEDGE at the keyboard and enter a value between 0 and 3.
  SHADEDGE = 0 gives a shaded colour surface with no lines.
  SHADEDGE = 1 gives a shaded colour surface with lines. This tends to give the best overall results.
  SHADEDGE = 2 gives a background colour surface which gives a similar effect to the Hide command.
  SHADEDGE = 3 gives a block colour surface, this is the AutoCAD default. See SHADE for a fuller description of the SHADEDGE variable.

- Always use Osnaps when picking in 3D.

- Use the Shade command regularly to keep track of your drawing. In wireline it's impossible to tell if a surface has a 3D Face or not, so you'll need to use Shade to check.

- You can force invisible 3D Face edges to display in wireline using the SPLFRAME variable. If SPLFRAME = 0 all invisible edges remain hidden. If it is set to 1 invisible edges will be displayed. This can be extremely useful because it is impossible to select a 3D Face which has no visible edges. The only way to select such a 3D Face is to set SPLFRAME to 1 first.
3D Tree Exercise

by David Watso

Introduction

The object behind this exercise is twofold. Firstly it is to give you practice with some of the 3D techniques which you have discovered in the tutorials or to introduce you to them if you haven't seen them before. Secondly it is to demonstrate a reasonably simple method for constructing a convincing 3D tree.

Constructing the Tree

It is quite difficult to construct convincing looking 3D trees in AutoCAD, however, with a few simple 3D commands at your disposal you should be able to create something which is identifiable as a tree and perhaps hint at a species. At the end of this exercise you should have something which looks similar to the illustration on the right. When you have completed the tree you will have a block which can be used in future drawings. Many users keep libraries of such blocks in order to create convincing drawings quickly. Follow the sequence below to complete the exercise.

Setting up the Drawing

1. Start a new drawing, click on \( \text{Ctrl}+\text{N} \) and select "Start from Scratch" from the Create New Drawing dialogue box.

2. Use the Layer command, \( \text{Ctrl}+L \) to create three new layers called "CONSTRUCTION", "CANOPY" and "TRUNK". Set the current layer to "CONSTRUCTION" and give the new layers appropriate colours. If you need more information about working with layers, see the "Object Properties" tutorial.

3. This might be a good time to save your drawing \( \text{Ctrl}+\text{S} \). Give it a logical name such as "3D_TREE1". Remember to save your drawing regularly (every 10 to 15 mins) during the drawing session.

4. Using the DDVPOINT command, View \( 3D \) Viewpoint Select… from the pull-down, create an elevational view of the drawing by setting the vertical angle (the half circle on the right of the dialogue box) to zero. Notice that your UCS icon changes to show the broken pencil to tell you that you cannot draw in this view.

5. Use the UCS command to set the current UCS to "View" \( \text{Ctrl}+G \). The UCS icon now reappears as usual except that the "W" is missing, to indicate that you are no longer in the World Co-ordinate System. You are now ready to draw in elevation. For more information on User Co-ordinate Systems, see the "UCS" tutorial.

Creating the Construction Frame
6. Draw a rectangle using the RECTANG command, **Draw Rectangle** from the pull-down menu or from the Draw toolbar. Use the height and spread of your tree as dimensions (say 8 high and 6 wide) remember to work in metres. The midpoint of the rectangle base needs to be at the co-ordinate 0,0 so that you can later use this tree as a block insert. Tip: try using -3,0 for the first point and @6,8 when prompted for the second point. This will create a rectangle 8 metres high and 6 metres wide with a base midpoint at 0,0.

7. Now that we have created a rectangular frame for our tree profile we need to draw a line for our Axis of Revolution. Start the LINE command, **Draw Line** from the toolbar and draw a line from the midpoint of the rectangle base to the midpoint of the rectangle top. Make sure to use the Midpoint Osnap . If you are unsure about using co-ordinate values with AutoCAD, see the "Using Co-ordinates" tutorial for more guidance.

### Drawing the Tree Profile

8. Draw two polylines, **Draw Polyline** or , to describe the profile of your tree, one for the canopy and one for the trunk. Make sure that you join the two polylines end to end, use the Endpoint Osnap, . Also make sure that the canopy polyline starts at the midpoint of the rectangle top and that the trunk polyline ends on the rectangle baseline.

9. You have now drawn all of the constructional elements you need. Your screen should now look something like the illustration on the right. Save your drawing.

### Creating the 3D Trunk

10. Make the TRUNK layer current and start the REVSURF command, **Draw Surfaces Revolved Surface** from the pull-down or from the Surfaces toolbar. Select the polyline you drew to represent the trunk profile when prompted for the path curve and then pick the axis. Accept the command defaults and a 3D tree trunk will be generated.

### Drawing the Leaves

11. Make the CANOPY layer current and use the 3DFACE command, **Draw Surfaces 3D Face** from the pull-down or from the toolbar to draw "leaves" on the canopy. Don't draw too many leaves, remember that they will be multiplied later when you use the ARRAY command and this can make the drawing file quite large.

**Tip:** just draw a few leaf shapes and then use the Multiple option of the COPY command to copy them. When you have finished, your drawing should look something like the illustration on the right.

### Creating the Canopy with Array
12. Use the UCS command to set the UCS back to "World"  
   you will see the broken pencil icon again.

13. Start the ARRAY command, Modify  Array from the pull-down or  from the Modify toolbar. Select all of the leaves when prompted and then select the Polar array option. Pick the midpoint of the rectangle base when prompted for the centre point of the array (this may be easier if the TRUNK layer is turned off first), alternatively you could enter the co-ordinate value 0,0 since you know this to be the same point. Enter the number of items, even numbers look best (say 6 or 8). Do not enter a large number, AutoCAD is likely to crash and you may lose your work. Accept the defaults for start angle, 360 degrees and to rotate objects as they are copied. Your canopy will be generated.

Viewing Your 3D Tree

14. Turn off the CONSTRUCTION layer, take a look at your tree in 3D (use DDVPOINT) and view the tree from different angles.

15. Use the SHADE command to shade the tree. View Shade  from the pull-down menu. Tip the leaves will look best if the 256 Color option is used. This is effectively the same as setting the SHADEDGE variable to 0. Experiment with the different Shade options to see what effect they have.

16. Save your drawing. Sit back and marvel at your skill.

You may find that the tree doesn't look quite right and that there are gaps in the canopy. If this is the case just go through the process again and use a different leaf pattern or add more leaves. There are lots of ways that you can refine this process to improve the look of the tree. For example you could draw leaves on three different layers and give each layer a slightly different colour to increase the tonal range. By changing the colour of the leaf layers you can hint at seasonal changes. You could draw leaves on both halves of the canopy so that the tree doesn't look too symmetrical when viewed face-on. The key is to experiment. The illustration on the right shows a tree with a conical shape.

Once you are quite happy with your tree and you have saved it you can use it as a block insert in any other drawing. You can do this by using the DDINSERT command, Insert Block… from the pull-down menu when in another drawing. The insert base point of this block will be the base of the tree trunk because you drew the tree with the co-ordinate system origin (0,0) in that location.

If you do decide to keep your tree for future use it is worth tidying the drawing up a little. For example, you don't need to have the construction lines any longer, so erase all of the objects on the "CONSTRUCTION" layer. Once you have done that you can also remove the layer itself using the Layers command or the PURGE command, see the "Object Properties" tutorial for details. This is good drawing practice.
All About Shadows
by David Watsor

Introduction

There is no way to create perfect or realistic shadows in AutoCAD but there are various options that can be used to create approximate shadow effects. The choice of shadow will often depend upon the object casting the shadow. For example, there is no difference between volumetric and raytraced shadows as cast by solid opaque objects. However, there is a difference between the two shadow types when cast by a transparent or translucent solid object. Volumetric and raytraced shadows give the best definition and are easier and more reliable to work with but they don't have the soft edges that many real shadows have. Shadow maps do have soft edges but they are difficult to control (there is no real-time preview) and they don't give particularly realistic results.

The 3 Shadow Types

The four images above demonstrate the differences between the 3 different shadow types that AutoCAD can render. The two images at the top are both shadow maps. The one on the left has been made with the default settings and the one on the right has been made by increasing both the map size and the softness. As you can see, shadow maps do not display any effect caused by the transparency of the object casting the shadow.
The table below demonstrates the effect of varying shadow map size and softness.

The image on the bottom left was created using a volumetric shadow. The shadow is well defined and although it is completely flat, it is lighter, giving a better impression of a shadow cast by a transparent object. To achieve this result, you must set the render type to "Photo Real".

The image on the bottom right was created using a raytraced shadow. The shadow is well defined and it has a fine gradient which gives the impression of the shadow cast by a transparent object of varying thickness. You must set the render type to "Photo Raytraced" in order to create this type of shadow.

### Shadow Map Options

The nine images above show the effects of varying shadow map size and softness. The center image is the result of the default values, as shown in the dialogue box on the right. As you can see, the results vary from the almost realistic to the surreal. To make shadow map settings you must first have created at least one light. Then,
start the Light command **View > Render > Light…** from the pull-down menu, select the light name from the list and then click the **Modify…** button. Then, in the Modify dialogue box, click the **Shadow Options…** button. When the Shadow Volumes/Ray Traced Shadows check box is deselected, you will be able to set the two shadow map variables.

**Shadows Cast by Opaque Objects**

The two images above demonstrate that there is no perceptible difference between volumetric and raytraced shadows when cast by solid objects. Since raytraced renders take longer, you may save time by switching to a **Photo Real** render type if all your objects are opaque.

The three images above demonstrate some of the difficulties involved in using shadow maps. In some particular circumstances, when using the default size and softness values, the shadow is barely visible (you can just about make out a few black splotches to the right of the tree trunk). You really have to struggle to create anything remotely approaching the realistic. By contrast, the volumetric/raytraced shadow hits the spot first time every time.

**Conclusion**

Finally, it is worth noting that although AutoCAD is good at many things, you will struggle to create photo realistic images. As an example, here is an image created using a basic render in Bryce. As you can see, the quality is far superior to AutoCAD and in addition to the beautiful raytraced shadows, you also get reflection effects and a much better sense of the density of the object.